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Assistenza tecnica Bio-Rad
Il reparto di assistenza tecnica di Bio-Rad negli Stati Uniti è aperto dal lunedì al venerdì, dalle ore
05.00 alle 17.00 (fuso costa pacifica).

Telefono: 1-800-424-6723, opzione 2

E-mail: support@bio-rad.com (solo per U.S.A./Canada)

Per assistenza tecnica al di fuori degli Stati Uniti e del Canada, contattare l'ufficio locale di assistenza
tecnica oppure fare clic sul link Contattaci disponibile all'indirizzo www.bio-rad.com.

Avviso
Nessuna parte della presente pubblicazione può essere riprodotta o trasmessa in alcuna forma o
mediante alcun mezzo, elettronico o meccanico, fra cui fotocopia, registrazione o qualsiasi sistema di
conservazione o recupero delle informazioni, senza l'autorizzazione scritta di Bio-Rad.

Bio-Rad si riserva il diritto di modificare i propri prodotti e servizi in qualsiasi momento. Questa guida è
soggetta a modifiche senza preavviso. Sebbene si impegni a garantire l'accuratezza, Bio-Rad non si
assume alcuna responsabilità per errori od omissioni, o per danni derivanti dall'applicazione o
dall'utilizzo di queste informazioni.

BIO-RAD è un marchio di Bio-Rad Laboratories, Inc.

BIO-RAD, HARD-SHELL e MICROSEAL sono marchi registrati di Bio-Rad Laboratories, Inc. in alcune
giurisdizioni.

SYBR è un marchio di Thermo Fisher Scientific Inc. Bio-Rad Laboratories, Inc. è autorizzata a
vendere reagenti contenenti SYBR Green I per l'uso nella PCR in tempo reale, solo per scopi di
ricerca.

EvaGreen è un marchio di Biotium, Inc. Bio-Rad Laboratories, Inc. vende reagenti contenenti
colorante EvaGreen per l'uso nella PCR in tempo reale su licenza di Biotium, solo per scopi di ricerca.

Tutti i marchi utilizzati nel presente documento appartengono ai rispettivi proprietari.

Copyright © 2022 di Bio-Rad Laboratories, Inc. Tutti i diritti riservati.

http://www.bio-rad.com/


Uso previsto

Uso previsto
Il sistema CFX96 Dx e il sistema CFX96 DeepWell Dx con Software CFX Manager Dx sono studiati
per eseguire la PCR basata su fluorescenza per rilevare e quantificare le sequenze dell’acido
nucleico. I sistemi e il software sono previsti per l’uso diagnostico in vitro da parte di tecnici di
laboratorio qualificati. I sistemi vanno utilizzati con test diagnostici dell’acido nucleico di terzi che siano
stati prodotti ed etichettati per scopi diagnostici.

Glossario dei simboli
Importante: Le modifiche importanti sono evidenziate!

Produttore Numero di lotto

Data di scadenza Per uso diagnostico in vitro

Limite di temperatura Numero di catalogo

Consultare le istruzioni per l'uso Numero di test

Per l'uso con Numero di serie

Solo su prescrizione medica Contiene lattice

Manuale operativo | iii



Marcatura CE - Regolamento (UE)
2017/746 relativo ai dispositivi medico-

diagnostici in vitro

Traduzioni
I documenti del prodotto possono essere forniti in altre lingue su supporti elettronici.
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Sicurezza e conformità normativa
Per il funzionamento sicuro dei sistemi PCR CFX96 Dx o DeepWell Dx con il software CFX Manager™
Dx, indicati come Sistema CFX Dx in questo documento, Bio-Rad consiglia vivamente di seguire le
specifiche di sicurezza elencate nel presente paragrafo e in tutto il manuale.

Importante: I sistemi CFX96 Dx e CFX96 DeepWell Dx sono approvati per l’uso come dispositivi
medici per diagnostica in vitro (IVD).

Etichette di avvertenza per la sicurezza
Le etichette di avvertenza sullo strumento e in questo manuale avvisano l’utente relativamente alle
fonti di infortunio o danno. Nella Tabella 1 viene definita ciascuna etichetta di avvertenza per la
sicurezza.

Icona Significato

Avvertenza relativa al rischio di lesioni personali o danni
all’apparecchiatura
Se il sistema CFX Dx viene azionato prima di aver letto questo manuale, può
sussistere un pericolo di infortunio. Per un utilizzo sicuro, non azionare lo strumento
in modo diverso da quello indicato nel presente manuale. Questo strumento deve
essere utilizzato solo da personale di laboratorio qualificato addestrato nell’uso
sicuro di apparecchiature elettriche. Maneggiare sempre tutti i componenti del
sistema con cura e con mani pulite e asciutte.

Avvertenza sulla manipolazione di materiale a rischio biologico
Quando si manipolano campioni a rischio biologico, attenersi alle precauzioni
consigliate e alle linee guida, nonché rispettare eventuali linee guida locali
specifiche del laboratorio e del luogo.

Tabella 1. Significato delle etichette di avvertenza per la sicurezza
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Sicurezza e conformità normativa

Icona Significato

Avvertenza relativa al rischio di ustioni
Il termociclatore genera calore sufficiente per causare gravi ustioni. Durante il
funzionamento indossare sempre occhialini protettivi o un’altra protezione per gli
occhi. Attendere sempre che il blocco campioni torni alla temperatura di inattività
prima di aprire il coperchio e rimuovere i campioni. Lasciare sempre uno spazio
vuoto massimo per evitare ustioni cutanee accidentali.

Avvertenza relativa al rischio di esplosione
I blocchi di campione possono scaldarsi molto durante il normale funzionamento,
portando i liquidi a ebollizione e causandone l’esplosione.

Tabella 1. Significato delle etichette di avvertenza per la sicurezza, continua

Specifiche per l’uso sicuro e conformità
Nella Tabella 2 sono elencate le specifiche per l’uso sicuro dei sistemi di rilevamento PCR in tempo
reale prodotti da Bio-RadCFX Dx. Per garantire la conformità ai limiti della normativa FCC per i
dispositivi di classe A, utilizzare i cavi schermati forniti con questi strumenti.

Profilo dell’uso Condizioni per l’uso sicuro

Potenza nominale d’ingresso 100-240 VCA, 50-60 Hz, 850 Wmax

Categoria di sovratensione II

Fusibili 10 A, 250 V, 5 x 20 mm, ad azione veloce (qtà. 2)

Ambiente Solo per uso in ambienti interni

Temperatura d’esercizio 15-31 °C

Temperatura di stoccaggio Da -20 a 60 °C

Umidità relativa Fino all’80% (senza condensa)

Altitudine Fino a 2.000 metri d’altezza (s.l.m.)

Grado di inquinamento 2

Tabella 2. Condizioni per l’uso sicuro
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Pericoli

Conformità normativa
Il sistema di rilevamento PCR in tempo reale CFX Dx è stato testato e riscontrato conforme con tutti i
requisiti applicabili dei seguenti standard di sicurezza ed elettromagnetici:

n IEC 61010-1:2010 (3a ed.), EN61010-1:2010 (3a ed.). Apparecchi elettrici di misura, controllo e
utilizzo in laboratorio - Parte 1: Requisiti generali

n IEC 61010-2-010:2014, EN 61010-2-010:2014. Requisiti di sicurezza per apparecchi elettrici di
misura, controllo e utilizzo in laboratorio. Parte 2-010: Requisiti particolari per apparecchi da
laboratorio per il riscaldamento di materiali

n IEC 61010-2-081:2015, EN 61010-2-081:2015. Requisiti di sicurezza per apparecchi elettrici di
misura, controllo e utilizzo in laboratorio. Parte 2-081: Requisiti particolari per apparecchi da
laboratorio automatici e semi-automatici per analisi ed altri scopi (include l’emendamento 1)

n IEC 61010-2-101:2015 (2a ed.). Requisiti di sicurezza per apparecchi elettrici di misura, controllo
e utilizzo in laboratorio. Requisiti particolari per apparecchiature mediche per uso diagnostico in-
vitro (IVD)

n IEC 61326-1:2012 (Classe A), EN 61326-1:2013 (Classe A). Apparecchi elettrici di misura,
controllo e utilizzo in laboratorio. Requisiti EMC, Parte 1: Requisiti generali

n IEC 61326-2-6:2012, EN 61326-2-6:2013 (Classe A). Apparecchi elettrici di misura, controllo e
utilizzo in laboratorio. Requisiti EMC. Requisiti particolari per apparecchiature mediche per uso
diagnostico in-vitro (IVD)

Importante: Questa apparecchiatura genera, utilizza e può irradiare energia a radio frequenza e,
se non installata ed utilizzata in conformità con la documentazione formativa fornita, può causare
interferenze dannose alle comunicazioni radio. L’utilizzo dei sistemi in un’area residenziale può
causare interferenze dannose: in questo caso l’utente dovrà correggere le interferenze a proprie
spese.

Pericoli
Il sistema di rilevamento PCR in tempo reale CFX Dx è stato progettato in modo da garantire un
funzionamento sicuro se viene utilizzato in conformità con le indicazioni del produttore. Qualora il
sistema di rilevamento PCR in tempo reale CFX Dx o uno qualsiasi dei componenti ad esso associati
venga utilizzato in modo diverso da quanto specificato dal produttore, la protezione intrinseca fornita
dallo strumento potrebbe risultare compromessa. Bio-Rad Laboratories, Inc. non è responsabile di
eventuali lesioni o danni provocati dall'uso di questa apparecchiatura in modo diverso da quanto
specificato o da modifiche allo strumento non apportate da Bio-Rad o da un agente autorizzato. Gli
interventi di riparazione/manutenzione sul sistema di rilevamento PCR in tempo reale CFX Dx vanno
eseguiti solo da personale Bio-Rad addestrato.
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Sicurezza e conformità normativa

Rischi biologici
Il sistema di rilevamento PCR in tempo reale di CFX Dx è un prodotto destinato all’uso in laboratorio.
Se tuttavia sono presenti campioni a rischio biologico, attenersi alle seguenti linee guida e rispettare
eventuali linee guida locali specifiche del laboratorio e del luogo.

Nota: Durante il normale funzionamento di questo strumento, non viene rilasciata alcuna
sostanza di origine biologica potenzialmente dannosa.

Precauzioni generali

n Indossare sempre camice e guanti da laboratorio, nonché occhiali di protezione con elementi
protettivi laterali od occhialini protettivi da laboratorio.

n Tenere le mani lontano dalla bocca, dal naso e dagli occhi.

n Prima di lavorare con materiali potenzialmente infettivi, proteggere completamente eventuali tagli
o abrasioni cutanee.

n Lavarsi bene le mani con acqua e sapone dopo aver lavorato con qualsiasi materiale
potenzialmente infettivo e prima di lasciare il laboratorio.

n Rimuovere orologi da polso e braccialetti prima di iniziare il lavoro al banco del laboratorio.

n Conservare tutto il materiale infettivo o potenzialmente infettivo in contenitori infrangibili ed
ermetici.

n Prima di uscire dal laboratorio, rimuovere gli indumenti di protezione.

n Non usare una mano guantata per scrivere, rispondere al telefono, accendere la luce o toccare
oggetti che altri potrebbero toccare a mani nude.

n Cambiarsi i guanti di frequente. I guanti visibilmente contaminati vanno rimossi immediatamente.

n Non esporre i materiali non adeguatamente decontaminabili all'azione di materiali potenzialmente
infettivi.

n Dopo aver completato un’operazione sul materiale biologicamente pericoloso, decontaminare
l'area di lavoro con un disinfettante opportuno (ad esempio, una diluizione di candeggina per uso
domestico in rapporto 1:10).

Precauzioni IVD specifiche

n Tutti i campioni dei pazienti costituiscono un potenziale pericolo biologico e vanno quindi trattati in
base alle precauzioni universali.

n Durante il normale funzionamento di questo strumento, non viene rilasciata alcuna sostanza di
origine biologica potenzialmente dannosa.
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Pericoli

Decontaminazione della superficie

AVVERTENZA! Per evitare scosse elettriche, spegnere e scollegare sempre lo
strumento prima di eseguire le procedure di decontaminazione.

Le seguenti superfici possono essere pulite utilizzando un disinfettante battericida, virucida o
fungicida di tipo ospedaliero:

n Coperchio esterno e telaio

n Superficie interna del blocco di reazione e pozzetti del blocco di reazione

n Pannello di controllo e display

Per preparare e applicare il disinfettante, fare riferimento alle istruzioni fornite dal produttore del
prodotto. Dopo aver applicato il disinfettante, sciacquare sempre il blocco di reazione e i pozzetti del
blocco di reazione svariate volte con acqua. Asciugare con cura il blocco di reazione e i pozzetti del
blocco di reazione dopo averli sciacquati con acqua.

Importante: Non utilizzare detergenti abrasivi o corrosivi o soluzioni alcaline forti. Questi agenti
possono graffiare le superfici e danneggiare il blocco di reazione, determinando la perdita
dell’accuratezza del controllo termico.

Smaltimento di materiali biologicamente pericolosi

I seguenti materiali potenzialmente contaminati vanno smaltiti in conformità alle norme vigenti a livello
di laboratorio, locale, regionale e nazionale.

n Campioni clinici

n Reagenti

n Cuvette di reazione usate o altri materiali di consumo potenzialmente contaminati

Pericoli chimici
Il sistema di rilevamento PCR in tempo reale CFX Dx non contiene alcun materiale chimico
potenzialmente pericoloso.

Pericoli di esplosione o infiammabilità
Il sistema di rilevamento PCR in tempo reale CFX Dx non presenta alcun pericolo particolare in
relazione all’infiammabilità o all’esplosione quando viene utilizzato in maniera corretta secondo
quanto indicato da Bio-Rad Laboratories.
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Sicurezza e conformità normativa

Pericoli elettrici
Il sistema di rilevamento PCR in tempo reale CFX Dx, se installato e utilizzato correttamente senza
alcuna modifica fisica e se collegato a una rete di alimentazione a norma, non comporta alcun pericolo
elettrico insolito per gli operatori.

Trasporto
Prima di movimentare o spedire il sistema di rilevamento PCR in tempo reale, il modulo ottico di
reazione o la base del termociclatore di CFX Dx, occorre eseguire le procedure di decontaminazione.
Movimentare o spedire sempre il sistema di rilevamento PCR in tempo reale CFX Dx o i moduli ottici di
reazione in contenitori separati con i materiali di imballaggio forniti, che proteggeranno lo strumento da
danni. Se non è possibile reperire contenitori adeguati, contattare l’ufficio Bio-Rad di zona.

Batteria
Il termociclatore Sistema CFX Dx utilizza una batteria a bottone al litio-metallo da 3 V e un gruppo
batteria ricaricabile al nichel-metallo idruro da 4,8 V per mantenere le impostazioni di data/ora e i dati
dell’analisi in caso di interruzione di alimentazione CA. Se la data/ora e/o i dati dell’analisi non
rimangono impostati dopo lo spegnimento dell’unità, può significare che le batterie si stanno
esaurendo. In tal caso, contattare l’assistenza tecnica Bio-Rad per assistenza.

Non tentare di sostituire le batterie. Contattare l’assistenza tecnica Bio-Rad.

Smaltimento
Il sistema di rilevamento PCR in tempo reale CFX Dx contiene materiali elettrici; questi devono essere
smaltiti come rifiuti indifferenziati e devono essere raccolti separatamente, conformemente alla
Direttiva dell’Unione Europea 2012/19/UE sui rifiuti delle apparecchiature elettriche ed elettroniche
(Direttiva RAEE). Prima dello smaltimento, contattare il rappresentante Bio-Rad di zona per le
istruzioni specifiche del paese.

Garanzia
Il sistema di rilevamento PCR in tempo reale CFX Dx e i relativi accessori sono coperti da una
garanzia Bio-Rad standard. Per maggiori dettagli sulla garanzia, contattare l’ufficio Bio-Rad locale.
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Capitolo 1 Introduzione
I sistemi di amplificazione PCR in tempo reale CFX Dx di Bio-Rad per la diagnostica in vitro (IVD)
presentano gli ultimi progressi tecnologici, consentendo la quantificazione PCR con la curva standard,
l’analisi dell’espressione genica, la discriminazione allelica e l’analisi del punto finale.

I sistemi CFX Dx comprendono due moduli hardware e software:

n Modulo di reazione ottico (ORM) CFX96™Dx o CFX96 DeepWell Dx

n Termociclatore C1000™Dx

n Software CFX Manager™ Dx

Quando usato con il software CFX Manager Dx è possibile:

n Generare risultati immediati con la procedura guidata di avvio

n Inserire o modificare le informazioni sul pozzetto prima, durante o dopo un’analisi

n Interpretare i dati complessi e dare un senso allo studio dell’espressione genica con strumenti
quali l’analisi dei controlli PrimePCR™ e lo strumento del selettore gene di riferimento

n Preparare i report completi dei dati PCR in tempo reale

Sistemi di rilevamento PCR CFX Dx
La Tabella 3 elenca i prodotti PCR IVD di Bio-Rad che vengono spediti con il Sistema CFX Dx.

Nota: Un Sistema CFX Dx viene spedito con il software CFX Manager Dx, termociclatore C1000
Dx e il modulo di reazione ottico CFX96 Dx o CFX96 DeepWell Dx.

N. di catalogo Descrizione

1845097-IVD CFX96 Dx ORM*

1844095-IVD CFX96 DeepWell Dx ORM

1841000-IVD Termociclatore C1000 Dx

12007917 Software CFX Manager Dx v3.1

Tabella 3. Sistemi di rilevamento PCR IVD CFX

*Modulo di reazione ottico
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Capitolo 1 Introduzione

Maggiori informazioni
Questo documento spiega come impostare e azionare in modo sicuro i sistemi di rilevamento PCR in
tempo reale CFX96 Dx e CFX96 DeepWell Dx, con marcatura CE-IVD. Tali sistemi sono indicati
come Sistema CFX Dx in questo documento. Inoltre, questo documento spiega come utilizzare il
Software CFX Manager Dx con il Sistema CFX Dx.

Suggerimento: Fare clic sul logo Bio-Rad nell’angolo in alto a destra di una finestra del Software
CFX Manager Dx per lanciare il sito web di Bio-Rad. Questo sito include collegamenti a note
tecniche, manuali, informazioni di prodotto e assistenza tecnica. Questo sito fornisce inoltre molte
risorse tecniche su un’ampia varietà di metodi e applicazioni correlate a PCR, PCR in tempo reale
ed espressione genica.
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Capitolo 2 Installazione del termociclatore C1000
Dx

Questo capitolo spiega come installare il termociclatore C1000 Dx del Sistema CFX Dx presso la sede
di riferimento.

Suggerimento: Prima di installare il termociclatore, acquisire dimestichezza con il termociclatore
e il relativo modulo di reazione ottico, porte e accessori.

Requisiti del sito
Le tabelle di questa sezione elencano i requisiti di spazio, ambientali ed elettrici necessari per
installare e usare correttamente il termociclatore Sistema CFX Dx.

Nota: Installare il termociclatore Sistema CFX Dx su una superficie piatta e asciutta, con un
sufficiente flusso d’aria fresca per garantirne il corretto funzionamento.

Requisiti di spazio del banco di lavoro

Elemento Specifica

Alimentazione di ingresso Fino a 850W, massimo

Frequenza 50–60 Hz, monofase

Porte USB 5 A, 1 B

Dimensioni L: 33 cm

P: 46 cm

A: 36 cm

Peso 21 kg

Tabella 4. Sistema CFX Dx Requisiti di spazio del banco del termociclatore
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Capitolo 2 Installazione del termociclatore C1000 Dx

Requisiti ambientali

Parametro Intervallo Intervallo di umidità

Condizioni operative 15–31 °C

59–87.8 °F

0–80% RH, senza condensa

Condizioni di conservazione 15–31 °C

59–87.8 °F

0–80% RH, senza condensa

Tabella 5. Sistema CFX Dx Requisiti ambientali del termociclatore

Requisiti elettrici
L’alimentazione elettrica del termociclatore Sistema CFX Dx deve essere stabile ed entro le specifiche
al fine di garantire un funzionamento corretto. Il cavo di alimentazione collegato alla porta di ingresso
alimentazione deve essere classificato per 7 amp o più.

Elemento Specifica

Tensione di ingresso di rete 100–240 V CA; 50–60 Hz, monofase

Massimo utilizzo di alimentazione <850 watt

Numero di prese di alimentazione Almeno 2 prese di alimentazione:

n 1 presa per il termociclatore

n 1 presa per il computer su cui è eseguito il software CFX
Manager Dx

Tabella 6. Sistema CFX Dx Requisiti elettrici
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Descrizione generale del sistema

Descrizione generale del sistema
Le illustrazioni di questo paragrafo mostrano i componenti principali della base del termociclatore
C1000 Dx.

Vista frontale

1. Modulo di reazione ottico: include un sistema ottico per raccogliere dati fluorescenti e un
blocco termociclatore. I sistemi di rilevamento PCR in tempo reale CFX Dx supportano un
modulo CFX96™Dx o CFX96 DeepWell Dx.

2. LED di stato: indica quando il blocco è in uso.

3. Pulsante del coperchio: apre o chiude il coperchio del modulo di reazione ottico e sigilla la
camera di reazione.

4. Base del termociclatore C1000™Dx: fornisce l’alimentazione del sistema e le
comunicazioni e alloggia i moduli di reazione ottico CFX96 Dx e CFX96 DeepWell.

LEGENDA
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Capitolo 2 Installazione del termociclatore C1000 Dx

5. Display e pulsanti del pannello anteriore: consentono il controllo del sistema in modalità
stand-alone.

Importante: Per garantire l’integrità dei dati dello studio dei geni IVD, il software CFX
Manager Dx non supporta i dati generati dal termociclatore in modalità stand-alone.

6. Coperchio interno riscaldato: mantiene la temperatura del coperchio per impedire la
condensa e l’evaporazione.

7. Blocco campione/reazione: tiene la cuvetta di reazione, comprese le provette e le
micropiastre.

Vista posteriore

1. Porta Ethernet: collega il termociclatore C1000 Dx alla rete.

2. Porte USB di tipo B: collegano il termociclatore C1000 Dx ad un computer con software
CFX Manager Dx.

3. Porte USB di tipo A: trasferiscono i dati a e da un’unità flash USB.
Importante: Per garantire l’integrità dei dati dello studio dei geni IVD, il software CFX
Manager Dx non supporta i dati generati dal termociclatore in modalità stand-alone.

4. Porta di test seriale: solo per analisi di servizio.

LEGENDA
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Descrizione generale del sistema

5. Sfiati di raffreddamento: raffreddano il termociclatore.
Importante: Non bloccare gli sfiati di raffreddamento. Per un funzionamento ottimale,
verificare che l’aria riesca a circolare dietro la base del termociclatore.

6. Ingresso di alimentazione: alimentazione di rete CA; usare il cavo di alimentazione
fornito.

7. Interruttore di alimentazione: interruttore a bilanciere per accendere e spegnere il
termociclatore.

8. Fusibili: per le specifiche sui fusibili vedere Specifiche per l’uso sicuro e conformità a
pagina 14.
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Capitolo 2 Installazione del termociclatore C1000 Dx

Moduli di reazione ottici
Il termociclatore C1000 Dx è compatibile con i seguenti moduli di reazione ottici Bio-Rad per PCR in
tempo reale.

n Modulo di reazione ottico CFX96 Dx

n Modulo di reazione ottico CFX96 DeepWell Dx

Il modulo di reazione ottico CFX Dx prescelto e il termociclatore vengono spediti in confezioni
separate. Il software CFX Manager Dx viene spedito con il modulo di reazione ottico.

Importante: Il modulo di reazione ottico è calibrato con la base del termociclatore con cui viene
spedito. Non utilizzare quindi il modulo di reazione ottico con un’altra base per termociclatore, né
la base del termociclatore con un altro modulo di reazione ottico.

Entrambi i moduli di reazione ottici comprendono un coperchio riscaldato perfettamente regolabile che
è in grado di funzionare in modo affidabile con un’ampia gamma di cuvette di reazione. Ciascun
modulo di reazione ottico contiene ventole di raffreddamento per riscaldare e raffreddare
velocemente.

Ciascun modulo di reazione ottico CFX Dx comprende i seguenti componenti:

n Coperchio interno riscaldato: mantiene la temperatura del coperchio per impedire la condensa
e l’evaporazione.

n Blocco campione/reazione: tiene le cuvette di reazione, comprese le provette e le micropiastre.

n Pulsante del coperchio: apre o chiude il coperchio e sigilla la reazione.

n LED di stato: quando è acceso, indica che il blocco è in uso.

Volumi campione consigliati
Quando si utilizza il termociclatore C1000 Dx, il volume massimo di campione viene determinato dal
tipo di modulo di reazione utilizzato. Nella Tabella 7 sono elencati i volumi consigliati da usare con
ciascun modulo di reazione.

Numero di pozzetti Numero di blocchi
Volume di campione consigliato, µl

(Limite superiore)

96 pozzetti 1 10-50

96 pozzetti profondi 1 10-125

Tabella 7. Limite di dimensione e volume per i moduli di reazione
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Installazione del termociclatore C1000 Dx

Installazione del termociclatore C1000 Dx
La base del termociclatore C1000 Dx viene spedita in una confezione separata dal modulo ottico di
reazione. La confezione include:

n La base del termociclatore C1000 Dx

n Il cavo di alimentazione

n 1 cavo USB

Per installare il termociclatore C1000 Dx, eseguire quanto segue:

1. Disimballare e installare la base del termociclatore C1000 Dx.

2. Fissare il modulo di reazione alla base.

3. Rimuovere la vite di imballaggio.

In questo paragrafo vengono spiegate in dettaglio queste attività.

Disimballaggio e installazione del termociclatore C1000 Dx
Importante: Prima di utilizzare il termociclatore, leggere le informazioni contenute in Sicurezza e
conformità normativa a pagina 13 e Etichette di avvertenza per la sicurezza a pagina 13.

Suggerimento: Durante l’impostazione, verificare di avere spazio sufficiente vicino al
termociclatore per un computer sul quale seguire il software CFX Manager Dx.

Disimballare e installare la base del termociclatore

1. Individuare la confezione della base del termociclatore.

2. Rimuovere la base dal materiale di imballaggio.

Suggerimento: Conservare l’imballaggio per l'uso futuro. Qualora manchi qualche
componente o sia danneggiato, contattare l’ufficio Bio-Rad locale.

3. Posizionare la base del termociclatore su una superficie piatta e asciutta, con sufficiente flusso
d’aria fresca per garantirne il corretto funzionamento.

4. Individuare il cavo di alimentazione nella confezione di spedizione e inserire un’estremità nella
porta di ingresso alimentazione sul retro del termociclatore.

Importante: In questa fase, non accendere lo strumento.

5. Collegare il modulo di reazione IVD alla base. Passare al capitolo Fissaggio del modulo ottico di
reazione a pagina 28.
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Capitolo 2 Installazione del termociclatore C1000 Dx

Fissaggio del modulo ottico di reazione
Bio-Rad spedisce il modulo ottico di reazione CFX96 Dx o CFX96 DeepWell con la base del
termociclatore C1000 Dx (in una confezione separata). Disimballare con cura il modulo ottico di
reazione e assicurarsi che i cavi di alimentazione e USB siano inclusi nell’imballaggio di spedizione.

Importante: Ogni modulo ottico di reazione è calibrato con la base del termociclatore con cui
viene spedito. Non utilizzare quindi il modulo ottico di reazione con una qualsiasi altra base per
termociclatore.

Assicurarsi che la base del termociclatore C1000 Dx sia appoggiata su una superficie piatta e asciutta,
con sufficiente flusso d’aria fresca per funzionare in modo corretto.

Per fissare il modulo di reazione alla base del termociclatore

1. Sistemare il termociclatore C1000 Dx in una posizione idonea con la barra di blocco rivolta verso
il basso.

2. Sollevando il modulo ottico di reazione dalle scanalature d’impugnatura sopra le bocchette laterali
dell’aria, posizionare il modulo nel vano per il modulo di reazione C1000 Dx, lasciando circa 2 cm
di spazio nella parte anteriore. Una volta nel vano, il modulo ottico deve coprire il logo Bio-Rad
che si trova nella parte anteriore del vano.
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Installazione del termociclatore C1000 Dx

3. Tirare verso l’alto la barra di blocco fino a quando non è a filo con i bordi laterali del vano del
modulo. Questa azione permette di spostare in avanti il modulo, bloccandolo in sede.

4. Assicurarsi che il modulo alloggi perfettamente nella base del termociclatore C1000 Dx. Non deve
esserci alcuno spazio vuoto tra il modulo e la base.

5. Collegare il cavo di alimentazione alla parte posteriore della base del termociclatore C1000 Dx e
nella presa elettrica idonea, quindi premere l’interruttore di alimentazione sul pannello posteriore
del termociclatore C1000 Dx per avviare il sistema.

Rimozione della vite di imballaggio
Importante: I moduli di reazione ottici di Bio-Rad vengono spediti con una vite rossa inserita nel
coperchio interno per stabilizzare il modulo ottico di reazione durante il trasporto. Prima di poter
far funzionare il modulo di reazione ottico, occorre rimuovere la vite di imballaggio.

Per rimuovere la vite di imballaggio

1. Il termociclatore C1000 Dx riconosce se la vite di imballaggio è inserita nel modulo di reazione
ottico e visualizza un messaggio che chiede di rimuovere la vite.
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Capitolo 2 Installazione del termociclatore C1000 Dx

2. Seguire le istruzioni per rimuovere la vite di imballaggio. La figura che segue mostra la posizione
della vite di imballaggio.

Nota: Occorre reinserire la vite di imballaggio nel caso in cui fosse necessario restituire il
modulo di reazione per un qualche motivo. Conservare la vite in un luogo sicuro e
accessibile.

Caricamento delle piastre dei campioni
Per garantire un raffreddamento e un riscaldamento uniformi dei campioni, le piastre devono essere
completamente a contatto con il blocco di reazione. per garantire l’integrità dei dati dello studio un
contatto adeguato, procedere come segue:

n Verificare che il blocco sia pulito prima di caricare i campioni.
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n Premere saldamente le singole provette, le strisce di provette o le micropiastre nei pozzetti del
blocco.

n Quando si utilizzano una o più provette, usare il telaio per provette (n. di catalogo 1849000 o
1849001) oppure caricare almeno una provetta vuota in ciascun angolo del blocco, per garantire
che il coperchio eserciti una pressione uniforme sulle singole provette.
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Caricamento delle piastre nel modulo ottico di reazione

Importante: Quando si utilizza il Sistema CFX Dx, bilanciare sempre le strisce di provette oppure
aggiungere i cappucci delle provette ai pozzetti angolari per assicurarsi che il coperchio riscaldato
applichi una pressione uniforme lungo tutto il blocco.

Per caricare le piastre nel modulo di reazione

1. Per aprire il coperchio motorizzato, eseguire una delle seguenti operazioni:

n Nel riquadro Detected Instruments (Strumenti rilevati) del software CFX Manager Dx, fare
clic su Open Lid (Apri coperchio).

n Nella scheda Start Run (Avvia analisi) del software, fare clic su Open Lid (Apri coperchio).

n Premere il pulsante del coperchio sulla parte anteriore dello strumento.

2. Sistemare nel blocco la micropiastra, le singole provette o le strisce di provette con i tappi sigillati.

Importante: Assicurarsi che le provette siano completamente sigillate per evitare perdite.

Suggerimento: Per risultati ottimali, caricare volumi di campione pari a 10-25 µl per il
Sistema CFX Dx.

3. Per analisi dei dati accurate, verificare che l’orientamento delle reazioni nel blocco sia
esattamente uguale all’orientamento del contenuto dei pozzetti nella scheda Plate (Piastra) del
software CFX Manager Dx.

Suggerimento: È possibile modificare il contenuto dei pozzetti utilizzando il software CFX
Manager Dx prima dell’analisi oppure durante o dopo l’analisi.

4. Per chiudere il coperchio motorizzato, eseguire una delle seguenti operazioni:

n Premere il pulsante del coperchio sullo strumento.

n Nel riquadro Detected Instruments (Strumenti rilevati) del software, fare clic su Close Lid
(Chiudi coperchio).

n Nella scheda Start Run (Avvia analisi) del software, fare clic su Close Lid (Chiudi coperchio).

Importante: Assicurarsi che non vi sia nulla che blocchi il coperchio quando si chiude.
Anche se è presente un meccanismo di sicurezza per impedire la chiusura del coperchio se
rileva un ostacolo, non mettere nulla che sia d’ingombro per il coperchio prima di chiuderlo.

32 | Sistemi CFX96 Dx e CFX96 DeepWell Dx



Installazione del termociclatore C1000 Dx

Consumabili dei reagenti e dei componenti in plastica per PCR

Per trovare e ordinare i consumabili in plastica raccomandati per il sistema CFX Dx, andare sul sito
web di Bio-Rad. È possibile accedere a questo sito dall’elemento di menu Help > PCR Plastic
Consumables Web Site (Guida > Sito web consumabili in plastica PCR) nel software CFX Manager
Dx. Inoltre, fare riferimento al selettore componenti in plastica e al selettore reagenti per trovare e
ordinare facilmente consumabili in plastica e reagenti per le esigenze specifiche dell’hardware e della
PCR.

Rilevamento degli strumenti collegati
Durante l’installazione, il programma di installazione del Software CFX Manager Dx installa
automaticamente i driver dello strumento sul computer che esegue il Software CFX Manager Dx. Il
software CFX Manager Dx rileva gli strumenti collegati quando si avvia il software.

Importante: È necessario scollegare il termociclatore C1000 Dx dal computer CFX Manager Dx
prima di installare il software. Non è necessario spegnere il termociclatore durante l’installazione
del software.

Per rilevare gli strumenti collegati

1. Se non ancora eseguito, inserire l’estremità quadrata (maschio) del cavo USB di tipo B fornito
nella porta USB di tipo B che si trova sul retro della base.

2. Inserire l’altra estremità (porta) in una porta USB del computer CFX Manager Dx.

3. Se il termociclatore non è già in esecuzione, premere l’interruttore di alimentazione sul retro dello
strumento per accenderlo.

4. Avviare il Software CFX Manager Dx.

Il software rileva automaticamente lo strumento collegato e ne visualizza il nome nel riquadro
Detected Instruments (Strumenti rilevati) nella finestra Home (Home).

Nota: Se lo strumento non viene visualizzato nel riquadro Detected Instruments (Strumenti
rilevati), verificare che il cavo USB sia installato correttamente. Per reinstallare i driver,
selezionare Tools > Reinstall Instrument Drivers (Strumenti > Reinstalla driver strumento) nella
finestra Home (Home) nel Software CFX Manager Dx.
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Capitolo 2 Installazione del termociclatore C1000 Dx

Rimozione del modulo di reazione
Importante: Spegnere il termociclatore C1000 Dx prima di rimuovere un modulo di reazione
(vedere Spegnimento del termociclatore C1000 Dx a pagina 35). Le alette di raffreddamento
all’interno del modulo di reazione potrebbero essere calde subito dopo l’esecuzione di un
protocollo o un’incubazione. Prima di rimuovere il modulo di reazione, verificare che le alette
siano fredde.

Per rimuovere il modulo di reazione ottico dalla base del termociclatore

1. Sul retro della base del termociclatore, spingere la barra di blocco verso il basso per sbloccare e
rilasciare il modulo di reazione ottico.

2. Sollevare attentamente il modulo di reazione ottico fuori dal vano usando le scanalature
dell’impugnatura su ciascun lato.

3. Posizionare il modulo di reazione ottico su una superficie orizzontale e pulita, dove non può
essere urtato, graffiato o fatto cadere.
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Spegnimento del termociclatore C1000 Dx
Per spegnere il termociclatore

1. Dopo un’analisi, premere il pulsante di apertura coperchio sulla parte anteriore del modulo di
reazione ottico CFX per accedere ai campioni caricati nel blocco.

2. Rimuovere i campioni dal blocco e premere il pulsante di chiusura coperchio per chiudere il
coperchio.

3. Per spegnere il sistema, premere l’interruttore di alimentazione sul pannello posteriore del
termociclatore C1000 Dx.
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Capitolo 3 Installazione del Software CFX
Manager Dx

Questo capitolo illustra come installare il software CFX Manager™ Dx.

Il Software CFX Manager Dx è necessario per analizzare i dati PCR in tempo reale dai sistemi
CFX96™Dx e CFX96 DeepWell Dx. Inoltre, è possibile utilizzare questo software per controllare
questi sistemi in modalità controllata da software.

Per informazioni sull’installazione del termociclatore Sistema CFX Dx e del modulo di reazione ottico,
fare riferimento a Installazione del termociclatore C1000 Dx a pagina 21.
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Requisiti del sistema
Nella Tabella 8 sono elencati i requisiti di sistema minimi e consigliati per il computer che esegue il
Software CFX Manager Dx (noto come il computer CFX Manager Dx).

Sistema Minimo Consigliato

Sistema operativo Microsoft Windows 7 SP1
Pro

Uno dei seguenti:

n Microsoft Windows 7 SP2 Pro (a 32 bit e a
64 bit)

n Microsoft Windows 10 Pro (solo a 64 bit)

n Microsoft Windows 10 Enterprise (solo a
64 bit)

Importante: Secure Boot (Avvio protetto) deve essere disattivato sia in Microsoft Windows 10 Pro
che in Enterprise.

Porte 2 porte USB 2.0 ad alta
velocità

2 porte USB 2.0 ad alta velocità

Spazio
disponibile su
disco rigido

128 GB 128 GB

Velocità del
processore

2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB DI RAM 8 GB DI RAM

Risoluzione dello
schermo

1024 x 768 con modalità
true-color

1280 x 1024 con modalità true-color

Lettore PDF Adobe PDF Reader o Windows PDF Reader di
una delle Microsoft Office Suite supportate:

n 2007

n 2010

n 2013

Tabella 8. Requisiti del computer per il Software CFX Manager Dx
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Installazione del Software CFX Manager Dx
Importante: Prima di installare o aggiornare il software, è necessario scollegare dal computer
CFX Manager Dx tutti gli strumenti collegati. Non è necessario spegnere il termociclatore durante
l’installazione del software. Verificare di aver salvato tutte le analisi e che non vi siano esperimenti
in corso.

Nota: Se si installa il Software CFX Manager Dx su unaWindows 10, prima di iniziare la
procedura di installazione, verificare che Secure Boot (Avvio protetto) sia disabilitato.

Per installare il Software CFX Manager Dx

1. Se necessario, scollegare dal computer tutti gli strumenti collegati.

Individuare e scollegare il cavo USB dello strumento sul computer CFX Manager Dx. L’estremità
inserita nello strumento può rimanere in posizione.

2. Accedere al computer CFX Manager Dx con privilegi di Amministratore.

3. Mettere il CD del software CFX Manager Dx nell’unità CD del computer.

4. Dovrebbe apparire automaticamente la pagina di avvio del software. Fare doppio clic su Install
Software (Installa software) nella pagina di avvio del software.

Nota: Se la pagina di avvio non appare automaticamente, navigare fino all’unità CD e aprire
la cartella CFX_Manager, quindi fare doppio clic su setup.exe per avviare la procedura
guidata di installazione del software.

Suggerimento: Nella procedura guidata di installazione, fare clic sul pulsante
Documentation (Documentazione) per cercare le copie delle note di rilascio, i manuali dello
strumento e altra documentazione.

5. Per completare l’installazione, seguire le istruzioni visualizzate sullo schermo. Al termine, appare
sul desktop del computer l’icona del software di gestione CFX.

6. Al termine dell’installazione, è possibile rimuovere in sicurezza il CD.

Rilevamento degli strumenti collegati
Durante l’installazione, il programma di installazione del Software CFX Manager Dx installa
automaticamente i driver dello strumento sul computer CFX Manager Dx. Il software CFX Manager Dx
rileva gli strumenti collegati quando si avvia il software.

Per rilevare gli strumenti collegati

1. Se non ancora eseguito, inserire l’estremità quadrata (maschio) del cavo USB di tipo B fornito
nella porta USB di tipo B che si trova sul retro della base dello strumento.

Manuale operativo | 39



Capitolo 3 Installazione del Software CFX Manager Dx

2. Inserire l’altra estremità (porta) in una porta USB del computer CFX Manager Dx.

3. Se lo strumento non è già in esecuzione, premere l’interruttore di alimentazione sul retro dello
strumento per accenderlo.

4. Avviare il Software CFX Manager Dx.

Il software rileva automaticamente lo strumento collegato e ne visualizza il nome nel riquadro
Detected Instruments (Strumenti rilevati) della finestra Home (Home).

Nota: Se lo strumento non viene visualizzato nel riquadro Detected Instruments (Strumenti
rilevati), verificare che il cavo USB sia installato correttamente. Per reinstallare i driver, nella
finestra Home (Home) nel CFX Manager Dx selezionare Tools > Reinstall Instrument Drivers
(Strumenti > Reinstalla driver strumento).

File software
Nella Tabella 9 sono elencati i tipi di file del Software CFX Manager Dx.

Tipo di file Estensione Dettagli

Protocollo .prcl Contiene i dettagli di impostazione del protocollo per
eseguire un’analisi PCR.

Piastra .pltd Contiene i dettagli di impostazione della piastra per
eseguire un’analisi PCR.

Dati .pcrd Contiene i risultati dell’analisi di un esperimento e
dell’analisi PCR.

Analisi PrimePCR™ .csv Contiene il protocollo e la disposizione della piastra per
le piastre PrimePCR.

Studio dei geni .mgxd Contiene i risultati di più analisi PCR e delle analisi
dell’espressione genica.

LIMS .plrn Contiene le informazioni relative al protocollo e
all’impostazione della piastra per eseguire un’analisi
LIMS compatibile.

Tabella 9. Tipi di file del Software CFX Manager Dx
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Misure raccomandate per la sicurezza informatica
Bio-Rad raccomanda di collaborare con il reparto IT al fine di implementare misure di sicurezza
informatica per il computer utilizzato con il sistema CFX96 Dx. Ad esempio:

n Installare e configurare un’adeguata protezione antivirus e applicazioni firewall appropriate.

Importante: Configurare la scansione antivirus in modo che venga eseguita durante le ore di
inattività oppure quando lo strumento non è attivamente in funzione. Se una scansione
antivirus viene avviata mentre il Software CFX Manager Dx esegue un esperimento, l’analisi
potrebbe essere annullata e i dati potrebbero andare persi.

n Il Software CFX Manager Dx non ha una funzione di timeout inattività per la sessione utente.
Implementare le misure di sicurezza per l’accesso utenti di Windows o di terzi (ad esempio,
implementare un salvaschermo che richieda il login).

n Sicurezza dei supporti rimovibili:

o Usare password e codifiche sul dispositivo USB per proteggere i dati.

o Disattivare le funzioni di analisi e riproduzione automatiche per tutti i dispositivi dei supporti
rimovibili.

o Effettuare una scansione USB ogni qualvolta si collega una chiavetta USB.

n Utilizzare un’utility di backup per facilitare il recupero dei dati.
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Capitolo 4 Spazio di lavoro
Il software CFX Manager™ Dx fornisce un’interfaccia per l’impostazione delle piastre, lo sviluppo di
protocolli PCR, la loro esecuzione sugli strumenti CFX Dx e l’analisi dei dati dalle analisi PCR.

Il software CFX Manager Dx presenta cinque spazi di lavoro principali:

n La finestra Home (Home)

n La procedura guidata di avvio

n La finestra Protocol Editor (Editor protocollo)

n La finestra Plate Editor (Editor piastra)

n La finestra Data Analysis (Analisi dei dati)

Ogni spazio di lavoro viene mostrato e illustrato brevemente in questo capitolo.
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Finestra Home (Home)
Il Software CFX Manager Dx si apre nella finestra Home (Home) e visualizza la procedura guidata di
avvio, dalla quale è possibile impostare un esperimento, eseguire o ripetere un’analisi o esaminare
un’analisi esistente. Dalla finestra Home (Home) è possibile anche visualizzare i registri applicazione
e strumenti, creare e gestire gli utenti e accedere a numerosi strumenti utili. Per maggiori informazioni,
fare riferimento al Capitolo 5, Finestra Home (Home).

44 | Sistemi CFX96 Dx e CFX96 DeepWell Dx



Procedura guidata di avvio

Procedura guidata di avvio
Utilizzare la procedura guidata di avvio per impostare ed eseguire velocemente esperimenti definiti
dall’utente o per selezionare ed eseguire un esperimento PrimePCR™. È possibile utilizzare questa
procedura guidata anche per ripetere un’analisi o per analizzare i dati dell’analisi.
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Finestra Protocol Editor (Editor protocollo)
Nell’editor protocollo è possibile creare, aprire, rivedere e modificare un protocollo. È possibile anche
modificare la temperatura del coperchio per il protocollo aperto. La funzionalità dell’editor protocollo è
dettagliata nel Capitolo 6, Creazione di protocolli.
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Finestra Plate Editor (Editor piastra)
Nell’editor piastra è possibile creare, aprire, rivedere e modificare una piastra. La funzionalità Editor
piastra è descritta dettagliatamente nel Capitolo 7, Preparazione delle piastre.
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Finestra Data Analysis (Analisi dei dati)
Nella finestra Data Analysis (Analisi dei dati) è possibile visualizzare e confrontare i dati delle analisi,
eseguire analisi statistiche, esportare i dati e creare report pronti per essere pubblicati. La funzionalità
Analisi dei dati è descritta nel Capitolo 9, Descrizione dell’analisi dei dati. Fare riferimento anche al
Capitolo 10, Dettagli dell’analisi dei dati.
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Capitolo 5 Finestra Home (Home)
Il software CFX Manager™ Dx fornisce un’interfaccia per lo sviluppo di protocolli PCR, la loro
esecuzione sui sistemi Dx e l’analisi dei dati PCR.

Questo capitolo descrive il Software CFX Manager Dx e le caratteristiche accessibili dalla finestra
Home (Home).
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Finestra Home (Home)
CFXManager Dx apre la finestra Home (Home) e visualizza la procedura guidata di avvio dalla quale
è possibile impostare un esperimento, eseguire o ripetere un’analisi oppure analizzare un’analisi
esistente. Dalla finestra Home (Home) è possibile anche visualizzare i registri applicazione e
strumenti, creare e gestire gli utenti e accedere a numerosi strumenti utili.

1. La barra del titolo del software visualizza il nome del software e l’utente collegato.

2. La barra dei menu offre l’accesso rapido ai comandi del menu File (File), View (Visualizza),
Users (Utenti), Run (Analisi), Tools (Strumenti), Window (Finestra) e Help (Guida).

3. I comandi della barra degli strumenti offrono un accesso rapido alle opzioni dei menu.

4. Nel riquadro di sinistra sono visualizzati gli strumenti collegati al computer CFX Manager Dx
e sono disponibili i pulsanti da cui è possibile azionare il coperchio e visualizzare lo stato
degli strumenti.

5. Il riquadro principale visualizza la finestra operativa. La finestra operativa predefinita della
schermata Home (Home) è quella della procedura guidata di avvio.

6. Nella barra di stato sono visualizzati i nomi degli strumenti collegati e dell’utente registrato.

LEGENDA
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Comandi del menu File (File)
New (Nuovo): apre una finestra di dialogo da cui è possibile scegliere di creare un nuovo protocollo, una
nuova piastra o un nuovo studio dei geni.

Open (Apri): apre una finestra di dialogo da cui è possibile scegliere di navigare e aprire un
protocollo, una piastra, un file di dati, uno studio dei geni, un file LIMS esistente, o un file di analisi
PrimePCR™.

Recent Data Files (File di dati recenti): visualizza un elenco dei file PCR aperti di recente.

Repeat a Run (Ripeti analisi): apre Windows Explorer (Esplora risorse di Windows) nella posizione
dei file PCR salvati, in cui è possibile individuare un’analisi da ripetere.

Exit (Esci): chiude CFX Manager Dx.

Comandi del menu View (Visualizza)
Application Log (Registro di applicazione): visualizza un registro di utilizzo del software
dall’installazione iniziale alla data attuale.

Run Reports (Report di analisi): visualizza un elenco di report di analisi.

Startup Wizard (Procedura guidata di avvio): visualizza la procedura guidata di avvio nel riquadro
principale.

Run Setup (Impostazione analisi): visualizza la finestra Run Setup (Impostazione analisi) nel
riquadro principale.

Instrument Summary (Riepilogo strumenti): visualizza la finestra Instrument Summary (Riepilogo
strumenti) nel riquadro principale.

Detected Instruments (Strumenti rilevati): consente di scegliere se visualizzare o no gli strumenti
collegati nel riquadro di sinistra. Per impostazione predefinita, il software visualizza gli strumenti
collegati nel riquadro di sinistra.

Toolbar (Barra degli strumenti): consente di scegliere se visualizzare o no la barra degli strumenti
nella parte superiore della schermata. Per impostazione predefinita, il software visualizza la barra
degli strumenti.

Status Bar (Barra di stato): consente di scegliere se visualizzare o no la barra di stato nella parte
inferiore dello schermo. Per impostazione predefinita, il software visualizza la barra di stato.

Show (Mostra): apre una finestra di dialogo dalla quale è possibile:

n Visualizzare o bloccare il registro di stato.

n Aprire e visualizzare la cartella dei dati di CFX Manager Dx.
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n Aprire e visualizzare la cartella dei dati dell’utente.

n Aprire e visualizzare la cartella dei dati di LIMS.

n Aprire e visualizzare la cartella dei dati di PrimePCR.

n Visualizzare la cronologia dell’analisi.

n Visualizzare le proprietà di tutti gli strumenti collegati.

Comandi del menu User (Utente)
Select User (Seleziona utente): apre la schermata di Login (Accedi) da cui si può selezionare un
utente dall’elenco a discesa User Name (Nome utente) e accedere all’applicazione.

Change Password (Modifica password): apre la finestra di dialogo Change Password (Modifica
password) in cui gli utenti possono modificare la propria password di accesso al Software CFX
Manager Dx.

User Preferences (Preferenze utente): apre la finestra di dialogo User Preferences (Preferenze
utente) in cui gli utenti possono cambiare le impostazioni predefinite per

n Inviare e ricevere una notifica e-mail al termine dell’analisi

n Salvare i file di dati

n Creare protocolli tramite l’editor protocollo o l’autowriter protocollo

n Creare piastre

n Analizzare i dati

n Eseguire analisi dell’espressione genica

n Determinare la qualità dei dati

n Esportare i dati dello strumento CFX Dx

User Administration (Amministrazione utenti): apre la finestra di dialogo User Administration
(Amministrazione utenti) in cui gli amministratori possono creare utenti, modificare le autorizzazioni
dei ruoli e assegnare i ruoli agli utenti.

Bio-Rad Service Login (Accesso tecnico): ad uso esclusivo del personale dell’assistenza tecnica
Bio-Rad. Non selezionare questo comando.
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Comandi del menu Run (Analisi)
User-defined Run (Analisi definita dall’utente): apre la finestra Run Setup (Impostazione analisi),
nella quale è possibile impostare un protocollo e una piastra definiti dall’utente, quindi eseguire un
esperimento PCR su strumenti selezionati.

PrimePCR Run (Analisi PrimePCR): apre la scheda Start Run (Avvia analisi) nella finestra Run
Setup (Impostazione analisi) con il protocollo PrimePCR e la disposizione della piastra predefiniti,
caricati in base allo strumento selezionato.

End-Point Only Run (Analisi solo del punto finale): apre la scheda Start Run (Avvia analisi) nella
finestra Run Setup (Impostazione analisi) con il protocollo del punto finale e la disposizione della
piastra predefiniti, caricati in base allo strumento selezionato.

Qualification Run (Analisi di qualificazione): apre la scheda Start Run (Avvia analisi) nella finestra
Run Setup (Impostazione analisi) con il protocollo di qualificazione e la disposizione della piastra Bio-
Rad predefiniti, caricati per lo strumento selezionato.

Comandi del menu Tools (Strumenti)

Master Mix Calculator: apre il Master Mix Calculator in cui si può creare una miscela di reazione e
stampare i calcoli.

Protocol AutoWriter (Autowriter protocollo): apre la finestra di dialogo Protocol AutoWriter
(Autowriter protocollo) in cui si può creare facilmente un protocollo.

Ta Calculator (Calcolatore Ta): apre un calcolatore Ta in cui si può calcolare la temperatura di
annealing dei primer.

Dye Calibration Wizard (Procedura guidata per la calibrazione dei coloranti): apre la procedura
guidata per la calibrazione dei coloranti grazie alla quale è possibile calibrare uno strumento per un
nuovo fluoroforo.

Reinstall Instrument Drivers (Reinstalla driver strumento): reinstalla i driver che controllano la
comunicazione con i sistemi PCR in tempo reale di Bio-Rad.

Manuale operativo | 53



Capitolo 5 Finestra Home (Home)

Zip Data and Log Files (Compatta dati e file di registro): apre una finestra di dialogo in cui è
possibile selezionare i file da compattare e salvare in un file zippato da conservare o inviare via posta
elettronica.

Batch Analysis (Analisi dei lotti): apre la finestra di dialogo Batch Analysis (Analisi dei lotti) in cui è
possibile impostare i parametri per analizzare più di un file di dati alla volta.

Options (Opzioni): apre una finestra di dialogo in cui è possibile

n configurare le impostazioni del server di posta elettronica;

n configurare le impostazioni di esportazione per LIMS e altri file di dati.

Comandi del menu Help (Guida)
Suggerimento: Il menu Help (Guida) è disponibile nella barra dei menu in tutte le finestra del
Software CFX Manager Dx.

Open Operation Manual (Apri manuale operativo): apre un PDF di questo manuale.

Gene Expression Gateway Web Site (Sito web gateway dell’espressione genica): apre la
pagina iniziale Bio-Rad per il Sistema CFX Dx.

PCR Reagents Web Site (Sito web reagenti PCR): apre il sito web dei reagenti PCR di Bio-Rad, da
cui è possibile ordinare i reagenti PCR, le supermiscele, i coloranti e i kit.

PCR Plastic Consumables Web Site (Sito web consumabili in plastica PCR): apre il sito web dei
consumabili e degli elementi in plastica per PCR di Bio-Rad, sul quale è possibile ordinare piastre
PCR, sigilli per piastre, provette e tappi e altri accessori di plastica.

Software Web Site (Sito web software): apre il sito web del software di analisi PCR di Bio-Rad, sul
quale è possibile ordinare le versioni aggiornate del Software CFX Manager Dx di Bio-Rad.

About (Info): visualizza le informazioni di copyright e versione di CFX Manager Dx.

54 | Sistemi CFX96 Dx e CFX96 DeepWell Dx



Finestra Home (Home)

Comandi della barra degli strumenti

: apre Windows Explorer, nel quale è possibile navigare e aprire un file di dati o un file di studio
dei geni.

: apre il Master Mix Calculator.

: apre la finestra Run Setup (Impostazione analisi).

: apre la finestra Run Setup (Impostazione analisi) con il protocollo PrimePCR predefinito e la
disposizione della piastra caricata in base allo strumento selezionato.

: apre la procedura guidata di avvio.
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Procedura guidata di avvio
Quando CFX Manager Dx si avvia, nel riquadro operativo appare la procedura guidata di avvio. Dalla
procedura guidata di avvio è possibile:

n Selezionare uno strumento dagli strumenti rilevati e impostare un’analisi definita dall’utente o
PrimePCR.

n Aprire e ripetere un’analisi.

n Aprire un file di dati per analizzare i risultati di una singola analisi o di un file di studio dei geni per i
risultati di più analisi dell’espressione genica.

Tali attività sono spiegate in dettaglio nei capitoli che seguono.

Barra di stato
A sinistra della barra di stato in fondo alla finestra principale del software è visualizzato lo stato attuale
degli strumenti rilevati. A destra della barra di stato il sistema visualizza il nome dell’utente attuale con
la data e l’ora.
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Riquadro Detected Instruments (Strumenti rilevati)
Il riquadro Detected Instruments (Strumenti rilevati) visualizza tutti gli strumenti collegati al computer CFX
Manager Dx. Per impostazione predefinita, ciascuno strumento viene visualizzato come icona e il suo
numero di serie viene visualizzato come nome.

Ad esempio, la seguente immagine visualizza quattro strumenti rilevati:

n due termociclatori C1000™ con moduli di reazione CFX96™DeepWell (CFX96DW1 e
CFX96DW2)

n due termociclatori C1000™ con moduli di reazione CFX96™ (CFX96l01 e CFX96l02)

Da questo riquadro è possibile eseguire quanto segue:

n Visualizzare le proprietà e i coloranti calibrati per uno strumento selezionato.

Per informazioni sulle proprietà dello strumento, fare riferimento a Visualizzazione delle proprietà
di uno strumento a pagina 61.

n Visualizzare lo stato di uno strumento collegato.

n Aprire il coperchio motorizzato sullo strumento selezionato.

n Chiudere il coperchio motorizzato sullo strumento selezionato.

n Visualizzare lo stato di tutti gli strumenti collegati.
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Per visualizzare lo stato di uno strumento collegato

u Nel riquadro Detected Instruments (Strumenti rilevati), selezionare lo strumento target ed
eseguire una delle seguenti opzioni:

n Fare clic su View Status (Visualizza stato) nella sezione Selected Instrument (Strumento
selezionato).

n Fare clic con il pulsante destro del mouse e selezionare View Status (Visualizza stato) sul
menu che viene visualizzato.

La finestra di dialogo Run Details (Dettagli analisi) viene visualizzata con la scheda Run Status
(Stato analisi). Lo stato dello strumento selezionato viene visualizzato sotto il riquadro dello stato
dell’analisi, ad esempio:

Per aprire o chiudere il coperchio di uno strumento

u Nel riquadro Detected Instruments (Strumenti rilevati), selezionare lo strumento target ed
eseguire una delle seguenti opzioni:

n Fare clic su Open Lid (Apri coperchio) nella sezione Selected Instrument (Strumento
selezionato).

n Fare clic con il pulsante destro del mouse e selezionare l’azione appropriate sul menu che
viene visualizzato.

n Aprire la finestra di dialogo Run Details (Dettagli analisi), selezionare la scheda Run Status
(Stato analisi) e fare clic su Open Lid (Apri coperchio) o Close Lid (Chiudi coperchio).
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Per visualizzare lo stato di tutti gli strumenti rilevati

u Eseguire una delle seguenti operazioni:

n Nella sezione All Instruments (Tutti gli strumenti) nel riquadro Detected Instruments
(Strumenti rilevati), fare clic su View Summary (Visualizza riepilogo).

n Nella barra dei menu, selezionare View > Instrument Summary (Visualizza > Riepilogo
strumenti).

Viene visualizza la finestra di dialogo Instrument Summary (Riepilogo strumenti).

Suggerimento: Se il sistema rileva solo uno strumento collegato, la sezione All Instruments
(Tutti gli strumenti) non viene visualizzata nel riquadro Detected Instruments (Strumenti
rilevati). Per visualizzare il riepilogo strumenti per un solo strumento, selezionare View >
Instrument Summary (Visualizza > Riepilogo strumenti).
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Comandi della barra degli strumenti Instrument Summary (Riepilogo strumenti)

La Tabella 10 elenca i comandi e le funzioni della barra degli strumenti Instrument Summary
(Riepilogo strumenti).

Pulsante Nome pulsante Funzione

Crea nuova analisi Crea un’analisi sul blocco selezionato
aprendo la finestra Run Setup
(Impostazione analisi).

Arresta Arresta l’analisi attuale sui blocchi
selezionati.

Pausa Mette in pausa l’analisi attuale sui
blocchi selezionati.

Riprendi Riprende l’analisi sui blocchi
selezionati.

Lampeggio indicatore di
blocco

Fa lampeggiare il LED indicatore sul
coperchio dei blocchi selezionati.

Apri coperchio Apre il coperchio motorizzato del
blocco selezionato.

Chiudi coperchio Chiude il coperchio motorizzato del
blocco selezionato.

Nascondi blocchi
selezionati

Nasconde i blocchi selezionati
nell’elenco Instrument Summary
(Riepilogo strumenti)

Mostra tutti i blocchi Mostra i blocchi selezionati nell’elenco
Instrument Summary (Riepilogo
strumenti)

Show (Mostra) Seleziona quali blocchi mostrare
nell’elenco. Selezionare una delle
opzioni per mostrare tutti i blocchi
rilevati, tutti i blocchi inattivi, tutti i
blocchi in esecuzione con l’utente
attuale o tutti i blocchi in esecuzione

Tabella 10. Comandi della barra degli strumenti Instrument Summary (Riepilogo strumenti)
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Visualizzazione delle proprietà di uno strumento
Dal riquadro degli strumenti rilevati è possibile visualizzare i dettagli sullo strumento selezionato,
incluse le proprietà, lo stato della vite di imballaggio e un elenco dei suoi coloranti calibrati (fluorofori).

Per visualizzare le proprietà dello strumento

u Nel riquadro Detected Instruments (Strumenti rilevati), fare clic con il pulsante destro del mouse
sullo strumento desiderato e selezionare Properties (Proprietà) nel menu che appare.

Scheda Properties (Proprietà)

Nella scheda Properties (Proprietà) sono elencati i dettagli tecnici sullo strumento selezionato tra cui il
modello, i numeri di serie dei rispettivi componenti e le versioni del firmware. Il nome predefinito dello
strumento (il suo numero di serie) appare in numerose posizioni, tra cui il riquadro Detected
Instruments (Strumenti rilevati) nella barra di intestazione della finestra di dialogo Instrument
Properties (Proprietà strumento). È possibile rinominare lo strumento in modo da identificarlo più
facilmente.

Per rinominare uno strumento

u Nella scheda Instrument Properties (Proprietà strumento), digitare un nome nella casella
Rename (Rinomina) nella parte superiore della scheda Properties (Proprietà) e fare clic su
Rename (Rinomina).
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Il nuovo nome viene visualizzato nella fila Nickname (Nome alternativo) della scheda Properties
(Proprietà) e anche nella barra di intestazione Instrument Properties (Proprietà strumento) e nel
riquadro Detected Instruments (Strumenti rilevati).

Scheda Shipping Screw (Vite di imballaggio)

La scheda Shipping Screw (Vite di imballaggio) visualizza lo stato attuale della vite di imballaggio per
lo strumento selezionato (Removed o Installed (Rimossa o Installata)). Nella scheda sono inoltre
incluse le istruzioni per installare o rimuovere la vite di imballaggio rossa.

Suggerimento: Se il software rileva la vite di imballaggio, nella finestra di dialogo Instrument
Properties (Proprietà strumento) appare automaticamente la scheda Shipping Screw (Vite di
imballaggio). Per rimuovere la vite, seguire le istruzioni.

Nota: Occorre rimuovere la vite di imballaggio prima di poter utilizzare lo strumento. Per maggiori
informazioni, vedere Rimozione della vite di imballaggio a pagina 29.

Scheda Calibrated Dyes (Coloranti calibrati)

Nella scheda Calibrated Dyes (Coloranti calibrati) sono visualizzati i fluorofori calibrati e le piastre per
lo strumento selezionato.

Per maggiori informazioni sulla calibrazione, fare clic sul pulsante Info (Informazioni) nella colonna
Detail (Dettagli).
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Operazioni preliminari

Impostazione delle preferenze utente
Suggerimento: Per utilizzare il Software CFX Manager Dx non è necessario eseguire queste
attività. È possibile saltare questa sezione o eseguire queste attività in qualsiasi momento.

In CFX Manager Dx è possibile personalizzare l’ambiente di lavoro. Se l’amministratore ha creato
utenti software, ogni utente può personalizzare il proprio ambiente di lavoro. Se l’amministratore non
ha creato utenti, le modifiche alle preferenze si applicano a chiunque acceda a CFX Manager Dx. (Per
informazioni sulla creazione di utenti CFX Manager Dx, fare riferimento a Appendice B, Gestione degli
utenti e dei ruoli di CFX Manager Dx.)

Ad esempio, nel menu Users > User Preferences (Utenti > Preferenze utente), è possibile effettuare le
seguenti operazioni:

n Impostare le notifiche e-mail relative al completamento dell’analisi.

n Modificare le impostazioni predefinite per

o La posizione in cui salvare i file

o I file di impostazione analisi

o Il prefisso del nome del file

n Impostare i parametri predefiniti da utilizzare per la creazione di un nuovo protocollo e una nuova
piastra.

n Impostare i parametri predefiniti per le analisi dei dati e l’espressione genica.

n Personalizzare i parametri di controllo qualità predefiniti.

n Personalizzare i dati dei parametri di esportazione dati

Nel menu Tools (Strumenti) è possibile effettuare le seguenti operazioni:

n Creare un master mix.

n Calibrare i coloranti per uno strumento specifico.

Nota: Il master mix e la calibrazione coloranti sono disponibili per chiunque acceda a CFX
Manager Dx.

Questa sezione spiega in modo dettagliato come eseguire queste attività.
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Impostazione delle notifiche e-mail

È possibile collegare CFX Manager Dx al server di posta elettronica in uscita per inviare una notifica e-
mail del completamento dell’analisi ad un elenco di utenti. Si può anche scegliere di allegare un file di
dati e un report analisi ad un elenco di utenti. Per impostare il collegamento tra CFX Manager Dx e il
server SMTP, vedere Collegamento di CFX Manager Dx ad un server SMTP a pagina 65.

Nota: La capacità di un’utente di accedere alle funzioni di impostazione della posta elettronica
dipende dal gruppo di utenti e dalle autorizzazioni assegnate dall’amministratore. Per dettagli
sulla gestione degli utenti e dei ruoli, vedere Gestione degli utenti a pagina 269.

Per impostare le notifiche e-mail

1. Selezionare Users > User Preferences (Utenti > Preferenze utente) per aprire la finestra di
dialogo User Preferences (Preferenze utente).

Appare la finestra di dialogo User Preferences (Preferenze utente) visualizzando la scheda Email
(E-mail).

Nota: Si viene informati se il sistema ha rilevato che non è stato impostato un server SMTP
valido per CFX Manager Dx. Fare clic su Configure Outgoing Email (Configura posta
elettronica in uscita) per aprire la finestra di dialogo Options (Opzioni) e configurare il server
SMTP di posta elettronica. Per maggiori informazioni, vedere Collegamento di CFX Manager
Dx ad un server SMTP a pagina 65.

2. Nella casella di testo To (A), digitare l’indirizzo e-mail di ogni persona che si prevede di informare
al termine di un’analisi. Tutti i destinatari riceveranno un’e-mail al termine dell’analisi.

Nota: Occorre immettere l’indirizzo e-mail su una riga separata. Premere Enter (Invio) o
Return (Ritorno a capo) dopo ciascun indirizzo.

3. (Facoltativo) Nella casella di testo cc, digitare l’indirizzo e-mail di ogni destinatario a cui si
prevede di inviare una copia di ogni notifica e-mail.
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4. (Facoltativo) Per impostazione predefinita tutti i destinatari ricevono una copia del file di dati come
allegato. Deselezionare questa casella di controllo se non si desidera allegare una copia del file di
dati.

5. (Facoltativo) Selezionare Attach Analysis Report (Allega report analisi) per allegare un PDF del
report dell’analisi all’e-mail.

6. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo User Preferences
(Preferenze utente).

Per modificare l’indirizzo e-mail di un destinatario

u Modificare l’indirizzo e-mail secondo necessità e fare clic su OK.

Per rimuovere un destinatario dell’e-mail

1. Selezionare il destinatario dell’e-mail e premere il tasto Delete (Elimina).

2. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra
di dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede torneranno
alle impostazioni originali di fabbrica. Procedere con cautela quando si fa clic su questo pulsante.

Collegamento di CFX Manager Dx ad un server SMTP

Importante: Alcuni provider di servizi webmail commerciali (quali Yahoo! e Gmail) hanno
aumentato la sicurezza delle e-mail. Se si utilizzano questi account, occorre attivare
l’impostazione Allow less secure apps (Permetti app meno sicure) nelle impostazioni
dell’account per permettere a CFX Manager Dx di inviare e-mail. Per maggiori informazioni,
vedere le informazioni relative alla sicurezza del proprio provider di servizi webmail.

Occorre stabilire una connessione dal CFX Manager Dx al server di posta elettronica prima che il
software possa inviare la notifica e-mail.

Per collegare CFX Manager Dx ad un server di posta elettronica

1. Eseguire una delle seguenti operazioni:

n Selezionare User > User Preferences (Utente > Preferenze utente) e fare clic sull’opzione
Configure Outgoing Email (Configura posta elettronica in uscita) della scheda Email (E-mail).

n Selezionare Tools > Options (Strumenti > Opzioni).

Si apre la finestra di dialogo Options (Opzioni) e visualizza la scheda E-mail (E-mail).
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2. Indicare le seguenti informazioni della propria società:

n SMTP Server Name (Nome server SMTP): il nome del server di posta elettronica in uscita
della società.

n Port (Porta): il numero porta del server SMTP, che solitamente è il 25.

n Use SSL (Utilizza SSL): opzione Secure Sockets Layer (SSL). Alcuni server SMTP
richiedono questa impostazione. Se la società non lo richiede, deselezionare questa casella
di controllo.

n Use Default “From” Address (Utilizza indirizzo “Da” predefinito): il nome del server di
posta elettronica della società. Alcuni server SMTP richiedono che tutte le e-mail inviate
abbiano un indirizzo “da” appartenente ad un determinato dominio, ad esempio
nome@società.com. In tal caso, deselezionare questa casella di controllo e immettere un
indirizzo e-mail valido.

n Authentication Required (Richiesta autenticazione): se il centro richiede l’autenticazione
dell’account, verificare che questa casella di controllo sia selezionata.

n User Name (Nome utente): nome dell’account autenticato. Questa informazione è
obbligatoria solo se è selezionata l’opzione Authentication Required (Richiesta
autenticazione).

n Password (Password): password dell’account autenticato. Questa informazione è
obbligatoria solo se è selezionata l’opzione Authentication Required (Richiesta
autenticazione).

3. Per verificare se le impostazioni del server SMTP sono corrette, immettere un indirizzo e-mail
valido nella casella di testo Test Email Address (Prova indirizzo e-mail) e fare clic sulla casella
Test Email (Prova e-mail).
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Nota: Alcuni server SMTP non permettono di inviare allegati e altri permettono di inviare
allegati solo di un determinato formato. Se si intende inviare per e-mail file di dati e/o report
utilizzando CFX Manager Dx, selezionare Test Attachment (Prova allegato) e impostare le
dimensioni in MB per l’allegato su 5 megabyte (MB) o più.

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Modifica delle impostazioni file predefinite

Nella scheda Files (File), presente nella finestra di dialogo User Preference (Preferenze utente), è
possibile modificare quanto segue:

n La posizione predefinita in cui salvare i file CFX Manager Dx

n I file predefiniti per l’impostazione dell’analisi

n I parametri di denominazione file predefiniti

Per cambiare le impostazioni file predefinite

1. Selezionare Users > User Preferences (Utenti > Preferenze utente) per aprire la finestra di
dialogo User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Files (File).
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3. Nella sezione Default Folder for File Creation (Cartella predefinita per la creazione file),
selezionare la cartella predefinita nella quale si desidera salvare i nuovi file. È possibile
selezionare una posizione diversa per ciascun tipo di file:

n Protocollo

n Piastra

n File di dati

n Studio dei geni

4. Nella sezione File Selection for Run Setup (Selezione dei file per l’impostazione dell’analisi),
individuare e selezionare i file protocollo target e piastra che devono apparire quando si apre la
finestra Experiment Setup (Impostazione esperimento).

5. Nella sezione file di dati, definire il prefisso e/o il suffisso per i file di dati. Per ogni parte,
selezionare un nuovo valore dall’elenco a discesa. Si possono fornire anche valori prefisso e
suffisso personalizzati nelle caselle di testo Prefix (Prefisso) e Suffix (Suffisso).

Il CFX Manager Dx visualizza un’anteprima del nome file sotto le caselle di selezione.

6. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra
di dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede torneranno
alle impostazioni originali di fabbrica. Procedere con cautela quando si fa clic su questo pulsante.
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Impostazione dei parametri predefiniti del protocollo

Per impostare i parametri predefiniti del protocollo per l’editor protocollo e per
l’autowriter protocollo

1. Selezionare Users > User Preferences (Utenti > Preferenze utente) per aprire la finestra di
dialogo User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Protocol
(Protocollo).

3. Nella sezione Protocol Editor (Editor protocollo), specificare i valori per le seguenti impostazioni
che sono visualizzate nell’editor protocollo:

n Sample volume (Volume del campione): volume di ogni campione nei pozzetti (in µl).

n Lid Shutoff temperature (Temperatura di arresto coperchio): temperatura in ºC a cui il
riscaldatore coperchio si spegne durante l’analisi.

4. Nella sezione Protocol AutoWriter (Autowriter protocollo), specificare i valori per le seguenti
impostazioni che sono visualizzate nell’autowriter protocollo:

n Annealing temperature (Temperatura di annealing): temperatura in ºC per gli esperimenti
che utilizzano la DNA polimerasi iProof™, la DNA polimerasi iTaq™ o altre polimerasi.

n Amplicon length (Lunghezza amplicone): lunghezza dell’amplicone in bp.

5. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.
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Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra
di dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede torneranno
alle impostazioni originali di fabbrica. Procedere con cautela quando si fa clic su questo pulsante.

Impostazione dei parametri predefiniti della piastra

Le modifiche apportate alla scheda Plate (Piastra) sono disponibili per tutti gli utenti del software. Le
modifiche apportate durante l’impostazione piastra sono disponibili per gli utenti dopo il salvataggio e
la chiusura del file piastra.

Nella finestra di dialogo User Preference (Preferenze utente), è possibile eseguire quanto segue:

n Impostare i parametri piastra predefiniti.

n Aggiungere nuovi nomi target e campione alle rispettive librerie.

n Eliminare i nomi target e campione dalle rispettive librerie.

Per impostare i parametri predefiniti della piastra

1. Selezionare Users > User Preferences (Utenti > Preferenze utente) per aprire la finestra di
dialogo User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Plate
(Piastra).

70 | Sistemi CFX96 Dx e CFX96 DeepWell Dx



Operazioni preliminari

3. Specificare i valori per le seguenti impostazioni per il nuovo file piastra. Tali valori sono
visualizzati nella finestra dell’editor piastra:

n Plate type (Tipo di piastra)

n Plate size (Dimensione piastra)

n Units (Unità): concentrazione del modello iniziale per i pozzetti che contengono gli standard.

CFX Manager Dx utilizza queste unità per creare una curva standard nella scheda
Quantification (Quantificazione) dell’analisi dei dati.

n Scientific notation (Notazione scientifica): quando è selezionata questa opzione, CFX
Manager Dx visualizza le unità della concentrazione con notazione scientifica.

n Scan mode (Modalità di scansione): numero o tipo di canali da scansionare durante
l’analisi.

n Fluorophores (Fluorofori): fluorofori predefiniti che appaiono nei controlli di caricamento
dei pozzetti dell’editor piastra.

n Libraries (Librerie): nomi target e campione che si utilizzano tipicamente negli esperimenti:

o Target names (Nomi target): nomi dei geni e delle sequenze target.

o Sample names (Nomi campione): nomi dei campioni dell’esperimento o di una
caratteristica di identificazione dei campioni (ad esempio, Topo1, Topo2, Topo3).

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Per aggiungere un nuovo nome target o campione

u Nella casella appropriata della libreria, digitare il nome per il target o campione e fare clic su OK.

Per eliminare un nome target o campione

u Nella casella appropriata della libreria, selezionare il nome e premere il tasto Delete (Canc) e
quindi fare clic su OK.

Importante: I nomi che vengono eliminati dalla libreria sono rimossi dal software e non sono più
disponibili per gli utenti. Per ripristinare i nomi CFX Manager Dx predefiniti, fare clic su Restore
Defaults (Ripristina impostazioni predefinite). Facendo clic su Restore Defaults (Ripristina
impostazioni predefinite) nella finestra di dialogo User Preferences (Preferenze utente), tutte le
preferenze in tutte le schede torneranno alle impostazioni originali di fabbrica. Procedere con
cautela quando si eliminano i nomi CFX Manager Dx predefiniti e quando si fa clic su questo
pulsante.
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Impostazione dei parametri predefiniti per l’analisi dei dati

Per impostare i parametri predefiniti per l’analisi dei dati

1. Selezionare Users > User Preferences (Utenti > Preferenze utente) per aprire la finestra di
dialogo User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Data
Analysis (Analisi dei dati).

3. Nella sezione Analysis Mode (Modalità di analisi), selezionare la modalità con la quale analizzare
i dati (Fluorophore (Fluoroforo) o Target (Target)).

4. Nella sezione PCR Quantitation (Quantificazione PCR), impostare i parametri predefiniti per le
seguenti opzioni:

n Baseline Setting (Impostazione linea basale): metodo della linea basale per la modalità di
analisi.

n Cq Determination Mode (Modalità di determinazione Cq): modalità con la quale vengono
calcolati i valori Cq per ciascuna traccia di fluorescenza (regressione o soglia singola).
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n Threshold Calc. Mode (Modalità calc. soglia): quantità target del punto finale.

L’impostazione predefinita è Auto (Automatico). Cioè, il software calcola automaticamente il
punto finale target. Per impostare una soglia specifica, deselezionare la casella di controllo
Auto (Automatico) e inserire la quantità del punto finale desiderata, calcolata in relative unità
di fluorescenza (o RFU). Il valore massimo è 65.000,00 RFU. I file di dati per le analisi
successive utilizzeranno questa impostazione della soglia.

n Baseline Calc. Mode (Modalità calc. linea basale): valore di linea basale per tutte le
tracce.

L’impostazione predefinita è Auto (Automatico). Cioè, il software calcola automaticamente la
linea basale per tutte le tracce. Per impostare una valore specifico di linea basale,
deselezionare la casella di controllo Auto (Automatico) e inserire i valori minimo e massimo
per l’intervallo di ciclo (da 1 a 9.999). I file di dati per le analisi successive utilizzeranno
questo intervallo di ciclo.

n Log View (Visualizza registro): determina come il software visualizza i dati di
amplificazione:

o On (Acceso): i dati di amplificazione sono visualizzati in un grafico semilogaritmico.

o Off (Spento): i dati di amplificazione sono visualizzati in un grafico lineare.

5. Nella sezione End Point (Punto finale), selezionare il numero di cicli finali medio quando si
effettua il calcolo del punto finale:

n PCR (PCR): numero di cicli finali medio per i dati di quantificazione (il valore predefinito è 5).

n End Point Only run (Analisi solo del punto finale): numero di cicli finali medio per i dati
del punto finale (il valore predefinito è 2).

6. Nella sezione Melt Curve (Curva di fusione), selezionare il tipo di picco da rilevare (positivo o
negativo).

7. Nella sezione Well Selector (Selettore pozzetto), selezionare come visualizzare le etichette
pozzetto (in base al tipo di campione, nome target o nome campione).

8. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra
di dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede torneranno
alle impostazioni originali di fabbrica. Procedere con cautela quando si fa clic su questo pulsante.
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Impostazione dei parametri predefiniti del file di dati dell’espressione genica

Per impostare i parametri predefiniti per un nuovo file di dati dell’espressione genica

1. Selezionare Users > User Preferences (Utenti > Preferenze utente) per aprire la finestra di
dialogo User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Gene
Expression (Espressione genica).

3. Specificare i valori per le seguenti impostazioni:

n Relative to (Relativo a): rappresenta i dati dell’espressione genica rispetto ad un controllo
(che inizia con 1) o allo zero:

o Zero (Zero): il software ignora il controllo. Questa è l’impostazione predefinita quando
non viene assegnato alcun campione di controllo nella finestra Experiment Settings
(Impostazioni esperimento).

o Control (Controllo): il software calcola i dati in relazione al campione di controllo
assegnato nella finestra Experiment Setup (Impostazione esperimento).

n X-axis (Asse X): rappresenta il campione o il target sull’asse x.

n Y-axis (Asse Y): rappresenta la scala lineare, log2 o log10 sull’asse y.
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n Scaling (Messa in scala): l’opzione di messa in scala per il grafico (l’opzione predefinita è
Unscaled (Senza scala):

o Highest (Più alto): il software mette in scala il grafico fino al punto di dati più alto.

o Lowest (Più basso): il software mette in scala il grafico fino al punto di dati più basso.

o Unscaled (Senza scala): il software presenta i dati senza scala nel grafico.

n Mode (Modalità): la modalità di analisi, quantità relativa (∆Cq) o espressione normalizzata
(∆∆Cq).

n Error Bar (Barra di errore): la variabilità dei dati presentata come deviazione standard (Std.
Dev.) o errore standard della media (Std. Error Mean).

n Error Bar Multiplier (Moltiplicatore barra di errore): il moltiplicatore di deviazione
standard utilizzato per rappresentare le barre di errore (il valore predefinito è 1).

È possibile aumentare il moltiplicatore a 2 o 3.

n Sample Types to Exclude (Tipi di campioni da escludere): i tipi di campione da
escludere dall’analisi.

È possibile selezionare uno o più campioni da escludere dall’analisi. Per escludere tutti i tipi
di campione, deselezionare le caselle di controllo di ogni tipo di campione selezionato.

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra
di dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede torneranno
alle impostazioni originali di fabbrica. Procedere con cautela quando si fa clic su questo pulsante.

Personalizzazione delle regole di controllo qualità

In CFX Manager Dx, è possibile impostare le regole di controllo qualità, che vengono applicate ai dati
nella finestra Data Analysis (Analisi dei dati). Il software convalida i dati rispetto alle regole impostate.

Nota: Per impostazione predefinita, tutte le regole di controllo qualità sono abilitate.

Suggerimento: È possibile escludere facilmente i pozzetti che non rispettano un parametro CQ
dall’analisi nel modulo CQ della finestra Data Analysis (Analisi dei dati).

Per personalizzare le regole di controllo qualità

1. Selezionare Users > User Preferences (Utenti > Preferenze utente) per aprire la finestra di
dialogo User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda QC (CQ).
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dove:

n NTC: nessun controllo modello

n NRT: nessun controllo di trascrittasi inversa

n Efficiency: efficacia della reazione

n Std Curve R^2: valore del quadrato R per la curva standard

n Replicate group Cq Std Dev: deviazione standard calcolata per ciascun gruppo di replicati

3. Per ciascuna regola CQ, eseguire una delle seguenti operazioni:

n Per usare il suo valore predefinito, non fare nulla.

n Per cambiarne il valore, fare clic sulla sua casella di testo Value (Valore), digitare un nuovo
valore e premere il tasto Enter (Invio).

n Per disabilitare la regola, deselezionare la sua casella di controllo Use (Usa).

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra
di dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede torneranno
alle impostazioni originali di fabbrica. Procedere con cautela quando si fa clic su questo pulsante.
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Personalizzazione dei parametri di esportazione dati

È possibile esportare i dati CFX Manager Dx nei seguenti formati:

n Testo (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

È possibile specificare il tipo di dati da esportare e personalizzare la stampa dei dati esportati.

Per personalizzare i parametri di esportazione dati

1. Selezionare Users > User Preferences (Utenti > Preferenze utente) per aprire la finestra di
dialogo User Preferences (Preferenze utente).

2. Nella finestra di dialogo User Preferences (Preferenze utente), selezionare la scheda Custom
Export (Personalizza esportazione).
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3. Nell’elenco a discesa Export Format (Formato esportazione), selezionare un formato in cui
esportare i dati.

4. Nella sezione Data to Export (Dati da esportare), selezionare o deselezionare le caselle di
controllo per il tipo di dati da esportare. Gli elementi selezionati sono visualizzati nella casella di
elenco Exported Columns (Colonne esportate).

Nota: Per impostazione predefinita, le informazioni sull’analisi sono incluse nell’intestazione.
Deselezionare questa casella di controllo se si desidera che le informazioni sull’analisi non
vengano incluse.

5. È possibile cambiare l’ordine di visualizzazione di stampa degli elementi selezionati.

Nella casella di elenco Exported Columns (Colonne esportate), selezionare l’elemento, quindi
fare clic sui pulsanti freccia a sinistra dell’elenco per spostarlo su o giù.

6. Opzionalmente, è possibile cambiare i nomi delle colonne di stampa degli elementi selezionati:

a. Fare clic su Customize Column Names (Personalizza nomi colonna).

Viene visualizzata la finestra di dialogo Column Name Customizer (Personalizzazione nomi
colonna).

b. Per ciascun nome colonna predefinito che si desidera cambiare, digitare il nuovo nome nel
campo Custom Name (Personalizza nome) corrispondente.

c. Eseguire una delle seguenti operazioni:

n Fare clic su OK per salvare le modifiche e tornare alla scheda Custom Export
(Personalizza esportazione). Il nuovo nome viene visualizzato tra parentesi accanto al
nome colonna predefinito nella casella di elenco Exported Columns (Colonne
esportate).

n Fare clic su Cancel (Annulla) per annullare le modifiche e tornare alla scheda Custom
Export (Personalizza esportazione).

7. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo.

Importante: Facendo clic su Restore Defaults (Ripristina impostazioni predefinite) nella finestra
di dialogo User Preferences (Preferenze utente), tutte le preferenze in tutte le schede torneranno
alle impostazioni originali di fabbrica. Procedere con cautela quando si fa clic su questo pulsante.

Creazione di un master mix delle reazioni
Utilizzando il Master Mix Calculator di CFX Manager Dx, è possibile calcolare facilmente il volume
richiesto di ciascun componente nel master mix. È possibile stampare la tabella di calcolo del master
mix con la stampante predefinita e salvare i calcoli per ciascun target per un uso futuro.
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Per creare un master mix delle reazioni con il Master Mix Calculator

1. Per aprire il Master Mix Calculator, eseguire una delle seguenti operazioni:

n Selezionare Tools > Master Mix Calculator (Strumenti > Master Mix Calculator).

n Fare clic su Master Mix Calculator nella barra degli strumenti.

Si apre la finestra di Master Mix Calculator.

2. Nella sezione Reaction (Reazione), selezionare una metodologia di rilevamento:

n SYBR®Green/EvaGreen

n Sonde

3. Per creare un nuovo target, nella sezione Target fare clic su Create New (Crea nuovo).
Nell’elenco a discesa dei target appare un nuovo nome target.

4. (Facoltativo) Per cambiare il nome target predefinito:

a. Evidenziare il nome target nell’elenco a discesa dei target.
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b. Immettere un nuovo nome target nella casella Target (Target).

c. Premere il tasto Enter (Invio).

5. Regolare le concentrazioni iniziale e finale per i primer diretto e inverso e per le sonde.

6. Nella sezione Master Mix (Impostazione del master mix), regolare i valori per

n Numero di reazioni da eseguire

n Volume di reazione per pozzetto

n Volume modello per pozzetto

n Concentrazione supermix per pozzetto

n Volume di reazione in eccesso per pozzetto

7. (Facoltativo) Eseguire le fasi 2-6 per il numero necessario di target.

8. Nella sezione Choose Target to Calculate (Scegli target da calcolare), selezionare il target da
calcolare.

Suggerimento: È possibile calcolare solo un target, diversi target o tutti i target nello stesso
tempo.

I volumi calcolati dei componenti necessari, per ciascun target selezionato, sono visualizzati nella
tabella dei master mix.

9. Fare clic su Set as Default (Imposta come predefinito) per impostare le quantità inserite nelle
sezioni Target and Master Mix Setup (Impostazioni Target e Master mix) come nuovi valori
predefiniti.

10. Fare clic su OK per salvare il contenuto della finestra di dialogo Master Mix Calculator.

Per stampare la tabella di calcolo del master mix

u Per stampare una tabella di calcolo del master mix, fare clic su Print (Stampa).

La tabella di calcolo viene stampata sulla stampante predefinita.

Per salvare la tabella di calcolo del master mix come .pdf

u Sostituire la stampante predefinita con un driver PDF e fare clic su Print on the Master Mix
Calculator (Stampa su Master Mix Calculator).

Per eliminare target

u Selezionare il target utilizzando l’elenco a discesa dei target e fare clic su Remove (Rimuovi).
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Importante: La rimozione di un target dall’elenco dei target lo rimuove da ogni calcolo del
master mix in cui era stato utilizzato. Procedere con cautela quando si elimina un target.
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Calibrazione dei nuovi coloranti
I sistemi CFX96™Dx vengono calibrati in fabbrica per i fluorofori comunemente utilizzati nelle piastre a
pozzetti bianchi e a pozzetti trasparenti. La Tabella 11 elenca i fluorofori e il canale per cui ciascuno
strumento viene calibrato.

Nota: I sistemi CFX96 includono anche un canale dedicato alla chimica FRET. Questo canale
non richiede una calibrazione per determinati coloranti.

Fluorofori Canale Eccitazione, nm Rilevamento, nm

FAM, SYBR® Green I 1 450–490 515–530

VIC, HEX, CAL Fluor Gold 540, Cal
Fluor Orange 560

2 515–535 560–580

ROX, Texas Red, CAL Fluor Red
610, TEX 615

3 560–590 610–650

CY5, Quasar 670 4 620–650 675–690

Quasar 705, Cy5.5 5 672–684 705–730

Tabella 11. Fluorofori calibrati in fabbrica e canali

Per calibrare nuovi coloranti per i sistemi CFX

1. Nella finestra Home (Home), selezionare uno strumento target nel riquadro Detected Instruments
(Strumenti rilevati).

2. Selezionare Tools > Calibration Wizard (Strumenti > Procedura guidata di calibrazione) per aprire
la procedura guidata di calibrazione del colorante.
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I fluorofori già calibrati per lo strumento target sono visualizzati nella tabella dei fluorofori calibrati.

3. Nella sezione Calibrate New or Existing Fluorophores (Calibra fluorofori nuovi o esistenti),
selezionare dall’elenco a discesa il fluoroforo da calibrare.

Se il nome del fluoroforo non è incluso nell’elenco, digitarne il nome nella casella di testo per
aggiungerlo all’elenco.

4. Selezionare il tipo di piastra per il fluoroforo.

Se il tipo di piastra non è incluso nell’elenco, digitarne il nome nella casella di testo per
aggiungerlo all’elenco.

5. Selezionare un canale per il fluoroforo.

6. Selezionare una colonna piastra per il fluoroforo.

7. (Facoltativo) Digitare un colore da associare al fluoroforo.

8. Fare clic su Add to Plate (Aggiungi a piastra) per aggiungere il fluoroforo.

9. (Facoltativo) Ripetere le fasi 3-8 per aggiungere ciascun fluoroforo che si pianifica di calibrare per
la piastra.

10. Una volta completata l’aggiunta di fluorofori, fare clic su View Plate (Visualizza piastra) per aprire
la finestra Pure Dye Plate Display (Display piastra colorante puro).

Usare questa finestra come guida per il caricamento dei coloranti nella piastra.

11. Preparare una piastra da 96 pozzetti per la calibrazione del colorante:

a. Pipettare la soluzione di colorante in ciascun pozzetto, seguendo il pattern mostrato in Pure
Dye Plate Display (Visualizzazione piastra colorante puro).

b. Per ciascun fluoroforo, riempire quattro pozzetti con 50 µl (piastra a 96 pozzetti) della
soluzione di colorante da 300 nM. Non dimenticare che almeno metà piastra contiene
pozzetti vuoti.

c. Sigillare la piastra usando il metodo di sigillatura che sarà utilizzato nell’esperimento.

12. Posizionare la piastra di calibrazione nel blocco e chiudere il coperchio.

13. Nella procedura guidata per la calibrazione dei coloranti, fare clic su Calibrate (Calibra), quindi su
OK per confermare che la piastra è bloccata.

14. Quando il Software CFX Manager Dx completa l’analisi di calibrazione, viene visualizzata una
finestra di dialogo. Fare clic su Yes (Sì) per terminare la calibrazione e aprire il Dye Calibration
Viewer (Visualizzatore calibrazione colorante).

15. Fare clic su OK per chiudere la finestra.
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Un protocollo è una serie di fasi che vengono eseguite in una sequenza specifica. Nel software CFX
Manager™ Dx, tutte le fasi sono associate a opzioni dello strumento. Ad esempio, le fasi ordinano allo
strumento di controllare la temperatura del blocco e del coperchio, applicare una differenza di
temperatura nel blocco, effettuare la lettura della piastra o effettuare l’analisi della curva di fusione.
Ciascuna opzione viene specificata per i vari tipi di piastre e di analisi.

Il CFX Manager Dx fornisce due opzioni per la creazione dei protocolli: l’editor protocollo e l’autowriter
protocollo.

Le funzioni dell’editor protocollo includono quanto segue:

n Controlli del protocollo standard per creare rapidamente i protocolli

n Capacità di calcolare velocemente un gradiente per il numero selezionato di righe

n Capacità di calcolare velocemente il tempo di esecuzione per il tipo di piastra selezionato

n Capacità di modificare le fasi del protocollo

n Capacità di salvare i protocolli per il riutilizzo

n Capacità di stampare il protocollo con una stampante predefinita

L’autowriter protocollo genera automaticamente un protocollo PCR personalizzato con fasi di avvio a
caldo, denaturazione iniziale, annealing ed estensione utilizzando i parametri forniti dall’utente. È
inoltre possibile visualizzare una rappresentazione grafica del protocollo suggerito e modificare,
eseguire o salvare il protocollo.
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Finestra Protocol Editor (Editor protocollo)
Utilizzare l’editor protocollo per creare, aprire, rivedere e modificare un protocollo. Per impostazione
predefinita, l’editor protocollo apre un protocollo a 2 fasi in tempo reale per una piastra da 96 pozzetti.

1. La barra dei menu offre l’accesso rapido ai comandi del menu File (File), Settings
(Impostazioni) e Tools (Strumenti).

2. La barra degli strumenti offre l’accesso rapido per salvare e stampare il protocollo, stabilire
dove inserire una fase, impostare il volume del campione e visualizzare il tempo stimato di
esecuzione del protocollo.

3. Nel riquadro principale è visualizzata una rappresentazione grafica del protocollo.

4. Nel riquadro inferiore appare la struttura del protocollo.

5. Nel riquadro di sinistra sono visualizzati i controlli del protocollo che è possibile aggiungere
per personalizzare il protocollo.

LEGENDA
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Comandi del menu File (File)
Save (Salva): salva il protocollo attuale.

Save As (Salva con nome): salva il protocollo attuale con un nuovo nome o in una nuova posizione.

Close (Chiudi): chiude l’editor protocollo.

Comando del menu Settings (Impostazioni)
Lid Settings (Impostazioni coperchio): apre la finestra di dialogo Lid Setting (Impostazione
coperchio) in cui si può modificare o impostare la temperatura del coperchio.

Comandi del menu Tools (Strumenti)
Gradient Calculator (Calcolatore gradiente): apre una finestra di dialogo dalla quale è possibile
selezionare il tipo di blocco per una fase gradiente. L'impostazione predefinita è 96 pozzetti.

Run time Calculator (Calcolatore tempo di analisi): apre una finestra di dialogo dalla quale è
possibile selezionare il tipo di piastra e la modalità di scansione per calcolare il tempo di analisi stimato
nella finestra Run Setup (Impostazione analisi). L'impostazione predefinita è 96 pozzetti, tutti i canali.

Comandi della barra degli strumenti

: salva il file del protocollo attuale.

: stampa la finestra selezionata.

: utilizzare questo comando per selezionare dove inserire i passi riguardanti la
fase attualmente selezionata.

: utilizzare questo comando per immettere un volume campione in µl. I volumi
dei campioni variano in base al tipo di blocco:

n Per un blocco di 96 pozzetti profondi, l’intervallo è 0–125 µl.

n Per un blocco di 96 pozzetti, l’intervallo è 0–50 µl.
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: visualizza il tempo stimato di esecuzione in base alle fasi del protocollo, alla
velocità di rampa e al tipo di blocco selezionati.

: visualizza informazioni della Guida sui protocolli.

Comandi di modifica protocollo
Il riquadro sinistro della finestra Protocol Editor (Editor protocollo) comprende i comandi che è
possibile utilizzare per creare i protocolli.

Ciascun controllo è composto da una serie di parametri che rappresentano una fase nel protocollo. È
possibile modificare ciascun parametro e aggiungerlo o rimuoverlo per personalizzare il protocollo.
Questa sezione descrive le opzioni di ciascun controllo.

n Insert Step (Inserisci fase): inserisce una fase prima o dopo la fase
selezionata. È possibile modificare i valori della temperatura e del
tempo di mantenimento nella visualizzazione grafica del protocollo o
nella struttura del protocollo.

n Insert Gradient (Inserisci gradiente): inserisce una fase gradiente
in base al tipo di blocco pozzetto selezionato nel calcolatore
gradiente. È possibile modificare l’intervallo gradiente nel riquadro
Gradient (Gradiente) che viene visualizzato quando si inserisce una
fase gradiente.

n Insert GOTO (Inserisci GOTO): inserisce una fase di ciclo (loop),
che indica al software di ripetere fasi specifiche in sequenza per un

numero di cicli specificato. Le ripetizioni iniziano dopo il completamento del primo ciclo. Ad
esempio, è possibile indicare al software di eseguire 39 ripetizioni delle fasi 2–4. Dopo la
ripetizione finale, il software avrà eseguito le fasi 2–4 per un totale di 40 volte. È possibile
modificare la fase di ritorno (GOTO) e il numero di cicli nella visualizzazione grafica o nella
struttura del protocollo.

n Insert Melt Curve (Inserisci curva di fusione): inserisce una fase di lettura della curva di
fusione.

n Insert Plate Read to Step (Inserisci lettura piastra nella fase): aggiunge un comando di
lettura piastra alla fase selezionata. Una lettura piastra misura la quantità di fluorescenza alla fine
di un ciclo. La fase di lettura piastra di solito è l’ultima fase in un loop GOTO.

Suggerimento: Dopo avere aggiunto un comando di lettura piastra ad una fase, il pulsante
diventa Remove Plate Read (Rimuovi lettura piastra) quando si seleziona la fase.
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n Remove Plate Read (Rimuovi lettura piastra): rimuove un comando di lettura piastra dalla fase
selezionata.

Suggerimento: Dopo aver rimosso un comando di lettura piastra da una fase, il pulsante
diventa Add Plate Read to Step (Aggiungi lettura piastra a fase) quando si seleziona la fase.

n Step Options (Opzioni fase): apre la finestra di dialogo Step Options (Opzioni fase) e visualizza
le opzioni disponibili per la fase selezionata. Per informazioni dettagliate sulle opzioni della fase
consultare le Opzioni fase a pagina 89.

Suggerimento: Inoltre, è possibile accedere alle opzioni della fase facendo clic con il
pulsante destro del mouse sulla fase nella visualizzazione grafica.

n Delete Step (Elimina fase): elimina la fase selezionata dal protocollo.

Opzioni fase

Aprire la finestra di dialogo Step Options (Opzioni fase) per visualizzare le opzioni che è possibile
aggiungere, modificare o rimuovere da una fase.

n Plate Read (Lettura piastra): quando è selezionata questa opzione, viene aggiunta una lettura
piastra alla fase.

n Temperature (Temperatura): imposta la temperatura target per la fase selezionata.

n Gradient (Gradiente): imposta l’intervallo gradiente per la fase; l’intervallo è 1–24 °C.

Nota: Viene eseguito un gradiente con la temperatura più bassa nella parte anteriore del
blocco (in questa immagine la fila H) e con la temperatura più alta nella parte posteriore del
blocco (in questa immagine la fila A).
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n Increment (Aumenta): quantità di cui incrementare (o ridurre) la temperatura della fase
selezionata; questo valore viene aggiunto alla temperatura target con ogni ciclo. L’intervallo è
±0,1-10 °C.

Nota: Per ridurre la temperatura, immettere un segno meno (-) prima del valore numerico (ad
esempio, -5 °C).

n Ramp Rate (Velocità rampa): velocità di rampa per la fase selezionata; l’intervallo dipende dalle
dimensioni del blocco.

n Time (Tempo): tempo di mantenimento della fase selezionata.

n Extend (Prolunga): quantità di tempo (in sec) di cui prolungare o ridurre la fase selezionata;
questa opzione viene aggiunta al tempo di mantenimento in ogni fase; l’intervallo è 1-60 sec.

n Beep (Bip): quando è selezionata questa opzione, viene riprodotto un bip al termine della fase.

Suggerimento: Quando si immette un valore che non rientra nell’intervallo dell’opzione, il
software cambia il numero con il valore più vicino che rientra nell’intervallo.
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Creazione di un protocollo nell’editor protocollo
Usando l’editor protocollo, è possibile creare dei file di protocollo personalizzati. Inoltre, è possibile
modificare e salvare i file di protocollo precedentemente salvati o i file di protocollo campione spediti
con il Software CFX Manager Dx.

Per creare un nuovo file di protocollo, procedere come segue:

n Aprire un file di protocollo nell’editor protocollo.

Suggerimento: È possibile aprire un protocollo nuovo o esistente nell’editor protocollo.

n Impostare il nuovo protocollo.

n Aggiungere le fasi al protocollo dal riquadro dei controlli del protocollo.

n Modificare le proprietà delle fasi.

n Salvare il protocollo.

Suggerimento: Per creare un nuovo protocollo da un file di protocollo precedentemente salvato
o campione, vedere Apertura di un protocollo esistente nell’editor protocollo a pagina 92.

Apertura di un nuovo file di protocollo nell’editor protocollo
CFXManager Dx offre più opzioni per aprire un nuovo file di protocollo:

n Dalla finestra Home (Home)

n Dalla finestra di dialogo Startup Wizard (Procedura guidata di avvio)

n Dalla finestra di dialogo Run Setup (Impostazione analisi)

Per aprire un nuovo file di protocollo dalla finestra Home (Home)

u Selezionare File > New > Protocol (File > Nuovo > Protocollo).

Si apre la finestra Protocol Editor (Editor protocollo), che visualizza il file di protocollo predefinito.

Suggerimento: Per le informazioni sull’impostazione del protocollo predefinito, vedere
Modifica delle impostazioni file predefinite a pagina 67.

Per aprire un nuovo file di protocollo dalla procedura guidata di avvio

1. Nella finestra Home (Home), eseguire una delle seguenti operazioni per aprire la procedura
guidata di avvio se non è già visualizzata:

n Selezionare View > Startup Wizard (Visualizza > Procedura guidata di avvio).

n Fare clic su Startup Wizard (Procedura guidata di avvio) sulla barra degli strumenti.
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Per impostazione predefinita, la procedura guidata di avvio visualizza la scheda Run Setup
(Impostazione analisi) con il tipo di strumento CFX96™ selezionato.

2. Se necessario, selezionare il tipo di strumento dall’elenco a discesa.

3. Fare clic su User-defined (Definito dall’utente) come tipo di analisi.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) nella scheda Protocol (Protocollo)
e visualizza il file di protocollo predefinito.

4. Fare clic su Create New (Crea nuovo).

Si apre la finestra Protocol Editor (Editor protocollo), che visualizza il protocollo in tempo reale
predefinito.

Per aprire un nuovo protocollo dalla finestra di dialogo Run Setup (Impostazione analisi)

1. Nella finestra Home (Home), eseguire una delle seguenti operazioni per aprire la finestra di
dialogo Run Setup (Impostazione analisi):

n Selezionare Run > User-defined Run (Analisi > Analisi definita dall’utente).

n Fare clic su User-defined Run Setup (Impostazione analisi definita dall’utente) sulla barra
degli strumenti.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) nella scheda Protocol (Protocollo)
e visualizza il file di protocollo predefinito.

2. Fare clic su Create New (Crea nuovo).

Si apre la finestra Protocol Editor (Editor protocollo), che visualizza il protocollo in tempo reale
predefinito.

Apertura di un protocollo esistente nell’editor protocollo
CFXManager Dx fornisce i file protocollo campione che è possibile modificare e salvare come nuovi
protocolli personalizzati. Si può creare un nuovo protocollo anche da un protocollo personalizzato
esistente.

Per aprire un file protocollo campione

1. Nella finestra Home (Home), selezionare File > Open > Protocol (File > Apri > Protocollo).

Per impostazione predefinita, Windows Explorer (Esplora risorse di Windows) si apre nella
posizione della cartella dei file Sample (Campione) di CFX Manager Dx.

2. Aprire la cartella dei file Sample (Campione). Sono presenti le seguenti cartelle:
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n ConventionalProtocols (Protocolli convenzionali): contiene file di protocolli di esempio
per la normale analisi PCR.

n DataFiles (File di dati): contiene file di dati di esempio che è possibile utilizzare per
esaminare le funzioni di CFX Manager Dx.

n MeltCalibration (Calibrazione di fusione): contiene file di protocolli di esempio da
utilizzare con il software Precision Melt Analysis di Bio-Rad.

n Plates (Piastre): contiene file piastra di esempio.

n RealTimeProtocols (Protocolli in tempo reale): contiene file di protocolli di esempio per
l’analisi PCR in tempo reale.

3. Aprire la cartella del protocollo per il tipo di analisi che si intende effettuare,
ConventionalProtocols (Protocolli convenzionali) o RealTimeProtocols (Protocolli in tempo reale).

4. Selezionare il protocollo che si è scelto e fare clic su Open (Apri).

Il file del protocollo campione viene aperto nella finestra Protocol Editor (Editor protocollo).

5. Selezionare File > Save As (File > Salva con nome) e salvare il protocollo con un nuovo nome o in
una nuova cartella.

Per aprire un protocollo esistente

1. Nella finestra Home (Home), eseguire una delle seguenti operazioni:

n Selezionare File > Open > Protocol (File > Apri > Protocollo), navigare fino al protocollo
target, selezionarlo e quindi fare clic su Open (Apri).

n Aprire la procedura guidata di avvio ed eseguire una delle operazioni seguenti:

o Per modificare il protocollo visualizzato, fare clic su Edit Selected (Modifica selezionato).

o Per modificare un altro protocollo esistente, fare clic su Select Existing (Seleziona
esistente) e navigare fino al file target.

Il protocollo viene aperto nella finestra Protocol Editor (Editor protocollo).

2. Selezionare File > Save As (File > Salva con nome) e salvare il protocollo con un nuovo nome o in
una nuova cartella.
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Impostazione di un nuovo protocollo
Suggerimento: Se il file del protocollo include i parametri richiesti (ad esempio, se si sta
modificando un file piastra esistente) è possibile saltare questa sezione. Passare al capitolo
Aggiunta di fasi ad un protocollo a pagina 96.

I nuovi file protocollo richiedono i seguenti parametri:

n Block type (Tipo di blocco)

n Scan mode (Modalità di scansione) per il tipo di blocco scelto

n Lid temperature (Temperatura coperchio)

n Sample Volume (Volume campione)

Impostazione del tipo di blocco

CFXManager Dx calcola automaticamente gli incrementi della temperatura per le fasi gradiente in
base al tipo di blocco.

Nota: Il tipo di piastra impostato nell’editor protocollo deve essere uguale alla piastra nel modulo
di reazione.

Per impostare il tipo di blocco

u Nella finestra Protocol Editor (Editor protocollo), selezionare Tools > Gradient Calculator
(Strumenti > Calcolatore gradiente) e scegliere il tipo di piastra adeguato nell’elenco a discesa
che appare.

Selezione della modalità di scansione per il tipo di blocco scelto

Per determinare il tempo di esecuzione del protocollo, selezionare il tipo di blocco target e la modalità
di scansione.

Per selezionare il tipo di blocco e la modalità di scansione

u Nella finestra Protocol Editor (Editor protocollo), selezionare Tools > Run time Calculator
(Strumenti > Calcolatore tempo di esecuzione) e scegliere il tipo di piastra e la modalità di
scansione adeguati nell’elenco a discesa che appare.

Regolazione della temperatura del coperchio

Il CFX Manager Dx imposta la temperatura predefinita del coperchio su 105,0 °C.

È possibile modificare le impostazioni predefinite o disattivare il riscaldatore del coperchio secondo
quanto necessario per il protocollo.
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Suggerimento: È possibile cambiare la temperatura predefinita del coperchio nella finestra di
dialogo User Preferences (Preferenze utente). Per ulteriori informazioni, vedere Impostazione dei
parametri predefiniti del protocollo a pagina 69.

Per regolare la temperatura del coperchio

1. Nella finestra Plate Editor (Editor piastra), selezionare Settings > Lid Settings (Impostazioni >
Impostazioni coperchio).

Appare la finestra di dialogo Lid Settings (Impostazioni coperchio).

2. Eseguire una delle seguenti operazioni:

n Selezionare User Defined (Definito dall’utente) e immettere un valore per la temperatura
nella casella di testo.

n Selezionare Turn Off Lid Heater (Spegni riscaldatore coperchio).

3. Fare clic su OK per accettare le modifiche e chiudere la finestra di dialogo.

Impostazione del volume campione

Per impostazione predefinita, CFX Manager Dx imposta il volume campione per ciascun pozzetto a
25 µl. Tuttavia, l’intervallo del Sistema CFX Dx è 0–125 µl.

Lo strumento utilizza una o due modalità di controllo temperatura per determinare quando il campione
raggiunge la temperatura target in un protocollo:

n Calculated mode (Modalità calcolata): quando il volume del campione è impostato ad un volume
appropriato per il blocco, lo strumento calcola la temperatura campione in base al volume del
campione. Questa è la modalità standard.

n Block mode (Modalità blocco): quando il volume del campione è impostato a zero (0) µl, lo
strumento registra la temperatura del campione come identica alla temperatura del blocco
misurata.

Per impostare il volume del campione per un blocco specifico

u Nella finestra Plate Editor (Editor piastra), digitare il valore corretto nella casella di testo Sample
Volume (Volume campione), sulla barra degli strumenti.

Suggerimento: Nella finestra di dialogo User Preferences (Preferenze utente) è possibile
modificare il volume predefinito del campione. Fare riferimento a Modifica delle impostazioni file
predefinite a pagina 67.
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Aggiunta di fasi ad un protocollo
Per aggiungere una fase ad un protocollo

1. Aprire il protocollo nella finestra Protocol Editor (Editor protocollo).

2. Stabilire dove inserire la nuova fase. Nella barra degli strumenti, selezionare Before (Prima) o
After (Dopo) nell’elenco a discesa Step (Fase).

3. Nel grafico, selezionare la fase prima o dopo la quale si intende inserire la nuova fase.

4. Nel riquadro di sinistra, fare clic su Insert Step (Inserisci fase).

5. Per cambiare la temperatura o il tempo di mantenimento, fare clic sul valore predefinito presente
sul grafico o sulla struttura del protocollo e digitare un nuovo valore.

6. (Facoltativo) Nel riquadro di sinistra, fare clic su Step Options (Opzioni fase) per visualizzare la
finestra di dialogo Step Options (Opzioni fase) e modificare le opzioni disponibili per la fase
selezionata.

Suggerimento: È possibile accedere alla finestra di dialogo Step Options (Opzioni fase) del
menu del pulsante destro del mouse nel riquadro del grafico o nel riquadro della struttura del
protocollo.

7. Fare clic su OK e poi su Yes (Sì) per salvare le modifiche apportate al protocollo.

Viene visualizzata la finestra di dialogo Save As (Salva con nome).

8. Nella finestra di dialogo Save As (Salva con nome), immettere un nome per il nuovo file del
protocollo e fare clic su Save (Salva).

Inserimento di una fase gradiente
Per inserire una fase gradiente

1. Verificare che la dimensione della piastra per il gradiente sia la stessa del tipo di blocco dello
strumento, a 96 pozzetti.

2. Se non è già stato fatto, selezionare la dimensione della piastra per il gradiente:

Selezionare Tools > Gradient Calculator (Strumenti > Calcolatore gradiente) e scegliere il tipo di
pozzetto appropriato dall’elenco a discesa.

3. Nella barra degli strumenti, selezionare Before (Prima) o After (Dopo) dall’elenco a discesa Insert
Step (Inserisci fase).

4. Nel grafico o nel riquadro della struttura, selezionare la fase prima o dopo la quale si prevede di
inserire la fase gradiente.
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5. Nel riquadro di sinistra, fare clic su Insert Gradient (Inserisci gradiente). La nuova fase gradiente
viene evidenziata nel grafico e nel riquadro della struttura, ad esempio:

La temperatura di ciascuna riga nel gradiente viene visualizzata nella tabella del gradiente nel
riquadro a destra.

6. Per modificare l’intervallo della temperatura gradiente, eseguire una delle seguenti operazioni:

n Fare clic sulla temperatura predefinita nel grafico o nel riquadro della struttura e inserire una
nuova temperatura.

n Fare clic su Step Options (Opzioni fase) per inserire l’intervallo di gradiente nella finestra
Step Options (Opzioni fase).

n Cambiare il valore Range (Intervallo) nella tabella del gradiente.

7. Per modificare il tempo di mantenimento, fare clic sul tempo predefinito nella vista a grafico o a
testo e inserire un nuovo tempo.

8. Fare clic su OK e quindi su Yes (Sì) per salvare le modifiche.
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Inserimento di una fase GOTO
Nota: Non è possibile inserire una fase GOTO in una serie GOTO; non è possibile creare loop
GOTO nidificati.

Per inserire una fase GOTO

1. Nella barra degli strumenti, selezionare Before (Prima) o After (Dopo) dall’elenco a discesa Insert
Step (Inserisci fase).

2. Nel grafico, selezionare la fase prima o dopo la quale si prevede di inserire la fase GOTO.

3. Nel riquadro di sinistra, fare clic su Insert GOTO (Inserisci GOTO).

4. Per modificare il numero di fase GOTO o il numero di ripetizioni GOTO, selezionare il numero
predefinito nel grafico o nel riquadro struttura e immettere un nuovo valore.

5. Fare clic su OK e quindi su Yes (Sì) per salvare le modifiche.

Inserimento di una fase di curva di fusione
Suggerimento: Non è possibile inserire una fase di curva di fusione all’interno di un loop GOTO.

Nota: La fase della curva di fusione include un tempo di mantenimento di 30 sec all’inizio della
fase che non è visualizzato nel protocollo.

Per inserire una fase di curva di fusione

1. Nella barra degli strumenti, selezionare Before (Prima) o After (Dopo) dall’elenco a discesa Insert
Step (Inserisci fase).

2. Nel grafico, selezionare la fase prima o dopo la quale si programma di inserire la fase di curva di
fusione.
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3. Nel riquadro di sinistra, fare clic su Insert Melt Curve (Inserisci curva di fusione). La nuova fase di
curva di fusione viene evidenziata nel grafico e nel riquadro della struttura, ad esempio:

4. Per modificare l’intervallo della temperatura di fusione o il tempo di incremento, selezionare il
numero predefinito nel grafico o nel riquadro struttura e inserire un nuovo valore.

5. Fare clic su OK e quindi su Yes (Sì) per salvare le modifiche.
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Aggiunta o rimozione di una fase di lettura piastra
Suggerimento: Dopo avere aggiunto un comando di lettura piastra ad una fase, il pulsante
diventa Remove Plate Read (Rimuovi lettura piastra) quando si seleziona la fase.

Per aggiungere una lettura piastra ad una fase

1. Nella barra degli strumenti, selezionare Before (Prima) o After (Dopo) dall’elenco a discesa Insert
Step (Inserisci fase).

2. Nel grafico, selezionare la fase prima o dopo la quale si prevede di inserire la fase di lettura
piastra.

3. Nel riquadro a sinistra, fare clic su Add Plate Read to Step (Aggiungi lettura piastra alla fase) per
aggiungere una lettura piastra alla fase selezionata.

4. Fare clic su OK e quindi su Yes (Sì) per salvare le modifiche.

Per rimuovere una lettura piastra da una fase

u Sul grafico, selezionare la fase che contiene la lettura piastra e fare clic su Remove Plate Read
(Rimuovi lettura piastra) nel riquadro a sinistra.

Modifica delle opzioni della fase
Per cambiare le opzioni della fase per la fase selezionata

1. Selezionare la fase target nel grafico o nel riquadro struttura.

2. Nel riquadro di sinistra, fare clic su Step Options (Opzioni fase) per aprire la finestra di dialogo
Step Options (Opzioni fase).

In alternativa, fare clic con il pulsante destro del mouse sulla fase target in uno dei riquadri e
selezionare Step Options (Opzioni fase) nel menu che appare.

3. Per aggiungere, modificare, o rimuovere le opzioni:

n Immettere un valore nella casella di testo appropriata.

n Modificare un valore nella casella di testo specifica.

n Selezionare o deselezionare una casella di controllo.

4. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo Step Options (Opzioni
fase).

5. Fare clic su OK e poi su Yes (Sì) per salvare il protocollo.

100 | Sistemi CFX96 Dx e CFX96 DeepWell Dx



Creazione di un protocollo nell’editor protocollo

Eliminazione di una fase
Per eliminare una fase del protocollo

1. Selezionare la fase nel grafico o nel riquadro struttura.

2. Nel riquadro di sinistra, fare clic su Delete Step (Elimina fase) per eliminare la fase selezionata.

3. Fare clic su OK e poi su Yes (Sì) per salvare il protocollo.

Copia, esportazione o stampa di un protocollo
Per copiare un protocollo

u Fare clic con il pulsante destro del mouse sulla struttura del protocollo e selezionare Copy
Protocol (Copia protocollo).

È possibile incollare la struttura in un file .txt, .xls, .doc o .ppt.

Per esportare un protocollo

1. Fare clic con il pulsante destro del mouse sulla struttura del protocollo e selezionare Export
Protocol (Esporta protocollo).

Viene visualizzata la finestra di dialogo Save As (Salva con nome).

2. (Facoltativo) In Windows Explorer, navigare fino alla cartella in cui salvare il file del protocollo.

3. Nel campo File name (Nome file), digitare un nome per il file del protocollo esportato.

4. Fare clic su Save (Salva).

Per stampare un protocollo

u Fare clic con il pulsante destro del mouse sulla struttura del protocollo e selezionare Print
(Stampa).

È possibile stampare la struttura del protocollo con la propria stampante predefinita.
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Creazione di un protocollo con l’autowriter protocollo
Importante: Bio-Rad non garantisce che l’esecuzione di un protocollo creato con l’autowriter
protocollo generi sempre un prodotto PCR in tempo reale.

L’autowriter protocollo di CFX Manager Dx genera automaticamente protocolli di ciclo in base ai
seguenti parametri di input:

n Amplicon length (Lunghezza amplicone): lunghezza del prodotto PCR

n Annealing temperature (Temperatura di annealing): reazione Ta per i primer utilizzati

Se il valore di Ta non è noto, si può usare il calcolatore Ta per calcolarlo automaticamente in base
alle sequenze del primer.

Nota: Il valore di Ta viene regolato secondo le informazioni relative alla temperatura di
fusione del primer (Tm) che sono basate sull’enzima scelto e sulla velocità di protocollo.

n Enzyme type (Tipo di enzima): l’enzima DNA polimerasi (DNA polimerasi iTaq™, iProof™ o
Altro)

Se si utilizza un enzima diverso dalla DNA polimerasi iTaq o iProof, è possibile immettere
informazioni aggiuntive, tra cui l’intervallo gradiente, il tempo di attivazione dell’avvio a caldo (in
sec) e il tempo di estensione finale (in sec).

n Run speed (Velocità analisi): velocità di reazione (standard, fast o ultrafast (standard, veloce o
ultraveloce)).

L’autowriter protocollo ottimizza il protocollo in base all’impostazione di velocità selezionata. Il
tempo totale di analisi viene determinato dal numero di fasi e cicli, dal tempo di incubazione in
ogni fase e dal tempo necessario per il raggiungimento dell’uniformità alla temperatura target.

Utilizzando i parametri immessi e le linee guida standard per la PCR, l’autowriter protocollo genera
automaticamente un protocollo PCR personalizzato con fasi di avvio a caldo, denaturazione iniziale,
annealing ed estensione. È inoltre possibile visualizzare una rappresentazione grafica del protocollo
suggerito e modificare, eseguire o salvare il protocollo.
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Per creare un nuovo protocollo utilizzando l’autowriter protocollo di CFX Manager Dx

1. Nella finestra Home (Home), selezionare Tools > Protocol AutoWriter (Strumenti > Autowriter
protocollo).

Appare la finestra di dialogo dell’autowriter protocollo.

2. Nella sezione Enter Target Values/Enzyme (Immettere valori target/enzima), eseguire quanto
segue:

n Immettere la temperatura di annealing (Ta) per i primer, se è nota.

Suggerimento: Per maggiori informazioni, vedere Utilizzo del calcolatore Ta a pagina
104.

Nota: Per maggiori informazioni sui calcoli utilizzati nel calcolatore Ta, vedere Breslauer
et al. 1986.

n Immettere la lunghezza amplicone in coppie di basi (bp).

n Selezionare un tipo di enzima dall’elenco di opzioni (polimerasi DNA iTaq™, polimerasi DNA
iProof™ o Other (Altro)).

Suggerimento: Se si seleziona Other (Altro) come tipo di enzima, si attivano i parametri
per la sezione Additional Parameters (Altri parametri) (opzionale).
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3. Se è stato selezionato Other come tipo di enzima, è possibile aggiungere i seguenti parametri al
protocollo:

n Gradient range (Intervallo gradiente)

n Hot start activation temperature (Temperatura di attivazione avvio a caldo)

n Final extension time (Tempo di estensione finale)

4. Nella sezione Type (Tipo), spostare la barra di scorrimento per selezionare la velocità di un
protocollo (Standard, Fast o Ultrafast (Standard, veloce o ultraveloce)). CFX Manager Dx regola il
tempo totale di analisi.

5. Selezionare il tipo di PCR da eseguire (PCR in tempo reale è l’analisi predefinita).

Con PCR in tempo reale, CFX Manager Dx aggiunge una fase di lettura piastra per raccogliere i
dati della fluorescenza.

6. Nella sezione di anteprima, rivedere il protocollo. È possibile apportare le modifiche necessarie.

7. Eseguire una delle seguenti operazioni:

n Fare clic su OK per salvare il nuovo protocollo. Dopo averlo salvato, il protocollo apre la
procedura guidata di avvio. Fare clic su Edit Selected (Modifica selezionato) per apportare
modifiche al protocollo. Ad esempio, potrebbe essere cambiare la temperatura del coperchio
e il volume del campione.

n Fare clic su Cancel (Annulla) per chiudere la finestra senza salvare il protocollo.

Utilizzo del calcolatore Ta
Quando la temperatura di annealing per il primer non è nota, è possibile utilizzare il calcolatore Ta per
calcolarne il valore. Per creare il protocollo è possibile utilizzare il valore nell’autowriter protocollo o
nell’editor protocollo.

Descrizione del calcolatore Ta
Il Calcolatore Ta calcola il valore Tm per ciascun primer, nonché il valore Ta per il protocollo alla
velocità standard.

Il valore Ta per il protocollo si basa sui valori medi Tm del primer con applicazione delle seguenti
regole:

n Se la differenza tra i valori Tm del primer è >4 °C, il valore Ta = (valore inferiore dei due valori Tm
del primer + 2) – 4 °C

n Se la differenza tra i valori Tm è ≤4 °C, il valore Ta = (media dei valori Tm del primer) – 4 °C
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Metodo di conteggio coppie base

Per ciascun primer, il Calcolatore Ta utilizza il metodo di conteggio coppie base per sequenze di 14
coppie base (bp) o meno.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

dove w, x, y e z sono rispettivamente i numeri delle basi A, T, G e C nella sequenza.

Metodo del vicino più vicino

Per le sequenze più lunghe di 14 bp, viene utilizzato il metodo del vicino più vicino. Nel metodo del
vicino più vicino, i calcoli della temperatura di fusione si basano sulla relazione termodinamica tra
entropia (ordine o misura dell’imprevedibilità dell’oligonucleotide), entalpia (calore rilasciato o
assorbito dall’oligonucleotide), energia libera e temperatura.

∆H = ∆G + T* ∆S

dove:

n ∆H = valore di entalpia, Cal/Mole*K

n T = temperatura, Kelvin

n ∆S = valore di entropia, Cal/Mole*K

n ∆G = energia libera di Gibbs in Cal/Mole*K

La variazione di entropia ed entalpia viene calcolata direttamente sommando i valori per le coppie di
nucleotidi mostrate nella Tabella 12 (Breslauer et al. 1986).

La relazione tra l’energia libera e la concentrazione delle sostanze di reattanza e i prodotti in equilibrio
viene calcolata come segue:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

dove R è la costante gas (1,986 Cal/Mole*K).

Dalla sostituzione di G nelle due equazioni e dalla risoluzione per T si ottiene:

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

presupponendo che la concentrazione di DNA e il complesso DNA-primer siano uguali.

È stato determinato empiricamente che si verifica una variazione di energia libera di 5 kcal (3,4 kcal)
(Sugimoto et al. 1996) durante la transizione dal DNA a singola elica al DNA a forma B. Si tratta
presumibilmente dell’energia di avvio a spirale. Infine, l’aggiunta di una regolazione per il sale fornisce
un’equazione che il calcolatore Ta utilizza:

T = (∆H – 5(KCal/K*Mole))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (molarità del sale)
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Non è necessaria alcuna costante di regolazione per la concentrazione salina, dal momento che i vari
parametri sono stati determinati a 1 M NaCl e il log10 di 1 è zero.

I calcoli termodinamici presumono che l’annealing si verifichi a pH 7,0. I calcoli Tm presumono che le
sequenze non siano simmetriche e contengano almeno un G o C.

La sequenza di oligonucleotide deve essere lunga almeno 14 basi per fornire valori Tm ragionevoli.
Con meno di 14 basi si utilizza il metodo di conteggio coppie base (fare riferimento alla Tabella 12
riportata di seguito).

Interazione ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabella 12. Costanti di interazione Breslauer
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Utilizzo del calcolatore Ta

Come utilizzare il calcolatore Ta

1. Per aprire il calcolatore Ta, eseguire una delle seguenti operazioni:

n Se ci si trova nell’autowriter protocollo, fare clic su Ta Calculator (Calcolatore Ta).

n Nella finestra Home (Home), selezionare Tools > Ta Calculator (Strumenti > Calcolatore Ta).

Viene visualizzata la finestra di dialogo Ta Calculator (Calcolatore Ta).

2. Nella casella di testo Forward Primer (Primer diretto), digitare o incollare la sequenza del primer
diretto.

Suggerimento: È possibile anche utilizzare i pulsanti A, T, G, C sul lato sinistro della finestra
di dialogo per inserire la sequenza.

3. Nella casella di testo Reverse Primer (Primer inverso) digitare o incollare la sequenza del primer
inverso.

4. Fare clic su Calculate (Calcola).

Il calcolatore Ta calcola e visualizza il valore Tm di ciascun primer e i valori medi di Tm e Ta; ad
esempio:
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Se i valori Tm del primer sono più di 4 °C l’uno dall’altro, l’autowriter protocollo utilizza il valore Tm
del primer più basso +2 °C come base per calcolare il valore Ta, che è possibile modificare
ulteriormente cambiando enzima e velocità di reazione.

Il calcolatore Ta genera una temperatura di annealing per velocità standard con iTaq DNA
polimerasi. Quando si utilizza un enzima differente, le impostazioni di velocità regolano
automaticamente il Ta.

5. Eseguire una delle seguenti operazioni:

n Se il calcolatore Ta è stato aperto dall’autowriter protocollo, fare clic su OK. Si ritorna
all’autowriter protocollo. La temperatura di annealing viene automaticamente modificata.

n Se il calcolatore Ta è stato aperto dal menu Tools (Strumenti), registrare il calcolo e fare clic
su Cancel (Annulla) per chiudere il calcolatore.
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Un file piastra contiene informazioni sui parametri di analisi, come la modalità di scansione, i fluorofori
e il contenuto del pozzetto. Dopo l’analisi, il software CFX Manager™ Dx collega il contenuto del
pozzetto ai dati di fluorescenza raccolti durante l’analisi e applica l’analisi appropriata nella finestra
Data Analysis (Analisi dei dati). Ad esempio, i pozzetti caricati con il tipo di campione standard
vengono usati per generare una curva standard.

Il Software CFX Manager Dx fornisce due opzioni per creare le piastre: l’editor piastra per le analisi
PCR in tempo reale e la procedura di impostazione guidata per l’analisi dell’espressione genica
normalizzata.

L’editor piastra include le seguenti funzioni:

n Fluorofori standard e tipi di campione da assegnare ai pozzetti della piastra

n Capacità di impostare il target di riferimento e il campione di controllo per l’analisi dell’espressione
genica

n Capacità di modificare l’impostazione piastra prima, durante o dopo un’analisi

n Capacità di salvare i file piastra per il riutilizzo

n Capacità di stampare il file piastra con una stampante predefinita

La procedura di impostazione guidata aiuta a creare una disposizione della piastra per l’analisi
dell’espressione genica normalizzata. È possibile usare la procedura di impostazione guidata prima,
durante o dopo un’analisi.
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Finestra Plate Editor (Editor piastra)
L’editor piastra viene utilizzato per creare piastre personalizzate o modificare piastre esistenti.

1. La barra dei menu fornisce rapido accesso ai comandi del menu File (File) e Settings
(Impostazioni), nonché alle opzioni degli strumenti di modifica.

2. La barra degli strumenti fornisce rapido accesso alle importanti funzioni di caricamento
piastra.

3. Il riquadro principale visualizza la struttura della piastra e le opzioni piastra quando vengono
applicate.

4. Il riquadro a destra visualizza le opzioni che vengono utilizzate per personalizzare la
piastra.

5. Il riquadro inferiore visualizza il tipo di piastra e fornisce rapido accesso alle opzioni di
visualizzazione.

LEGENDA
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Comandi del menu File (File)
Save (Salva): salva il file di dati della piastra nella posizione specificata, nella scheda File (File) della
finestra di dialogo User Preferences (Preferenze utente). Per ulteriori informazioni fare riferimento a
Modifica delle impostazioni file predefinite a pagina 67. Questo elemento di menu è disponibile solo
quando si crea un nuovo file piastra.

Save As (Salva con nome): salva il file di dati piastra aperto con un nuovo nome fornito. Questo
elemento di menu è disponibile solo quando si crea un nuovo file piastra.

Extract Plate (Estrai piastra): apre una finestra di dialogo in cui è possibile estrarre/salvare il file
piastra (.pltd). Questo elemento di menu è disponibile solo quando si visualizza o si modifica un file
piastra esistente.

Print (Stampa): stampa il file di dati piastra aperto.

Close (Chiudi): chiude l’editor piastra.

Comandi del menu Settings (Impostazioni)
Plate Size (Dimensione piastra): fornisce le opzioni da cui è possibile selezionare la dimensione
piastra per l’analisi.

Nota: Il Sistema CFX Dx può utilizzare solo una piastra con 96 pozzetti.

Plate Type (Tipo di piastra): permette di scegliere il tipo di pozzetti della piastra che contiene i
campioni, BRWhite o BR Clear. Per ottenere un’analisi dei dati accurata, il tipo di piastra selezionato
deve essere uguale al tipo di piastra utilizzato nell’analisi.

Number Convention (Convenzione numerica): permette di selezionare o deselezionare l’opzione
per visualizzare le unità con notazione scientifica. Per impostazione predefinita vengono visualizzate
le unità con notazione scientifica.

Units (Unità): permette di scegliere le unità da mostrare nel foglio di calcolo quando si esegue la
quantificazione di sconosciuti rispetto a una curva standard.

Modifica dei comandi del menu Tools (Strumenti)
Setup Wizard (Procedura di impostazione guidata): apre la procedura di impostazione guidata, in
cui è possibile definire la disposizione e i parametri di analisi per la piastra attuale. È possibile usare la
procedura di impostazione guidata prima, durante o dopo aver completato un’analisi.

Spreadsheet View/Importer (Vista foglio di calcolo/Programma importazione): apre la finestra di
dialogo View (Visualizza), che visualizza la disposizione della piastra come modello in formato foglio
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di calcolo. È possibile usare questa finestra di dialogo per esportare o importare i dati del modello
piastra in formato .csv.

Flip Plate (Inclina piastra): inclina il contenuto della piastra di 180o.

Comandi della barra degli strumenti

Salva il file piastra attuale.

Visualizza un elenco a discesa da cui è possibile aumentare o diminuire
l’ingrandimento della vista piastra.

Visualizza un elenco a discesa da cui è possibile selezionare una modalità
di scansione, che indica allo strumento da quali canali raccogliere i dati di
fluorescenza durante un’analisi.

Apre il Well Groups Manager (Gestore gruppi di pozzetti), che è possibile
usare per creare dei gruppi di pozzetti per la piastra attuale.

Visualizza una finestra di dialogo in cui è possibile scegliere i colori e i
simboli per le tracce di amplificazione.

Apre la finestra di dialogo View (Visualizza), che visualizza la dispo-
sizione della piastra come modello in formato foglio di calcolo. È pos-
sibile usare questa finestra di dialogo per esportare o importare i dati
del modello piastra in formato .csv.

Visualizza le fasi necessarie per l’impostazione di una piastra e il cari-
camento dei pozzetti.
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Creazione di un file piastra usando l’editor piastra
Usando l’editor piastra, è possibile creare dei file piastra personalizzati. Inoltre, è possibile modificare
e salvare i file piastra precedentemente salvati o i file piastra campione spediti con il Software CFX
Manager Dx.

Per creare un nuovo file piastra, procedere come segue:

n Aprire un file piastra nell’editor piastra.

n Selezionare il tipo di piastra.

Nota: Il tipo di piastra per il file piastra deve essere uguale alla piastra nel modulo di
reazione.

n Selezionare la modalità di scansione da usare nel protocollo.

n Selezionare i fluorofori da usare nella piastra.

n Selezionare i tipi di campione, i target e i campioni.

n Selezionare i replicati , se opportuno.

n Salvare la disposizione della piastra.

Suggerimento: Per creare una nuova piastra dai file piastra campione o precedentemente
salvati, fare riferimento ad Apertura di un file piastra esistente nell’editor piastra a pagina 115.

Apertura di un nuovo file piastra nell’editor piastra
Il Software CFX Manager Dx offre più opzioni per aprire un nuovo file piastra:

n Dalla finestra Home (Home)

n Dalla finestra di dialogo Startup Wizard (Procedura guidata di avvio)

n Dalla finestra di dialogo Run Setup (Impostazione analisi)

Per aprire un nuovo file piastra dalla finestra Home (Home)

u Selezionare File > New > Plate (File > Nuovo > Piastra).

Si apre la finestra Plate Editor (Editor piastra), che visualizza il file piastra predefinito per lo
strumento selezionato.

Suggerimento: Per le informazioni sull’impostazione del file piastra predefinito, vedere
Modifica delle impostazioni file predefinite a pagina 67.
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Per aprire un nuovo file piastra dalla procedura guidata di avvio

1. Nella finestra Home (Home), eseguire una delle seguenti operazioni per aprire la procedura
guidata di avvio se non è già visualizzata:

n Selezionare View > Startup Wizard (Visualizza > Procedura guidata di avvio).

n Fare clic su Startup Wizard (Procedura guidata di avvio) sulla barra degli strumenti.

Per impostazione predefinita, la procedura guidata di avvio visualizza la scheda Run Setup
(Impostazione analisi) con lo strumento CFX96™ selezionato.

2. Se necessario, selezionare il tipo di strumento dall’elenco a discesa.

3. Per creare una nuova piastra, fare clic su User-defined (Definito dall’utente) come tipo di analisi.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) che visualizza la scheda Protocol
(Protocollo).

4. Fare clic sulla scheda Plate (Piastra) e fare clic su Create New (Crea nuovo).

Si apre la finestra Plate Editor (Editor piastra), che visualizza la disposizione predefinita della
piastra per lo strumento selezionato.

Per aprire un nuovo file piastra dalla finestra di dialogo Run Setup (Impostazione analisi)

1. Nella finestra Home (Home), eseguire una delle seguenti operazioni per aprire la finestra di
dialogo Run Setup (Impostazione analisi):

n Selezionare Run > User-defined Run (Analisi > Analisi definita dall’utente).

n Fare clic su User-defined Run Setup (Impostazione analisi definita dall’utente) sulla barra
degli strumenti.

Si apre la finestra di dialogo Run Setup (Impostazione analisi) nella scheda Protocol (Protocollo).

2. Per creare una nuova piastra, fare clic sulla scheda Plate (Piastra) e fare clic su Create New
(Crea nuovo).

Si apre la finestra Plate Editor (Editor piastra), che visualizza la disposizione predefinita della
piastra per lo strumento selezionato.
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Apertura di un file piastra esistente nell’editor piastra
Il Software CFX Manager Dx fornisce i file piastra campione che è possibile modificare e salvare come
nuove piastre. Si può anche creare un nuovo file piastra dal file piastra precedentemente salvato.

Per aprire un file piastra campione

1. Nella finestra Home (Home) selezionare File > Open > Plate (File > Apri > Piastra).

Windows Explorer si apre nella posizione della cartella dei file Sample (Campione) di CFX
Manager Dx.

2. Aprire la cartella dei file Sample (Campione) e quindi aprire la cartella Plates (Piastra).

3. Selezionare la piastra idonea e fare clic su Open (Apri).

Il file piastra campione si apre nella finestra Plate Editor (Editor piastra).

4. Selezionare File > Save As (File > Salva con nome) e salvare il file piastra con un nuovo nome o
in una nuova cartella.

Per aprire un file piastra precedentemente salvato

1. Nella finestra Home (Home), Selezionare File > Open > Plate (File > Apri > Piastra), selezionare
la piastra target e quindi fare clic su Open (Apri).

Il file della piastra target viene aperto nella finestra Plate Editor (Editor piastra).

2. Selezionare File > Save As (File > Salva con nome) e salvare il file piastra con un nuovo nome o
in una nuova cartella.
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Impostazione di un nuovo file piastra
Suggerimento: Se il file piastra include i parametri richiesti (ad esempio, se si sta modificando un
campione o un file piastra esistente), si può tralasciare questo paragrafo. Procedere a
Assegnazione di parametri opzionali al file piastra a pagina 123.

Per i nuovi file piastra sono richiesti i seguenti parametri:

n Plate size (Dimensione piastra)

n Plate type (Tipo di piastra)

n Scan mode (Modalità di scansione)

n Un fluoroforo (colorante)

n Un tipo campione

Selezione della dimensione e del tipo di piastra

Importante: Selezionare la dimensione della piastra durante l’impostazione piastra. Non è
possibile modificare la dimensione della piastra durante o dopo l’analisi.

Il software applica la dimensione e il tipo di piastra a tutti i pozzetti durante l’analisi. Assicurarsi che la
dimensione piastra selezionata sia uguale a quella della piastra che si utilizzerà nell’analisi.

Gli strumenti CFX96 e CFX96 DeepWell di Bio-Rad sono calibrati in fabbrica per numerose
combinazioni di piastre e coloranti fluorescenti. La calibrazione è specifica per il tipo di strumento,
colorante e piastra. Assicurarsi che il fluoroforo che si intende utilizzare sia calibrato per il tipo di
piastra selezionato.

Selezione della modalità di scansione

I sistemi CFX96 e CFX96 DeepWell eccitano e rilevano i fluorofori in cinque canali. Tutti i sistemi
utilizzano modalità di scansione multiple per l’acquisizione dei dati, al fine di raccogliere i dati sulla
fluorescenza durante un’analisi.

Il Software CFX Manager Dx fornisce tre modalità di scansione:

n All Channels (Tutti i canali)

o Scansione dei canali da 1 a 5 per i sistemi CFX96 e CFX96 DeepWell

n SYBR® /FAM

o Scansione solo del canale 1

o Fornisce una scansione rapida
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n FRET

o Scansione solo del canale FRET

o Fornisce una scansione rapida

Selezione dei fluorofori

Importante: Prima di iniziare l’analisi, il Software CFX Manager Dx verifica che i fluorofori che
l’utente ha specificato nella piastra siano calibrati su quello strumento. Non è possibile analizzare
una piastra se include fluorofori che non sono stati calibrati su tale strumento.

È necessario caricare almeno un fluoroforo per la disposizione piastra prima dell’analisi. In questo
momento è possibile aggiungere una gran quantità di fluorofori (tanti quanti ne occorrono), ma la
piastra deve contenere almeno un fluoroforo. I fluorofori selezionati sono visualizzati come opzioni per
i target nel campo Target Names (Nomi target).

Utilizzare la finestra di dialogo Select Fluorophores (Seleziona fluorofori) per caricare i fluorofori (o i
coloranti piastra) nei controlli di carico pozzetto dell’editor piastra. I fluorofori visualizzati nella finestra
di dialogo Select Fluorophores (Seleziona fluorofori) dipendono dalla modalità di scansione che è
stata selezionata:

n All Channels (Tutti i canali)

Sono visualizzati tutti i fluorofori disponibili.

Suggerimento: È possibile aggiungere la quantità necessaria di fluorofori (tanti quanti ne
occorrono), tuttavia si può caricare solo un fluoroforo per canale in ciascun pozzetto.

n SYBR®/FAM

Sono visualizzati solo i fluorofori del canale 1.

n FRET

Viene visualizzato solo il fluoroforo del canale 6.

Suggerimento: Il fluoroforo FRET del canale 6 appare solo quando viene selezionato FRET
come modalità di scansione. Non è disponibile per la modalità di scansione All Channels
(Tutti i canali).

Nota: Non è possibile aggiungere direttamente i fluorofori alla finestra di dialogo Select
Fluorophore (Seleziona fluoroforo) o rimuoverli. È necessario calibrare i nuovi fluorofori in uno
strumento utilizzando la procedura guidata di calibrazione. Al termine della calibrazione, il nuovo
fluoroforo viene aggiunto automaticamente a questo elenco.
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Selezione dei tipi di campione

Importante: È necessario selezionare almeno un tipo di campione da assegnare ai pozzetti della
piastra prima di eseguire l’analisi.

Il Software CFX Manager Dx offre cinque tipi di campione:

n Unknown (Sconosciuto)

n Standard (Standard)

n NTC (nessun controllo modello)

n Positive Control (Controllo positivo)

n Negative Control (Controllo negativo)

n NRT (nessuna trascrittasi inversa)

Assegnare i tipi di campione ai pozzetti della piastra.

Impostazione di una nuova piastra

Per impostare una nuova piastra

1. Aprire una nuova piastra nella finestra Plate Editor (Editor piastra).

2. Per impostare la dimensione della piastra, selezionare Settings > Plate Size (Impostazioni >
Dimensione piastra) e selezionare la dimensione appropriata della piastra dal menu a discesa.

3. Per impostare il tipo di piastra, selezionare Settings > Plate Type (Impostazioni > Tipo di piastra)
e selezionare BRWhite (BR bianco) o BR Clear (BR trasparente) dal menu a discesa.

4. Facoltativamente, dal menu delle impostazioni è possibile cambiare la convenzione numerica e le
unità di visualizzazione:

n Per cambiare la convenzione numerica, selezionare Settings > Number Convention
(Impostazioni > Convenzione numerica) e quindi selezionare Scientific Notation (Notazione
scientifica).

Suggerimento: Per impostazione predefinita, viene selezionata la notazione scientifica.
In questo caso, selezionando la notazione scientifica si annulla l’impostazione
predefinita e si imposta la convenzione numerica sul formato standard.

n Per cambiare le unità di visualizzazione, selezionare Settings > Units (Impostazioni > Unità)
e selezionare un nuovo valore in unità.
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5. Per impostare la modalità di analisi, selezionare la modalità corretta dall’elenco a discesa Scan
Mode (Modalità di scansione) nella barra degli strumenti della finestra Plate Editor (Editor
piastra).

6. Selezionare i fluorofori necessari per la piastra:

a. Nel riquadro di destra fare clic su Select Fluorophores (Seleziona fluorofori).

Viene visualizzata la finestra di dialogo Select Fluorophores (Seleziona fluorofori). Appaiono
i fluorofori disponibili per il tipo di modalità di analisi selezionato nella Fase 5, ad esempio:

b. Per selezionare un fluoroforo, fare clic sulla rispettiva casella di controllo Selected
(Selezionato).

Suggerimento: Per rimuovere un fluoroforo dall’elenco, deselezionare la sua casella di
controllo Selected (selezionato).

c. Per cambiare il colore di visualizzazione del fluoroforo, fare clic sulla casella Color (Colore).

Nota: Il colore selezionato rappresenta il fluoroforo nella finestra Plate Editor (Editor
piastra) e nei grafici di analisi dei dati.

d. Nella finestra di dialogo Color (Colore), selezionare il colore desiderato oppure fare clic su
Define Custom Colors (Definisci colori personalizzati) e creare un nuovo colore che
rappresenti il fluoroforo.
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e. Fare clic su OK per salvare le modifiche e uscire dalla finestra di dialogo Select Fluorophores
(Seleziona fluorofori).

7. Occorre selezionare almeno un pozzetto in cui caricare un tipo di campione. Per impostazione
predefinita, viene selezionato il pozzetto A1.

Nel riquadro della piastra, eseguire una delle seguenti operazioni:

n Per caricare più pozzetti vicini, fare clic su un pozzetto e trascinare il cursore fino al pozzetto
target.

n Per caricare più pozzetti non vicini, tenere premuto il tasto Control (Ctrl) e fare clic su ciascun
pozzetto.

n Per caricare una colonna intera con lo stesso tipo di campione, fare clic sul numero della
colonna.

n Per caricare una riga intera, fare clic sul rispettivo numero di riga.

n Per caricare l’intera piastra, fare clic in alto a sinistra della piastra.

Ad esempio:

8. Assegnare un tipo di campione al pozzetto o ai pozzetti selezionati dal menu a discesa Sample
Type (Tipo campione).
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9. Assegnare almeno un fluoroforo a tutti i pozzetti che contengono il tipo di campione. È possibile
assegnare più di un fluoroforo al pozzetto o al gruppo di pozzetti.

Nota: È possibile assegnare solo un fluoroforo per canale. Non è possibile assegnare più di
un fluoroforo dello stesso canale allo stesso pozzetto.

Suggerimento: In questo momento, si può associare un target al fluoroforo oppure si può
assegnare solo il fluoroforo al pozzetto e associare un target al fluoroforo dopo l’esecuzione
dell’esperimento.

n Per assegnare solo un fluoroforo ai pozzetti selezionati, nella sezione Target Names (Nomi
target) presente nel riquadro di destra selezionare la casella di controllo Load (Carica) per lo
specifico fluoroforo.

n Per associare un target ad un fluoroforo, nella sezione Target Names (Nomi target)
selezionare un nome target dall’elenco a discesa per lo specifico fluoroforo. Il software
seleziona automaticamente la casella di controllo Load (Carica) corrispondente.

10. Per i pozzetti contenenti un tipo di campione Standard, occorre caricare una concentrazione.
Ciascun pozzetto può avere un valore differente per la concentrazione. Per impostazione
predefinita, il Software CFX Manager Dx carica la concentrazione 1.00E+06 per tutti i pozzetti con
il tipo di campione Standard. Se necessario, è possibile modificare il valore.

a. Nel riquadro della piastra, selezionare un pozzetto o gruppo di pozzetti Standard:

b. Nella sezione Concentration (Concentrazione), fare clic su Load (carica) per caricare il valore
nel pozzetto o nei pozzetti selezionati.

c. (Facoltativo) Per caricare un’altra concentrazione, digitare il nuovo valore nella casella di
testo Concentration (Concentrazione) e premere invio.
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d. Eseguire questo passo per tutti i pozzetti per cui è stato impostato il tipo di campione
Standard.

Suggerimento: Per caricare la stessa concentrazione per tutti i pozzetti Standard,
assicurarsi che sia visualizzata la dicitura <All> (Tutti) nell’elenco a discesa sotto il
valore della concentrazione. Per caricare lo stesso valore di concentrazione per tutti i
pozzetti con un determinato fluoroforo, fare clic sull’elenco a discesa e selezionare il
fluoroforo.

11. Fare clic su OK per salvare la nuova piastra.
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Assegnazione di parametri opzionali al file piastra
Un file piastra contiene le informazioni sul contenuto di ciascun pozzetto caricato con il campione per
un’analisi. Dopo l’analisi, il Software CFX Manager Dx collega il contenuto del pozzetto ai dati di
fluorescenza raccolti durante il protocollo e applica l’analisi appropriata nella finestra Data Analysis
(Analisi dei dati).

In CFX Manager Dx, è possibile assegnare i parametri a ciascun pozzetto nella piastra prima, durante
o persino dopo l’esecuzione degli esperimenti. È possibile assegnare i parametri ad un file piastra
esistente o ad un file piastra nuovo. Questi parametri includono:

n Target names (Nomi target): il target o i target di interesse (geni o sequenze) in ciascun
pozzetto caricato.

n Sample names (Nomi campione): l’identificatore o la condizione che corrisponde al campione
in ciascun pozzetto caricato, come 0Hr, 1Hr o 2Hr.

Suggerimento: I target e i nomi campione devono essere gli stessi tra i pozzetti per
confrontare i dati nella scheda Gene Expression (Espressione genica) della finestra Data
Analysis (Analisi dei dati). Ciascun nome deve contenere le stesse caratteristiche di
maiuscole/minuscole, punteggiatura e spaziatura. Ad esempio, “Actin” non è uguale ad
“actin”, “2Hr” non è uguale a “2 hr.” e “Mouse 1” non è uguale a “mouse1”. Per garantire
coerenza nei nomi, inserire i nomi nella sezione Libraries (Librerie) in User > User
Preferences > Plate (Utente > Preferenze utente > Piastra), disponibile nella finestra Home
(Home).

n Biological sets (Set biologici): l’identificatore o la condizione che corrisponde ad un set di
pozzetti.

n Replicates (Replicati): ogni pozzetto che viene usato per analizzare la stessa combinazione di
campione e target, ovvero le reazioni qPCR replicate.

n Dilution series (Serie di diluizione): la quantità con cui cambiare la concentrazione del tipo di
campione Standard all’interno di un gruppo di replicati per creare dati di curve standard per
l’analisi.

Assegnazione di target ai pozzetti
Suggerimento: È possibile assegnare lo stesso nome target ad un solo pozzetto o a più pozzetti.
Inoltre, è possibile assegnare più target allo stesso pozzetto.

Per assegnare un target ad un pozzetto o ad un gruppo di pozzetti

1. Nell’editor piastra, verificare che al pozzetto o al gruppo di pozzetti sia stato assegnato un tipo di
campione.
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Per ulteriori informazioni sull’assegnazione dei tipi di campione ai pozzetti vedere Selezione dei
tipi di campione a pagina 118.

2. Nel riquadro della piastra, selezionare il pozzetto o il gruppo di pozzetti:

n Per selezionare un solo pozzetto, fare clic sul pozzetto.

n Per selezionare più pozzetti vicini, fare clic su un pozzetto e trascinare fino al pozzetto target.

n Per selezionare più pozzetti non vicini, tenere premuto il tasto Control (Ctrl) e fare clic su
ciascun pozzetto.

n Per selezionare una colonna intera con lo stesso tipo di campione, fare clic sul numero della
colonna.

n Per selezionare una riga intera, fare clic sul rispettivo numero di riga.

3. Nel riquadro a destra, selezionare un nome dall’elenco a discesa Target Name (Nome target) per
ciascun fluoroforo selezionato.

4. Ripetere la Fase 3 per ciascun pozzetto o gruppo di pozzetti a cui è necessario assegnare un
target.

Suggerimento: È possibile assegnare lo stesso nome target o un nome target diverso per
ciascun fluoroforo selezionato.

5. Fare clic su OK per accettare le modifiche e salvare la piastra.

Per rimuovere un nome target

u Per rimuovere un nome target dal pozzetto o dal gruppo di pozzetti selezionato, deselezionare la
casella di controllo Load (Carica) corrispondente.

Importante: La rimozione di un nome target da un pozzetto rimuove anche il fluoroforo associato.
Prestare attenzione durante la rimozione di un nome target da un pozzetto.

Per aggiungere un nome target all’elenco

u Per aggiungere un nome target all’elenco a discesa, eseguire una delle seguenti operazioni:

n Digitare un nome nell’elenco a discesa Target Name (Nome target) e premere Enter (Invio).
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Suggerimento: I nomi target che vengono aggiunti ad un elenco sono visualizzati in tutti
gli altri elenchi target.

n Fare clic sul simbolo + verde a destra dell’elenco a discesa, digitare un nome per il target e
premere Enter (Invio).

n Fare clic su User Preferences (Preferenze utente) nella barra degli strumenti e aggiungere il
nome alla libreria Target Names (Nomi target) nella scheda Plate (Piastra).

Importante: I nomi target che vengono aggiunti nell’elenco a discesa sono disponibili solo
per la piastra attuale e solo se si assegna il nome ad un pozzetto e si salva la disposizione
della piastra. Se non si assegna il nome ad un pozzetto e non si salva la disposizione della
piastra, il nome non viene salvato e non sarà disponibile per utilizzi futuri. Per aggiungere un
nome target in modo permanente, aggiungerlo anche alla libreria Target Names (Nomi
target) usando la finestra di dialogo User Preferences (Preferenze utente). I nomi che
vengono aggiunti alla libreria sono disponibili solo dopo aver riaperto l’editor piastra. Per
ulteriori informazioni vedere Impostazione dei parametri predefiniti della piastra a pagina 70.

Per eliminare un nome target dall’elenco

1. Fare clic su User Preferences (Preferenze utente) sulla barra degli strumenti.

Si apre la finestra di dialogo User Preferences (Preferenze utente) visualizzando la scheda Plate
(Piastra).

2. Nella libreria Target Names (Nomi target) della scheda Plate (Piastra), selezionare il nome da
eliminare e premere il tasto Delete (Elimina).

3. Fare clic su OK per salvare le modifiche e uscire dalla finestra di dialogo User Preferences
(Preferenze utente).

Importante: Non è possibile eliminare i nomi target che sono stati salvati con un file piastra. I
nomi personalizzati che vengono aggiunti all’elenco a discesa Target Names (Nomi target), e
non vengono utilizzati e salvati con la piastra, vengono automaticamente rimossi dall’elenco.
I nomi che vengono eliminati dalla libreria Target Names (Nomi target) vengono rimossi in
modo permanente dal software e non sono più disponibili per gli utenti. Procedere con
cautela quando si eliminano i nomi target.

Assegnazione di un nome campione ai pozzetti
Nota: Per assegnare un nome campione, è necessario assegnare almeno un fluoroforo ai
pozzetti selezionati. Se ai pozzetti selezionati non viene assegnato alcun fluoroforo, l’elenco a
discesa Sample Names (Nomi campione) è disabilitato. Per ulteriori informazioni
sull’assegnazione di fluorofori vedere Assegnazione di target ai pozzetti a pagina 123.
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Suggerimento: È possibile assegnare un solo nome campione a ciascun pozzetto o gruppo di
pozzetti.

Per assegnare un nome campione ad un pozzetto o gruppo di pozzetti

1. Nell’editor piastra, verificare che al pozzetto o al gruppo di pozzetti sia stato assegnato un
fluoroforo.

2. Nel riquadro della piastra, selezionare il pozzetto o il gruppo di pozzetti.

3. Nel riquadro a destra, selezionare un nome nell’elenco a discesa Sample Names (Nomi
campione).

4. Ripetere la Fase 3 per ciascun pozzetto o gruppo di pozzetti a cui è necessario assegnare un
nome campione.

5. Fare clic su OK per accettare le modifiche e salvare la piastra.

Per rimuovere un nome campione

u Per rimuovere un nome campione da un pozzetto o da un gruppo di pozzetti selezionato,
deselezionare la casella di controllo Load (Carica).

Per aggiungere un nome campione all’elenco

u Per aggiungere un nome campione all’elenco a discesa, eseguire una delle seguenti operazioni:

n Digitare un nome nell’elenco a discesa Sample Names (Nomi campione) e premere Enter
(Invio).

n Fare clic sul simbolo + verde a destra dell’elenco a discesa e digitare un nome per il
campione.

n Fare clic su User Preferences (Preferenze utente) nella barra degli strumenti e aggiungere il
nome alla libreria Sample Names (Nomi campione) nella scheda Plate (Piastra).

Importante: I nomi campione che vengono aggiunti nell’elenco a discesa sono disponibili
solo per la piastra attuale e solo se si assegna il nome ad un pozzetto e si salva la
disposizione della piastra. Se non si assegna il nome ad un pozzetto e non si salva la
disposizione della piastra, il nome non viene salvato e non sarà disponibile per utilizzi futuri.
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Per aggiungere un nome campione in modo permanente, aggiungerlo anche alla libreria
Sample Names (Nomi campione) usando la finestra di dialogo User Preferences (Preferenze
utente). I nomi che vengono aggiunti alla libreria sono disponibili solo dopo aver riaperto
l’editor piastra. Per ulteriori informazioni vedere Impostazione dei parametri predefiniti della
piastra a pagina 70.

Per eliminare un nome campione dall’elenco

1. Fare clic su User Preferences (Preferenze utente) sulla barra degli strumenti.

Si apre la finestra di dialogo User Preferences (Preferenze utente) visualizzando la scheda Plate
(Piastra).

2. Nella libreria Sample Names (Nomi campione) della scheda Plate (Piastra), selezionare il nome
da eliminare e premere il pulsante Delete (Elimina).

3. Fare clic su OK per salvare le modifiche e uscire dalla finestra di dialogo User Preferences
(Preferenze utente).

Importante: Non è possibile eliminare i nomi campione che sono stati salvati con un file
piastra. I nomi personalizzati che vengono aggiunti all’elenco Sample Names (Nomi
campione) e non vengono utilizzati e salvati con la piastra, vengono automaticamente
rimossi dall’elenco a discesa. I nomi che vengono eliminati dalla libreria Sample Names
(Nomi campione) vengono rimossi dal software e non sono più disponibili per gli utenti.
Procedere con cautela quando si eliminano i nomi campione.

Assegnazione di set biologici ai pozzetti
Nota: Per assegnare un set biologico ai pozzetti selezionati, è necessario assegnare almeno un
fluoroforo. L’assegnazione di un fluoroforo abilita l’elenco a discesa Biological Set Name (Nome
set biologico). Per ulteriori informazioni sull’assegnazione di fluorofori, vedere Assegnazione di
target ai pozzetti a pagina 123.

Suggerimento: È possibile assegnare un set biologico a ciascun pozzetto o gruppo di pozzetti.

Per assegnare un set biologico ad un pozzetto o gruppo di pozzetti:

1. Nelle opzioni View (Visualizza) nella parte inferiore della finestra Plate Editor (Editor piastra),
selezionare la casella di controllo Biological Set (Set biologico).

2. Nell’editor piastra, verificare che al pozzetto o al gruppo di pozzetti sia stato assegnato un
fluoroforo.

3. Nel riquadro della piastra, selezionare il pozzetto o il gruppo di pozzetti.

4. Nel riquadro a destra, selezionare un nome nell’elenco a discesa Biological Set Name (Nome set
biologico).

Manuale operativo | 127



Capitolo 7 Preparazione delle piastre

Software CFX Manager Dx seleziona automaticamente la casella di controllo Load (Carica)
corrispondente.

5. Ripetere la Fase 4 per ciascun pozzetto o gruppo di pozzetti a cui è necessario assegnare un set
biologico.

6. Fare clic su OK per accettare le modifiche e salvare la piastra.

Suggerimento: L’assegnazione di nomi di set biologico ai pozzetti abilita le opzioni di analisi
del set biologico nella finestra di dialogo Experiment Settings (Impostazioni esperimento), in
cui è possibile eseguire l’analisi dei campioni in una delle quattro configurazioni. Per ulteriori
informazioni vedere Modifica delle impostazioni dell’esperimento a pagina 134.

Per rimuovere un set biologico

u Per rimuovere un set biologico dal pozzetto o dal gruppo di pozzetti selezionato, deselezionare la
casella di controllo Load (Carica).

Per aggiungere un nome del set biologico all’elenco

u Per aggiungere un nome del set biologico all’elenco a discesa, digitare un nome nella casella a
discesa Biological Set Name (Nome set biologico) e premere Enter (Invio):

Importante: I nomi del set biologico che vengono aggiunti nell’elenco a discesa sono
disponibili solo per la piastra attuale e solo se si assegna il nome ad un pozzetto e si salva la
disposizione della piastra. Se non si assegna il nome ad un pozzetto e non si salva la
disposizione della piastra, il nome non viene salvato e non sarà disponibile per utilizzi futuri.

Per visualizzare tutti i set biologici sulla piastra

u Selezionare la casella di controllo Biological Set (Set biologico) nelle opzioni View (Visualizza)
nella parte inferiore della finestra dell’editor.

Tutti i pozzetti visualizzano il rispettivo nome del set biologico, se assegnato. Il controllo Biological
Set Name (Nome set biologico) viene visualizzato nel riquadro a destra.

Per nascondere i set biologici, deselezionare la casella di controllo Biological Set (Set biologico)
nelle opzioni View (Visualizza).
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Assegnazione di numeri replicati ai pozzetti
Importante: Per assegnare di numeri replicati , il contenuto dei pozzetti selezionati deve essere
identico. Ossia, i pozzetti selezionati devono avere lo stesso tipo di campione e fluoroforo. Se
pertinente, è necessario assegnare loro anche lo stesso target e nome campione, come pure lo
stesso impostato. Se non sono uguali, Software CFX Manager Dx non abilita questa opzione.

Per assegnare numeri replicati ad un gruppo di pozzetti

1. Nell’editor piastra, assicurarsi che il contenuto del gruppo di pozzetti sia identico.

2. Nel riquadro della piastra, selezionare il gruppo di pozzetti target.

3. Per assegnare lo stesso numero di replicati a tutti i pozzetti selezionati, nella sezione Replicate #
(N. replicati), che si trova nel riquadro di destra, digitare il numero di replicati nella casella e quindi
selezionare Load (Carica).

4. (Facoltativo) Per applicare una serie di replicati ad un insieme di pozzetti selezionati:

a. Fare clic su Replicate Series (Serie di replicati). La sezione Replicate # (N. replicati) cambia
per visualizzare le seguenti opzioni:

n Replicate size (Dimensioni replicati): un numero che rappresenta il numero di
pozzetti in ciascun gruppo di replicati

n Starting replicate # (N. replicato iniziale): il primo numero della serie di replicati per il
gruppo di replicati selezionato

Nota: Per impostazione predefinita, Software CFX Manager Dx visualizza il numero
replicato iniziale come un numero maggiore dell’ultimo numero replicato assegnato nella
piastra. Ad esempio, se l’ultimo di replicati tecnici nella piastra è cinque, il successivo
numero iniziale sarà sei. È possibile cambiare il numero iniziale con un numero qualsiasi
che non sia già stato assegnato.

n Direzione di caricamento (Horizontal (Orizzontale) o Vertical (Verticale))
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b. Fare clic su Apply (Applica) per applicare i parametri alla serie e tornare alla visualizzazione
del Replicate # (N. replicati).

5. Fare clic su OK per accettare le modifiche e salvare la piastra.

Per rimuovere un pozzetto da una serie di replicati

u Selezionare il pozzetto o il gruppo di pozzetti da rimuovere e deselezionare la casella di controllo
Replicate # Load (Carica n. replicati).

In alternativa, è possibile fare clic su Clear Replicate # (Cancella n. replicati) per cancellare il
numero di replicati dal pozzetto o gruppo di pozzetti selezionato.

Assegnazione di una serie di diluizione ai tipi di campione
standard
Come indicato in precedenza, a tutti i pozzetti con il tipo di campione Standard deve essere assegnato
un valore di concentrazione. È possibile assegnare una serie di diluizione a più pozzetti con il tipo di
campione Standard.

Nota: Per assegnare una serie di diluizione ad un gruppo di pozzetti, i pozzetti devono essere
inclusi in una serie di tecnici. Per informazioni sull’aggiunta di pozzetti ad una serie di replicati,
vedere Assegnazione di numeri replicati ai pozzetti a pagina 129.

Per assegnare una serie di diluizione ad un gruppo di pozzetti campione Standard

1. Nell’editor piastra, verificare che vengano soddisfatti i seguenti requisiti:

n Il tipo di campione per il gruppo di pozzetti deve essere Standard.

n A tutti i pozzetti nel gruppo viene assegnato almeno un fluoroforo e tutti devono contenere gli
stessi fluorofori.

n Tutti i pozzetti nel gruppo sono inclusi nella stessa serie di tecnici.

Nota: Il Software CFX Manager Dx abilita l’opzione Dilution Series (Serie di diluizione)
solo quando tutti i pozzetti selezionati soddisfano questi criteri.

2. Nel riquadro della piastra, selezionare il gruppo di pozzetti target.

3. Nella sezione Concentration (Concentrazione) nel riquadro a destra, fare clic su Dilution Series
(Serie di diluizione). La sezione Concentration (Concentrazione) cambia per visualizzare le
seguenti opzioni:
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n Starting concentration (Concentrazione iniziale): il valore di concentrazione da cui inizia
la serie

n Replicates from and to (Replicati da e a): i replicati nella serie a cui sarà applicato il fattore
di diluizione

n Dilution factor (Fattore di diluizione): la quantità con cui cambiare la concentrazione
all’interno di ciascun gruppo di replicati

4. Impostare i valori per le opzioni o accettare le impostazioni predefinite.

5. Per impostazione predefinita, la serie di diluizione diminuisce in base al fattore di diluizione.
Selezionare Increasing (In aumento) per aumentare la serie di diluizione.

6. (Facoltativo) Per impostazione predefinita, il fattore di diluizione si applica a tutti i fluorofori nella
serie di replicati. Se la serie contiene più di un fluoroforo e si desidera applicare la diluizione ad un
solo fluoroforo, selezionarla dall’elenco a discesa.

7. Fare clic su Apply (Applica) per applicare la serie di diluizione al gruppo di pozzetti e tornare alla
vista Concentration (Concentrazione).

8. Fare clic su OK per accettare le modifiche e salvare la piastra.

Copia del contenuto del pozzetto in un altro pozzetto
È possibile copiare il contenuto di un pozzetto e incollarlo in un solo pozzetto o in più pozzetti.
Tuttavia, è possibile copiare il contenuto di un solo pozzetto. Non è possibile selezionare più pozzetti e
copiarne il contenuto.

Per copiare il contenuto del pozzetto in un altro pozzetto

1. Nel riquadro della piastra, selezionare il pozzetto da copiare.

2. Fare clic con il pulsante destro del mouse sul pozzetto e selezionare Copy Well (Copia pozzetto).

3. Selezionare il pozzetto o i pozzetti in cui incollare il contenuto:

n Per selezionare un solo pozzetto, fare clic sul pozzetto.
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n Per selezionare più pozzetti vicini, fare clic su un pozzetto e trascinare fino al pozzetto target.

n Per selezionare più pozzetti non vicini, premere il tasto Control (Ctrl) e fare clic su ciascun
pozzetto.

4. Con i pozzetti target selezionati, fare clic con il pulsante destro del mouse e selezionare Paste
Well (Incolla pozzetto).

Il Software CFX Manager Dx incolla il contenuto del primo pozzetto nei pozzetti selezionati.

Aggiunta di una nota ad un pozzetto
È possibile aggiungere una nota descrittiva ad un pozzetto. È possibile visualizzare le note pozzetto
nella scheda Quantification (Quantificazione) della finestra Data Analysis (Analisi dei dati).

Per aggiungere una nota ad un pozzetto

1. Nel riquadro della piastra, selezionare il pozzetto o i pozzetti a cui si intende aggiungere una nota.

2. Nella sezione View (Visualizza) nel riquadro inferiore, selezionare Well Note (Nota pozzetto).

L’area Well Note (Nota pozzetto) viene visualizzata nel riquadro a destra.

3. Digitare il contenuto della nota nella casella di testo e premere Enter (Invio).

Il testo viene visualizzato nella parte inferiore dei pozzetti selezionati.

Suggerimento: Se era stata creata una nota pozzetto precedente, è possibile selezionarla
dall’elenco a discesa e applicarla ai pozzetti selezionati.

Cancellazione di tutto il contenuto dei pozzetti
È possibile cancellare il contenuto di un singolo pozzetto, di un gruppo di pozzetti o di un’intera piastra.
La cancellazione dei pozzetti non rimuove i dati relativi alla fluorescenza raccolti durante la lettura
piastra.

La cancellazione di un pozzetto rimuove in modo permanente il contenuto dal pozzetto. Procedere
con cautela quando si cancellano i pozzetti.

Per cancellare tutte le impostazioni dei pozzetti

1. Nel riquadro piastra dell’editor piastra, selezionare il pozzetto o il gruppo di pozzetti:

n Per selezionare un solo pozzetto, fare clic sul pozzetto.

n Per selezionare più pozzetti vicini, fare clic su un pozzetto e trascinare fino al pozzetto target.
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n Per selezionare più pozzetti non vicini, tenere premuto il tasto Control (Ctrl) e fare clic su
ciascun pozzetto.

n Per selezionare una colonna intera con lo stesso tipo di campione, fare clic sul numero della
colonna.

n Per selezionare una riga intera, fare clic sul rispettivo numero di riga.

2. Nel riquadro di destra fare clic su Clear Wells (Cancella pozzetti).

Il Software CFX Manager Dx cancella tutte le impostazioni dei pozzetti selezionati.

3. Fare clic su OK per accettare le modifiche e salvare la piastra.
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Modifica delle impostazioni dell’esperimento
Usare la finestra di dialogo Experiment Settings (Impostazioni esperimento) per visualizzare o
cambiare l’elenco di target o campioni o per selezionare il gruppo di analisi dell’espressione genica e
l’opzione di analisi, se sono stati assegnati set biologici ai pozzetti nella piastra.

Nella finestra di dialogo Experiment Settings (Impostazioni esperimento), la scheda Targets (Target)
visualizza un elenco dei nomi target per ciascuna reazione PCR, come il gene target o le sequenze
geniche di interesse.

La scheda Samples (Campioni) visualizza un elenco di nomi campione che indicano la fonte del
target, come un campione prelevato a 1 ora (1Hr) o da un determinato individuo (mouse1 (topo 1)).

Per cambiare le impostazioni della piastra usando la finestra di dialogo Experiment
Settings (Impostazioni esperimento)

1. Per aprire la finestra di dialogo Experiment Settings (Impostazioni esperimento), eseguire una
delle seguenti operazioni:

n Nel riquadro a destra dell’editor piastra, fare clic su Experiment Settings (Impostazioni
esperimento).

n Nella scheda Gene Expression (Espressione genica) della finestra Data Analysis (Analisi dei
dati), fare clic su Experiment Settings (Impostazioni esperimento).

Appare la finestra di dialogo Experiment Settings (Impostazioni esperimento) che mostra il
contenuto della scheda Targets (Target).
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2. Per aggiungere un nuovo nome target o campione, nella scheda appropriata digitare un nome
nella casella di testo New (Nuovo) e fare clic su Add (Aggiungi).

3. Per rimuovere uno o più nomi target o campione dall’elenco, nella scheda appropriata
selezionare la casella di controllo dell’elemento nella colonna Select to Remove (Seleziona per
rimuovere) e fare clic su Remove checked item(s) (Rimuovi elementi selezionati).

4. Il Software CFX Manager Dx esclude il tipo di campione NTC (nessun controllo modello)
dall’analisi dell’espressione genica.

Per includere i tipi di campione NTC, deselezionare la casella di controllo nella sezione Exclude
the following sample types (Escludi i seguenti tipi di campione). È possibile scegliere di escludere
i seguenti tipi di campione selezionando la casella di controllo appropriata:

n NRT (nessuna trascrittasi inversa)

n Negative Control (Controllo negativo)

n Positive Control (Controllo positivo)

n Standard (Standard)
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5. Nella scheda Targets (Target):

a. Per selezionare un target come riferimento per l’analisi dei dati dell’espressione genica,
selezionarlo nella colonna Reference (Riferimento).

b. Per nascondere le impostazioni dell’analisi che saranno applicate nella scheda Gene
Expression (Espressione genica) della finestra Analysis Settings (Impostazioni analisi),
deselezionare Show Analysis Settings (Mostra impostazioni analisi).

Il software nasconde le seguenti colonne:

n Color (Colore)

n Show Chart (Mostra grafico)

n Auto Efficiency (Efficacia automatica)

n Efficiency (%) (Efficacia %)

c. Per cambiare il colore del target quando viene tracciato nel grafico dell’espressione genica,
fare clic sulla relativa cella nella colonna Color (Colore), selezionare un nuovo colore nella
finestra di dialogo Color (Colore) che viene visualizzata e fare clic su OK.

d. Per visualizzare il target nel colore selezionato nel grafico dell’espressione genica,
selezionare la casella di controllo corrispondente nella colonna Show Chart (Mostra grafico).

e. Per impostazione predefinita, CFX Manager Dx calcola automaticamente l’efficacia relativa
per un target se i suoi dati includono una curva standard.

Per usare un valore di efficacia determinato in precedenza, digitare il valore nella sua cella
nella colonna Efficiency (%) (Efficacia %) e premere il tasto Enter (Invio). CFX Manager Dx
deseleziona la casella di controllo Auto Efficiency (Efficacia automatica).

6. Nella scheda Samples (Campioni) :

a. Per selezionare un campione come campione di controllo per l’analisi dei dati
dell’espressione genica, selezionare la relativa casella di controllo nella colonna Control
(Controllo).

b. Per assegnare la condizione di controllo ad un campione per un’analisi, fare clic nella relativa
casella di controllo nella colonna Control (Controllo).

c. Se non è già selezionata, fare clic su Show Analysis Settings (Mostra impostazioni analisi)
per visualizzare o cambiare i parametri di analisi che saranno applicati nella scheda Gene
Expression (Espressione genica). Il software nasconde le colonne Color (Colore) e Show
Chart (Mostra grafico).
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7. Se sono stati assegnati uno o più set biologici ai pozzetti nella piastra (vedere Assegnazione di set
biologici ai pozzetti a pagina 127), selezionare una delle seguenti opzioni dall’elenco delle opzioni
di analisi del set biologico:

n Target vs. Sample (Target vs campione): nei calcoli dell’espressione genica viene usato
solo il nome campione del pozzetto.

n Target vs. Biological Set (Target vs set biologico): nei calcoli viene usato solo il nome
del set biologico.

n Target vs. Sample_Biological Set (Target vs campione_set biologico): il nome
campione e il nome del set biologico vengono combinati per formare un nome unico usato
nei calcoli.

n Target vs. Biological Set_Sample (Target vs set biologico_campione): il nome del set
biologico e il nome campione vengono combinati per formare un nome unico usato nei
calcoli.

8. Fare clic su OK per salvare i parametri nella finestra di dialogo Experiment Settings (Impostazioni
esperimento) e tornare alla finestra Plate Editor (Editor piastra).

Creazione di gruppi di pozzetti
I gruppi di pozzetti dividono una piastra singola in sottoinsiemi di pozzetti che possono essere
analizzati in modo indipendente nella finestra Data Analysis (Analisi dei dati). Una volta impostati i
gruppi di pozzetti, selezionarne uno nella finestra Data Analysis (Analisi dei dati) per analizzare i dati
come gruppo indipendente. Ad esempio, impostare i gruppi di pozzetti per analizzare più esperimenti
eseguiti in una sola piastra o per analizzare ciascun gruppo di pozzetti con una curva standard
diversa.

Nota: Il gruppo di pozzetti predefinito è All Wells (Tutti i pozzetti).

Per creare gruppi di pozzetti

1. Per aprire Well Groups Manager (Gestore gruppi di pozzetti), eseguire una delle seguenti
operazioni:

n Nella barra degli strumenti dell’editor piastra, fare clic su Well Groups (Gruppi di pozzetti).

n Nella finestra Data Analysis (Analisi dei dati), fare clic su ManageWell Groups (Gestisci
gruppi di pozzetti).

Viene visualizzata la finestra di dialogo Well Groups Manager (Gestore gruppi di pozzetti).
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2. Fare clic su Add (Aggiungi) per creare un nuovo gruppo. Il menu a discesa visualizza il nome
gruppo come Group 1 (Gruppo 1) per il primo gruppo.

3. Selezionare i pozzetti per il gruppo di pozzetti nella vista della piastra, facendo clic e trascinando
attraverso il gruppo di pozzetti. I pozzetti selezionati sono visualizzati in blu nel Manager
(Gestore).

4. (Facoltativo) Per cambiare il nome del gruppo, selezionare il nome nel menu a discesa e digitare
un nuovo nome.

5. (Facoltativo) Per eliminare un gruppo di pozzetti, selezionarne il nome nell’elenco a discesa e fare
clic su Delete (Elimina).

6. Fare clic su OK per finire e chiudere la finestra, oppure fare clic su Cancel (Annulla) per chiudere
la finestra senza apportare modifiche.

Importante: Per visualizzare i gruppi di pozzetti, selezionare Well Groups (Gruppi di pozzetti)
nelle opzioni View (Visualizza), nella parte inferiore della finestra Plate Editor (Editor piastra).
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Voci del menu del pulsante destro del mouse per la finestra di dialogo Well
Groups Manager (Gestione gruppi di pozzetti)

Nella Tabella 13 sono elencati le voci di menu disponibili nella finestra Well Groups Manager
(Gestione gruppi di pozzetti) quando si fa clic con il pulsante destro del mouse su un pozzetto.

Voce Funzione

Copy (Copia) Copia il contenuto del pozzetto, che può quindi essere
incollato in un altro pozzetto o pozzetti.

Copy as Image (Copia come
immagine)

Copia la vista del selettore pozzetto come immagine.

Print (Stampa) Stampa la visualizzazione del selettore pozzetto.

Print Selection (Stampa
selezione)

Stampa solo le celle selezionate.

Export to Excel (Esporta in
Excel)

Esporta i dati in un foglio di calcolo Excel.

Export to Csv (Esporta in csv) Esporta i dati come documento con valori separati da
virgole.

Export to Xml (Esporta in xml) Esporta i dati come documento .xml.

Export to Html (Esporta in html) Esporta i dati come documento .html.

Tabella 13. Voci del menu del pulsante destro del mouse nella finestra di dialogo Well
Selector (Selettore pozzetto) dell’editor piastra
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Modifica degli stili traccia
Durante l’impostazione della piastra e mentre è in corso l’analisi, è possibile modificare il colore e lo
stile delle tracce di amplificazione. Si possono quindi visualizzare facilmente le tracce nella finestra
dello stato in tempo reale mentre vengono raccolti i dati.

Per modificare gli stili traccia

1. Fare clic su Trace Styles (Stili traccia) nella barra degli strumenti dell’editor piastra.

Viene visualizzata la finestra di dialogo Trace Styles (Stili traccia) per la piastra aperta, ad
esempio:

2. Per visualizzare gli stili traccia per un particolare fluoroforo, selezionarlo dall’elenco a discesa
Fluorophores (Fluorofori).

3. Per cambiare la visualizzazione della traccia:

a. Selezionare il tipo di traccia dall’elenco a discesa Wells (Pozzetti).

b. Fare clic sul suo colore nella colonna Color (Colore).

c. Nella finestra di dialogo Color (Colore) che viene visualizzata, scegliere un altro colore per la
traccia e fare clic su OK.

Il cambiamento per il tipo di pozzetto viene visualizzato nella griglia sottostante.

d. (Facoltativo) Selezionare un simbolo per la traccia dall’elenco a discesa Symbols (Simboli).

4. Per cambiare rapidamente l’assortimento di colori, fare clic sulla scelta desiderata nella sezione
Color Quick Set (Impostazione rapida colore).
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5. Per visualizzare le etichette dei pozzetti nella griglia, selezionare il tipo di etichetta nella sezione
Well Labels (Etichette pozzetto).

6. Fare clic su OK per salvare le modifiche o su Cancel (Annulla) per annullarle.
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Visualizzazione della piastra in formato foglio di calcolo
Lo strumento Spreadsheet View/Importer (Vista foglio di calcolo/Programma importazione) visualizza
il contenuto di una piastra in formato foglio di calcolo. È possibile usare lo strumento Spreadsheet
View/Importer (Vista foglio di calcolo/Programma importazione) per esportare il contenuto del
pozzetto in formato delimitato da tabulazione in un’applicazione come Microsoft Excel. È possibile
anche importare il contenuto del pozzetto da un’applicazione delimitata da tabulazione.

Per usare lo strumento Spreadsheet View/Importer (Vista foglio di calcolo/Programma
importazione)

1. Nella barra degli strumenti dell’editor piastra, fare clic su Spreadsheet View/Importer (Vista foglio
di calcolo/Programma importazione) per aprire la finestra di dialogo Plate Spreadsheet View
(Vista foglio di calcolo piastra).

2. La finestra di dialogo Spreadsheet View (Vista foglio di calcolo) visualizza il contenuto nella
piastra per un solo fluoroforo. Per visualizzare il contenuto della piastra per un altro fluoroforo,
selezionarlo dall’elenco a discesa Fluors List (Elenco fluorofori).

3. Fare clic su Export Template (Esporta modello) per esportare un modello del foglio di calcolo
della piastra in un file di Excel (formato .csv). È possibile modificare questo modello per importare
le informazioni sul contenuto del pozzetto.

4. (Facoltativo) Fare clic su Import (Importa) per importare il contenuto del pozzetto da un file con
valori delimitati da virgole.

5. Per ordinare il foglio di calcolo conformemente ai dati in una colonna specifica, fare clic sul
triangolo accanto ad un nome colonna.
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Suggerimento: È possibile modificare il contenuto di qualsiasi cella in una colonna con un
asterisco (*) accanto al nome colonna (ad esempio *Nome target).

Nota: Selezionare le unità per i dati della curva standard nella colonna Quantity (Quantità)
aprendo l’editor piastra e selezionando Settings > Units (Impostazioni > Unità) nella barra dei
menu. Al termine dell’analisi della piastra, i dati di questi standard sono visualizzati nel grafico
della curva standard della scheda Quantification (Quantificazione) nella finestra Data Analysis
(Analisi dei dati) con le unità selezionate.

Voci del menu del pulsante destro del mouse per lo strumento Plate
Spreadsheet View/Importer (Vista foglio di calcolo/Programma importazione)

La Tabella 14 elenca le voci del menu disponibili nello strumento Spreadsheet View/Importer (Vista
foglio di calcolo/Programma importazione) quando si fa clic con il pulsante destro del mouse su uno
qualsiasi dei pozzetti dello strumento.

Voce Funzione

Copy (Copia) Copia tutto il foglio di calcolo.

Copy as Image (Copia
come immagine)

Copia il foglio di calcolo come file immagine.

Print (Stampa) Stampa il foglio di calcolo.

Print Selection (Stampa
selezione)

Stampa solo le celle selezionate.

Export to Excel
(Esporta in Excel)

Esporta il file in un foglio di calcolo di Excel.

Export to CSV (Esporta
in CSV)

Esporta il file come file .csv.

Export to Xml (Esporta
in xml)

Esporta il file come file .xml.

Export to Html (Esporta
in html)

Esporta il file come file .html.

Find (Trova) Cerca un testo specifico.

Tabella 14. Voci del menu selezionabili con il pulsante destro del mouse nello stru-
mento Plate Spreadsheet View/Importer (Vista foglio di calcolo/Programma impor-
tazione)
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Voce Funzione

Sort (Ordina) Ordina il foglio di calcolo selezionando fino a tre colonne di dati
nella finestra Sort (Ordina).

Tabella 14. Voci del menu selezionabili con il pulsante destro del mouse nello stru-
mento Plate Spreadsheet View/Importer (Vista foglio di calcolo/Programma impor-
tazione), continua
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Creazione di una disposizione piastra usando la procedura
di impostazione guidata

È possibile usare la procedura di impostazione guidata per inserire le informazioni sulla piastra che
sono necessarie per l’analisi dell’espressione genica normalizzata, fra cui:

n Nomi target

n Nomi campione

n Posizione dei target e del campione sulla piastra

n Geni di riferimento

n Campione di controllo

È possibile usare la procedura di impostazione guidata prima, durante o dopo un’analisi.

Utilizzo della procedura di impostazione guidata della piastra
In questo paragrafo si spiega come creare una disposizione piastra utilizzando la procedura di
impostazione guidata piastra. Per visualizzare più facilmente il contenuto di ogni pozzetto nella
piastra, fare clic su Zoom plate (Ingrandisci piastra), nella parte superiore della procedura guidata di
impostazione.

Importante: Se si ritorna alla scheda Auto layout (Disposizione automatica), mentre si è in
qualsiasi altra scheda della procedura guidata di impostazione, si ripristina la disposizione
scheda. Procedere con cautela quando si seleziona questa scheda.

Suggerimento: È possibile ripristinare la disposizione selezionando Tools > Clear Plate
(Strumenti > Cancella piastra) nella procedura guidata di impostazione.

Per utilizzare la procedura guidata di impostazione piastra

1. Aprire l’editor piastra.

2. Per aprire la procedura guidata di impostazione, scegliere Editing Tools > Setup Wizard (Modifica
strumenti > Procedura guidata di impostazione).

Appare la procedura guidata di impostazione con la scheda Auto layout (Disposizione
automatica).
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3. Nella scheda Auto layout (Disposizione automatica), procedere come segue:

a. Fare clic su un pozzetto nella griglia e trascinarlo verso il basso per specificare l’area della
piastra in cui si intende caricare il campione.

b. Inserire il numero di target e campioni da caricare.

Suggerimento: Il numero di target e campioni deve essere uguale al numero di celle
selezionate. Se i numeri immessi non si adattano all’area selezionata, modificare i
numeri o l’area di selezione della piastra. È possibile specificare l’orientamento degli
articoli sulla piastra e il loro raggruppamento.

c. (Facoltativo) Cambiare l’orientamento della piastra. Ad esempio, è possibile impostare i
target nelle colonne e nei campioni in file o gruppi di campioni.

d. Fare clic su Next (Avanti) per passare alla scheda Target names (Nomi target).

Nota: Se la disposizione piastra non ha un modello normale, utilizzare la scheda Target
names (Nomi target) per posizionare manualmente i target o la scheda Sample names (Nomi
campione) per posizionare manualmente i campioni sulla piastra. Fare clic e trascinare per
selezionare più pozzetti.

4. Nella scheda Target names (Nomi target), definire i nomi target dei gruppi target:

a. Eseguire una delle seguenti operazioni:

n Per rinominare i target per gruppo, impostare Select by (Seleziona per) su Target
(Target).
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n Per rinominare i target per pozzetto, impostare Select by (Seleziona per) su Well
(Pozzetto).

b. Selezionare un gruppo di target o il pozzetto nella griglia e digitare il nome nell’elenco a
discesa Target name (Nome target).

Suggerimento: Premere il tasto Tab per selezionare il gruppo o pozzetto successivo a
destra oppure premere Enter (Invio) per selezionare il gruppo successivo o il pozzetto
sottostante. In alternativa, nelle schede Target name (Nome target) e Sample name
(Nome campione), tenere premuto il tasto Control (Ctrl) e fare clic su un pozzetto per
selezionare più pozzetti che non sono contigui.

c. Fare clic su Next (Avanti) per passare alla scheda Sample Names (Nomi campione).

5. Nella scheda Sample names (Nomi campione), definire i nomi campione per i gruppi di campioni.

6. Fare clic su Next (Avanti) per passare alla scheda Reference targets (Target di riferimento).

7. Nella scheda Reference targets (Target di riferimento), selezionare uno o più target da utilizzare
come riferimenti per l’espressione genica normalizzata e fare clic su Next (Avanti) per passare
alla scheda Control sample (Campione di controllo).

8. Nella scheda Control sample (Campione di controllo), selezionare un campione da utilizzare
come controllo per i calcoli della rispettiva espressione genica.

9. Fare clic su OK per salvare la disposizione piastra e tornare all’editor piastra dove è possibile
definire altri parametri piastra. Per maggiori informazioni, vedere Assegnazione di parametri
opzionali al file piastra a pagina 123.

In alternativa, fare clic su Previous (Precedente) per tornare alla scheda precedente e apportare
eventuali modifiche.

Nota: Se si torna alla scheda Auto layout (Disposizione automatica) si ripristina
automaticamente la piastra. Procedere con cautela quando si fa clic su Previous
(Precedente).
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Capitolo 8 Esecuzione di esperimenti
In questo capitolo si spiega come eseguire esperimenti di analisi personalizzati (definiti dall’utente) o
PrimePCR™ utilizzando il software CFX Manager™ Dx.

Un file di dati di analisi contiene informazioni relative al protocollo e alla piastra per l’analisi. Il file
contiene anche i dati delle analisi che CFX Manager Dx esegue al termine della sessione di analisi.

Il software CFX Manager Dx semplifica la configurazione e l’esecuzione di esperimenti definiti
dall’utente o PrimePCR. La finestra Run Setup (Impostazione analisi) illustra le fasi comuni per
allestire un esperimento, arrivando fino alla finestra di dialogo Start Run (Avvia analisi) da cui si avvia
l’analisi.

Accesso alla finestra Run Setup (Impostazione analisi)
Per accedere alla finestra Run Setup (Impostazione analisi)

u Eseguire una delle seguenti operazioni:

n Nella scheda Run setup (Impostazione analisi) nella procedura guidata di avvio, fare clic su
User-defined (Definita dall’operatore) o PrimePCR (PCR priming).

n Nella finestra Home (Home), fare clic su User-defined Run Setup (Impostazione analisi
definita dall’operatore) o PrimePCR Run Setup (Impostazione analisi PCR priming) nella
barra degli strumenti.

n Nella finestra Home (Home), selezionare Run > User-defined Run (Analisi > Analisi definita
dall’operatore) oppure Run > PrimePCR Run (Analisi > Analisi PCR priming).
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Finestra Run Setup (Impostazione analisi)
La finestra Run Setup (Impostazione analisi) fornisce un accesso rapido ai file e alle impostazioni
necessarie a impostare ed eseguire un esperimento. Quando si sceglie di eseguire un esperimento
definito dall’utente, si apre la finestra Run Setup (Impostazione analisi) che mostra la scheda Protocol
(Protocollo). Quando si sceglie di eseguire un esperimento PrimePCR, si apre la finestra Run Setup
(Impostazione analisi) che mostra la scheda Start run (Avvia analisi).

Suggerimento: Per le informazioni relative a PrimePCR, fare riferimento a Esecuzione di
esperimenti PrimePCR a pagina 168; per informazioni sulla scheda Start run (Avvia analisi), fare
riferimento a Scheda Start Run (Avvia analisi) a pagina 158.
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1. Le schede sono una guida per l’impostazione e l’esecuzione di un esperimento:

n Scheda Protocol (Protocollo): consente di selezionare un protocollo esistente
per eseguire o per modificare o creare un nuovo protocollo nell’editor
protocollo.

n Scheda Plate (Piastra): consente di selezionare una piastra esistente da
analizzare o modificare oppure di creare una nuova piastra nell’editor piastra.

n Scheda Start Run (Avvia analisi): consente di visualizzare le impostazioni
dell’esperimento, selezionare uno o più blocchi strumento e avviare l’analisi.

2. La finestra principale visualizza le opzioni per ciascuna scheda quando vengono
applicate.

3. I pulsanti di navigazione danno accesso alla scheda Start Run (Avvia analisi).

LEGENDA

Manuale operativo | 151



Capitolo 8 Esecuzione di esperimenti

Scheda Protocol (Protocollo)
La scheda Protocol (Protocollo) visualizza un’anteprima del file protocollo che si prevede di eseguire.
Un file protocollo contiene le istruzioni per le fasi di temperatura dello strumento, nonché le opzioni
strumento che controllano velocità di rampa, volume campione e temperatura coperchio.

Come impostazione predefinita, il software visualizza il protocollo definito nella selezione file per la
sezione Run Setup (Impostazione analisi), nella scheda Files (File) della finestra di dialogo User >
User Preferences (Utente > Preferenze utente). Nella finestra di dialogo User Preferences
(Preferenze utente) è possibile modificare il protocollo predefinito. Per ulteriori informazioni, fare
riferimento a Modifica delle impostazioni file predefinite a pagina 67.

La scheda Protocol (Protocollo) consente di effettuare le seguenti operazioni:

n Creare un nuovo protocollo da eseguire

n Selezionare un protocollo esistente per eseguirlo o modificarlo

Per maggiori informazioni su come creare e modificare i protocolli, fare riferimento al Capitolo 6,
Creazione di protocolli.
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Per creare un nuovo protocollo

1. Nella scheda Protocol (Protocollo), fare clic su Create New (Crea nuovo).

Viene visualizzato l’editor protocollo.

2. Utilizzare l’editor protocollo per creare un nuovo protocollo.

3. Fare clic su OK per salvare il protocollo e tornare alla scheda Protocol (Protocollo) in Run Setup
(Impostazione analisi).

4. Esaminare i dettagli del protocollo ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Next (Avanti) per passare alla scheda Plate (Piastra).

n Se i dettagli non sono corretti, fare clic su Edit Selected (Modifica selezionato) per tornare
alla finestra Protocol Editor (Editor protocollo). Rivedere il protocollo, salvare le modifiche,
quindi fare clic su Next (Avanti) nella scheda Protocol (Protocollo) per procedere alla scheda
Plate (Piastra).

Selezione di un protocollo esistente

1. Nella scheda Protocol (Protocollo), eseguire una delle seguenti operazioni:

n Fare clic su Select Existing (Seleziona esistente) e navigare fino ad un protocollo esistente.

n Fare clic su Express Load (Caricamento veloce) e selezionare un protocollo dall’elenco a
discesa dei protocolli.

Suggerimento: Nell’elenco a discesa Express Load (Caricamento veloce) è possibile
aggiungere o rimuovere protocolli. Per maggiori informazioni, fare riferimento ad
Aggiunta e rimozione di protocolli di Express Load riportato di seguito.

2. Esaminare i dettagli del protocollo ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Next (Avanti) per passare alla scheda Plate (Piastra).

n Se i dettagli non sono corretti, fare clic su Edit Selected (Modifica selezionato) per aprire
l’editor protocollo. Rivedere il protocollo, salvare le modifiche, quindi fare clic su Next (Avanti)
nella scheda Protocol (Protocollo) per procedere alla scheda Plate (Piastra).

Aggiunta e rimozione di protocolli di Express Load

È possibile modificare il contenuto dell’elenco a discesa di Express Load che appare nell’editor
protocollo. I protocolli nell’elenco vengono salvati nella cartella che segue:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\
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Per modificare l’elenco di protocolli Express Load

1. Navigare fino alla cartella ExpressLoad e aprirla.

2. Esaminare i file dei protocolli (.pcrl) nella cartella.

3. Eseguire una delle seguenti operazioni:

n Eliminare i protocolli dalla cartella per rimuoverli dall’elenco a discesa.

n Copiare i protocolli nella cartella per aggiungerli all’elenco a discesa.

154 | Sistemi CFX96 Dx e CFX96 DeepWell Dx



Scheda Plate (Piastra)

Scheda Plate (Piastra)
Nota: Se il protocollo selezionato nella scheda Protocol (Protocollo) non include una fase di
lettura piastra per l’analisi PCR in tempo reale, la scheda Plate (Piastra) viene nascosta. Per
visualizzare la scheda Plate (Piastra), aggiungere almeno una lettura piastra al protocollo.

La scheda Plate (Piastra) visualizza un’anteprima del file piastra che si prevede di caricare. In
un’analisi PCR in tempo reale, il file piastra contiene una descrizione del contenuto di ciascun
pozzetto, compresi i relativi fluorofori, la modalità di scansione e il tipo di piastra. Il software CFX
Manager Dx utilizza queste descrizioni per la raccolta dati e l’analisi.

Per impostazione predefinita, il software visualizza la piastra definita nella sezione File Selection for
Run Setup (Selezione file per l’impostazione analisi) nella scheda Files (File) nella finestra di dialogo
User > User Preferences (Utente > Preferenze utente). Nella finestra di dialogo User Preferences
(Preferenze utente) è possibile modificare la piastra predefinita. Per ulteriori informazioni fare
riferimento a Modifica delle impostazioni file predefinite a pagina 67.

Nella scheda Plate (Piastra), è possibile:

n Creare una nuova piastra da caricare.

n Selezionare una piastra esistente da caricare o modificare.
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Per ulteriori informazioni sulla creazione e sulla modifica delle piastre, consultare il Capitolo 7,
Preparazione delle piastre.

Per creare una nuova piastra

1. Nella scheda Plate (Piastra) fare clic su Create New (Crea nuovo).

Viene visualizzato l’editor piastra.

2. Usare l’editor piastra per creare una nuova piastra.

3. Fare clic su OK per salvare la piastra e tornare alla scheda Plate (Piastra) in Run Setup
(Impostazione analisi).

4. Esaminare i dettagli della piastra ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Next (Avanti) per passare alla scheda Start Run (Avvia
analisi).

n Se i dettagli non sono corretti, fare clic su Edit Selected (Modifica selezionato) per tornare
all’editor piastra. Revisionare il file piastra, salvare le modifiche, quindi fare clic su Next
(Avanti) sulla scheda Plate (Piastra) per procedere alla scheda Start Run (Avvia analisi).

Per selezionare un file piastra esistente

1. Nella scheda Plate (Piastra) eseguire una delle seguenti operazioni:

n Fare cic su Select Existing (Seleziona esistente) e navigare fino a un file piastra esistente.

n Fare clic su Express Load (Caricamento veloce) e selezionare un file piastra dall’elenco a
discesa.

Suggerimento: È possibile aggiungere delle piastre o rimuoverle dall’elenco a discesa
Express Load (Caricamento veloce). Per ulteriori informazioni fare riferimento al capitolo
Aggiunta e rimozione di file piastra di Express Load riportato di seguito.

2. Esaminare i dettagli della piastra ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Next (Avanti) per passare alla scheda Start Run (Avvia
analisi).

n Se i dettagli non sono corretti, fare clic su Edit Selected (Modifica selezionato) per aprire la
finestra dell’editor piastra. Revisionare il file piastra, salvare le modifiche, quindi fare clic su
Next (Avanti) per procedere alla scheda Start Run (Avvia analisi).
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Aggiunta e rimozione di file piastra di Express Load

È possibile modificare il contenuto dell’elenco a discesa di Express Load che appare nell’editor
piastra. Le piastre che appaiono nell’elenco vengono salvate nella seguente cartella:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

Per modificare l’elenco di file piastra di Express Load

1. Navigare fino alla cartella ExpressLoad e aprirla.

2. Esaminare i file piastra (.pltd) nella cartella.

3. Eseguire una delle seguenti operazioni:

n Eliminare i file piastra dalla cartella per rimuoverli dall’elenco a discesa.

n Copiare i file piastra nella cartella per aggiungerli all’elenco a discesa.
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Scheda Start Run (Avvia analisi)
La scheda Start Run (Avvia analisi) visualizza le informazioni relative all’esperimento da eseguire.
Visualizza anche il blocco o i blocchi di strumenti collegati sui quali è possibile eseguire l’esperimento.

La scheda Start Run (Avvia analisi) consente di effettuare le seguenti operazioni:

n Visualizzare informazioni dettagliate sull’analisi, incluso il file del protocollo selezionato, il file
piastra e la modalità di scansione.

n Aggiungere note relative all’analisi.

n Visualizzare i dettagli relativi a tutti gli strumenti collegati, incluso il relativo stato dell’analisi (in
corso o inattiva), il volume del campione in µl, la temperatura del coperchio, la modalità di
emulazione e l’ID o il codice a barre, se disponibile.

Nota: È possibile modificare le colonne che sono visualizzate in Start Run (Avvia analisi)
nella tabella Selected Blocks (Blocchi selezionati). Per maggiori informazioni, fare riferimento
a Modifica dei dettagli nella tabella dei blocchi selezionati a pagina 159.

n Selezionare il blocco o i blocchi sui quali eseguire l’analisi.

n Aprire o chiudere in remoto il coperchio di ciascun strumento selezionato.

n Avviare l’analisi.
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Modifica dei dettagli nella tabella dei blocchi selezionati

È possibile modificare le colonne che sono visualizzate nella tabella Start Run on Selected Blocks
(Avvia analisi nei blocchi selezionati). Nella tabella si possono anche modificare il volume del
campione predefinito e i valori della temperatura del coperchio. Le modifiche dell’impostazione
vengono applicate all’analisi che deve essere effettuata.

Per aggiungere colonne nella tabella Start Run on Selected Blocks (Avvia analisi nei
blocchi selezionati)

u Fare clic sulla tabella con il pulsante destro del mouse e selezionare un’opzione nel menu che
appare.

Per rimuovere colonne nella tabella Start Run on Selected Blocks (Avvia analisi nei
blocchi selezionati)

u Fare clic sulla tabella con il pulsante destro del mouse e deselezionare un’opzione nel menu che
appare.

Per modificare un volume campione o i valori della temperatura del coperchio per un
blocco

u Selezionare la cella del volume campione o della temperatura del coperchio per il blocco target e
digitare un nuovo valore nella cella.

Per aggiungere un ID o un codice a barre dell’analisi per un blocco

u Selezionare la cella ID/Bar Code (ID/codice a barre) per il blocco target e digitare un ID oppure
eseguire la scansione del blocco con un lettore di codici a barre.

Esecuzione di un esperimento
Importante: Prima di eseguire un esperimento, verificare che il software anti-virus del computer
utilizzato non avvii una scansione durante l’analisi.

Per eseguire un esperimento

1. Nella scheda Start Run (Avvia analisi), verificare i dettagli della piastra e del protocollo nella
sezione Run Information (Informazioni analisi).

2. (Facoltativo) Aggiungere note relative all’analisi o all’esperimento nella casella di testo Notes
(Note).

3. Selezionare la casella di controllo di uno o più blocchi sui quali eseguire l’analisi.

Suggerimento: Per eseguire l’esperimento su tutti i blocchi, selezionare Select All Blocks
(Seleziona tutti i blocchi), che si trova sotto la tabella Selected Blocks (Blocchi selezionati).
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4. (Facoltativo) Fare clic su Flash Block Indicator (Lampeggio indicatore di blocco) per far lampeggiare il
LED di indicazione sui blocchi strumento selezionati.

5. Inserire le piastre esperimento nel blocco:

a. Fare clic su Open Lid (Apri coperchio). Si apre il coperchio motorizzato di ciascun blocco
selezionato.

b. Inserire un blocco esperimento in ciascun blocco selezionato.

c. Fare clic su Close Lid (Chiudi coperchio).

Suggerimento: È possibile anche premere il pulsante nella parte anteriore di ciascun blocco
per aprire e chiudere il coperchio.

6. Fare clic su Open Lid (Apri coperchio) e Close Lid (Chiudi coperchio) per aprire e chiudere il
coperchio motorizzato di ciascun blocco strumento selezionato.

7. Esaminare i dettagli dell’analisi ed eseguire una delle seguenti operazioni:

n Se i dettagli sono corretti, fare clic su Start Run (Avvia analisi).

n Se i dettagli non sono corretti:

o Correggere i dettagli nella tabella Selected Blocks (Blocchi selezionati) e fare clic su
Start Run (Avvia analisi).

o Tornare alla scheda corretta ed eseguire le modifiche necessarie, salvare le modifiche,
quindi fare clic su Next (Avanti) per tornare alla scheda Start Run (Avvia analisi) e
avviare l’analisi.

Avvio di una nuova analisi da un’analisi precedente

u Eseguire una delle seguenti operazioni:

n Selezionare File > Repeat a Run (File > Ripeti un’analisi) nella barre dei menu principale del
software; navigare e fare doppio clic sul file di dati dell’analisi che si desidera ripetere.

n Selezionare la scheda Repeat Run (Ripeti analisi) nella procedura guidata di avvio, quindi
fare doppio clic sul file di dati dell’analisi che si desidera ripetere.

Opzionalmente, nella scheda Repeat Run (Ripeti analisi), fare clic su Browse (Sfoglia),
quindi navigare e fare doppio clic sul file di dati dell’analisi che si desidera ripetere.
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Finestra di dialogo Run Details (Dettagli dell’analisi)
Quando si fa clic su Start Run (Avvia analisi), il software CFX Manager Dx chiede di salvare il file di
dati (.pcrd), avvia l’analisi e apre la finestra di dialogo Run Details (Dettagli analisi). La finestra di
dialogo Run Details (Dettagli analisi) include tre schede di stato:

n Run Status (Stato dell’analisi): utilizzare questa scheda per visualizzare lo stato attuale del
protocollo, aprire o chiudere il coperchio, mettere in pausa un’analisi, aggiungere ripetizioni,
saltare fasi o interrompere l’analisi.

n Real-time Status (Stato in tempo reale): utilizzare questa scheda per visualizzare i dati della
fluorescenza dell’analisi PCR in tempo reale man mano che vengono raccolti.

n Time Status (Stato tempo): utilizzare questa scheda per visualizzare un timer per conto alla
rovescia a schermo intero per il protocollo.

Queste schede sono spiegate in dettaglio nei paragrafi che seguono.

Scheda Run Status (Stato analisi)
Scheda Run Status (Stato analisi) visualizza lo stato attuale di un’analisi in corso. In questa schermata
è possibile anche controllare il coperchio e le modifiche dell’analisi in corso.
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1. Riquadro Run Status (Stato analisi): visualizza lo stato attuale del protocollo.

2. Run Status controls (Controlli stato analisi): permette di utilizzare lo strumento o
interrompere il protocollo attuale.

3. Riquadro Run Information (Informazioni analisi): visualizza i dettagli dell’analisi.

LEGENDA

Comandi di stato dell’analisi

Utilizzare i comandi della scheda Run Status (Stato analisi) per azionare lo strumento a partire dal
software o cambiare un’analisi che è in corso.

Nota: Se si apportano modifiche al protocollo durante l’analisi, come l’aggiunta di ripetizioni, il file
del protocollo associato all’analisi non viene modificato. Tali azioni sono registrate nel registro
dell’analisi.

: apre il coperchio motorizzato degli strumenti selezionati.

Importante: L’apertura del coperchio durante l’analisi mette in pausa l’analisi durante la fase
attuale e potrebbe alterare i dati.

: chiude il coperchio motorizzato degli strumenti selezionati.

: aggiunge più ripetizioni all’attuale fase GOTO del protocollo. Questa opzione è disponibile solo
quando è in corso una fase GOTO.

: ignora la fase attuale del protocollo.

Nota: Se si ignora una fase GOTO, il software chiede di confermare che si intende ignorare
l’intero loop GOTO e passare alla fase successiva del protocollo.

: fa lampeggiare il LED sullo strumento selezionato per identificare i blocchi selezionati.
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: mette in pausa il protocollo.

Nota: Questa azione viene registrata nel registro dell’analisi.

: riprende un protocollo messo in pausa.

: interrompe l’analisi prima della fine del protocollo.

Nota: Se si interrompe un’analisi prima della fine del protocollo, i dati potrebbero essere
alterati.
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Scheda Real-time Status (Stato in tempo reale)
La scheda Real-time Status (Stato in tempo reale) visualizza i dati dell’analisi PCR in tempo reale
raccolti ad ogni ciclo durante l’analisi, dopo le prime due letture piastra.

1. Amplification trace pane (Riquadro traccia di amplificazione): visualizza i dati
dell’amplificazione in tempo reale durante l’analisi.

2. Well group identifier (Identificativo gruppo di pozzetti): se durante l’impostazione
piastra i gruppi di pozzetti sono stati identificati, gli utenti possono selezionare un
gruppo di pozzetti per visualizzarne le tracce, i pozzetti e le informazioni tabulari.

Step number identifier (Identificativo numero di fase): se il protocollo raccoglie i
dati in più di una fase (per esempio durante l’amplificazione e la curva di
fusione), gli utenti possono selezionare una specifica fase e visualizzare le
tracce raccolte durante tale fase.

3. Well selector pane (Riquadro selettore pozzetto): visualizza i pozzetti attivi,
inattivi e vuoti della piastra.

4. Plate setup table pane (Riquadro tabella di impostazione piastra): visualizza
l’impostazione piastra in formato tabulare.

LEGENDA
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5. Run details pane (Riquadro dettagli analisi): visualizza lo stato in tempo reale
dell’analisi tra cui:

n La fase attuale

n La ripetizione attuale

n La temperatura attuale

n Il tempo residuo

n La temperatura del campione

n La temperatura del coperchio

6. Plate Setup (Impostazione piastra): apre la finestra di dialogo Plate Setup
(Impostazione piastra), nella quale gli utenti possono modificare l’impostazione
della piastra attuale durante l’analisi.

Nella scheda Real-time Status (Stato in tempo reale) è possibile:

n Mostrare o nascondere le tracce in tempo reale selezionandole nel riquadro del selettore pozzetto
o nella tabella di impostazione piastra.

n Visualizzare tracce singole o gruppi di tracce selezionandole nell’elenco a discesa del gruppo di
pozzetti.

n Modificare la piastra o sostituire il file piastra.

n Applicare un file PrimePCR all’analisi.

Mostrare o nascondere le tracce in tempo reale

Per impostazione predefinita, tutti i pozzetti riempiti sono attivi e compaiono nella tabella di
configurazione della piastra. I pozzetti attivi sono visualizzati in blu nel riquadro del selettore pozzetto.
I pozzetti nascosti sono visualizzati in grigio chiaro e i pozzetti inutilizzati sono visualizzati in grigio
scuro nel riquadro del selettore pozzetto.

Durante l’analisi è possibile nascondere le tracce dai pozzetti attivi. Il Software CFX Manager Dx
continua a raccogliere i dati per tutti i pozzetti; quando si nascondono i pozzetti, i rispettivi dati non
sono visualizzati nella tabella di configurazione della piastra.

Per nascondere le tracce in tempo reale

u Nel riquadro del selettore pozzetto, fare clic sui pozzetti attivi (blu) che si desidera nascondere.

Per mostrare le tracce in tempo reale

u Nel riquadro del selettore pozzetto, fare clic sui pozzetti nascosti (grigio chiaro) che si desidera
visualizzare.

Per maggiori informazioni sul selettore pozzetto, vedere Selettore pozzetto a pagina 182.
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Modifica di un’impostazione piastra

Per modificare un’impostazione piastra

u Fare clic su Plate Setup (Impostazione piastra), quindi selezionare View/Edit Plate
(Visualizza/Modifica piastra).

Viene visualizzata la finestra Plate Editor (Editor piastra), in cui è possibile modificare la piastra
durante l’esecuzione dell’analisi. Per ulteriori informazioni sulla modifica delle piastre, consultare
il Capitolo 7, Preparazione delle piastre.

Nota: Inoltre, è possibile modificare gli stili traccia dalla finestra Plate Editor (Editor piastra).
Le modifiche vengono visualizzate nel grafico della traccia di amplificazione nella scheda
Real-time Status (Stato in tempo reale).

Sostituzione di un file piastra

Suggerimento: La sostituzione di un file piastra è particolarmente utile se si avvia un’analisi con
un file Quick Plate nella cartella ExpressLoad.

Per sostituire un file piastra

u Fare clic su Plate Setup (Impostazione piastra), quindi selezionare una delle seguenti opzioni:

n Replace Plate file (Sostituisci file piastra): selezionare il nuovo file piastra dall’elenco nella
finestra di navigazione

n Apply PrimePCR file (Applica file PrimePCR): cercare il file di un’analisi da cui si otterrà la
disposizione della piastra utilizzando la funzione di ricerca intelligente oppure fare clic su
Browse (Sfoglia) per individuare un file che è stato scaricato dal sito web Bio-Rad e che non
si trova nella cartella PrimePCR

Nota: Il Software CFX Manager Dx controlla la modalità di scansione e le dimensioni della
piastra per il file piastra, che devono essere uguali a quelle delle impostazioni con cui è stata
avviata l’analisi.
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Scheda Time Status (Stato tempo)
La scheda Time Status (Stato tempo) visualizza il tempo rimanente per completare l’analisi in corso.
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Esecuzione di esperimenti PrimePCR
Gli esperimenti PrimePCR utilizzano dosaggi specifici di percorso o malattia che Bio-Rad ha
convalidato in wet-lab e ottimizzato e che sono disponibili nei seguenti formati:

n Pannelli prepiastrati: piastre contenenti dosaggi che sono specifici per un percorso biologico o
una malattia; includono controlli PrimePCR e geni di riferimento

n Piastre configurate personalizzate: piastre che possono essere impostate in una disposizione
definita dall’utente con l’opzione di scegliere dosaggi per i target di interesse, i controlli e i
riferimenti

n Dosaggi individuali: provette che contengono singoli set di primer da usare nelle reazioni in tempo
reale

Per ridurre il tempo di analisi complessivo, è possibile rimuovere la fase di fusione nel protocollo. Bio-
Rad raccomanda vivamente di non apportare altre modifiche ad un protocollo di analisi PrimePCR. Il
protocollo predefinito è quello usato per la convalida del dosaggio. Qualsiasi deviazione da tale
raccomandazione può alterare i risultati. Le modifiche al protocollo vengono annotate nella scheda
Run Information (Informazioni analisi) del file di dati risultante e in qualsiasi report creato.

Per avviare un’analisi PrimePCR

u Per avviare un’analisi PrimePCR, eseguire una delle seguenti operazioni:

n Nella procedura guidata di avvio, selezionare PrimePCR (PrimePCR) nella scheda Run
Setup (Impostazione analisi), quindi selezionare la chimica appropriata (SYBER o sonda).

n Selezionare un’analisi PrimePCR dall’elenco Recent Runs (Analisi recenti) della scheda
Repeat run (Ripeti analisi), nella procedura guidata di avvio.

n Selezionare File > New > PrimePCR Run (File > Nuovo > Analisi PrimePCR) nella finestra
Home (Home).

n Selezionare File > Open > PrimePCR Run File (File > Nuovo > File di analisi PrimePCR)
nella finestra Home (Home).

n Selezionare e trascinare un file di analisi PrimePCR nella finestra Home (Home).

Dopo aver selezionato un’analisi PrimePCR, si apre la finestra Run Setup (Impostazione analisi) nella
scheda Start Run (Avvia analisi) con la disposizione piastra PrimePCR predefinita, caricata in base
allo strumento selezionato.

Per rimuovere la fase di fusione nel protocollo

u Nella scheda Protocol (Protocollo), deselezionare la casella accanto a Include Melt Step (Includi
fase di fusione).
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Per importare le informazioni target per le piastre PrimePCR in una disposizione piastra

1. Eseguire una delle seguenti operazioni:

n Nella scheda Real-time Status (Stato in tempo reale) della finestra di dialogo Run Details
(Dettagli analisi), selezionare Plate Setup > Apply PrimePCR File (Impostazione piastra >
Applica file PrimePCR).

n Nella finestra Data Analysis (Analisi dei dati), selezionare Plate Setup > Apply PrimePCR
File (Impostazione piastra > Applica file PrimePCR).

2. Nella finestra di dialogo PrimePCR Run File (File di analisi PrimePCR), fare clic su Browse
(Sfoglia) per navigare fino al file PrimePCR appropriato (.csv).

3. Selezionare il file PrimePCR target e fare clic su Open (Apri).

Il Software CFX Manager Dx importa le informazioni target nella disposizione piastra.
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Il Software CFX Manager™ Dx offre più metodi per aprire e visualizzare i file di dati. È possibile:

n Selezionare File > Open > Data File (File > Apri > File di dati) nella finestra Home (Home) e
navigare fino al file .pcrd di destinazione.

n Selezionare File > Recent Data Files (File > File di dati recenti) nella finestra Home (Home) per
selezionare un file dall’elenco degli ultimi dieci file di dati aperti più di recente.

Finestra Data Analysis (Analisi dei dati)
La finestra Data Analysis (Analisi dei dati) visualizza più schede; ciascuna scheda mostra i dati
analizzati per un metodo di analisi specifico o le informazioni specifiche dell’analisi. Le schede sono
visualizzate solo se i dati raccolti nell’analisi sono disponibili per quel tipo di analisi.

Suggerimento: Per selezionare le schede da visualizzare, selezionarle dal menu a discesa View
(Visualizza) nella finestra Data Analysis (Analisi dei dati). Per tornare nel layout della scheda
originale, selezionare Settings > Restore Default Window Layout (Impostazioni > Ripristina layout
predefinito della finestra).
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Barra degli strumenti Data Analysis (Analisi dei dati)
La barra degli strumenti della finestra Data Analysis (Analisi dei dati) fornisce rapido accesso a
importanti funzioni di analisi dei dati.

La Tabella 15 elenca le funzioni dei pulsanti nella barra degli strumenti.

Pulsante Nome Funzione

Plate Setup
(Impostazione
piastra)

View/Edit plate (Visualizza/Modifica piastra):
apre l’editor piastra per visualizzare e
modificare il contenuto dei pozzetti.

Replace Plate file (Sostituisci file piastra):
seleziona un file piastra per sostituire il
layout della piastra.

Apply PrimePCR file (Applica file
PrimePCR): seleziona un file di analisi per
sostituire il layout piastra per un’analisi
PrimePCR™.

Gestisci gruppi di
pozzetti

Apre la finestra Well Groups Manager
(Gestore gruppi di pozzetti) per creare,
modificare ed eliminare i gruppi di pozzetti.

Gruppo di pozzetti Selezionare il nome di un gruppo di pozzetti
esistente dal menu a discesa. La selezione
predefinita è All Wells (Tutti i pozzetti).
Questo pulsante viene visualizzato solo
quando si creano dei gruppi di pozzetti.

Modalità di analisi Analizza i dati in modalità Fluorophore
(Fluoroforo) o Target (Target).

Guida Apre una copia digitale di questo manuale in
formato Acrobat PDF.

Tabella 15. Barra degli strumenti della finestra Data Analysis (Analisi dei dati)
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Barra dei menu di analisi dei dati
Nella Tabella 16 sono elencate le voci della barra dei menu disponibili nella finestra Data Analysis
(Analisi dei dati).

Voce di menu Comando Funzione

File (File) Save (Salva) Salva il file.

Save as (Salva con nome) Salva il file con un nuovo nome.

Repeat Run (Ripeti analisi) Estrae il file protocollo e piastra dall’attuale
analisi per eseguirla di nuovo.

Close (Chiudi) Chiude la finestra Data Analysis (Analisi dei
dati).

View (Visualizza) Run Log (Registro analisi) Apre la finestra Run Log (Registro analisi)
per visualizzare il registro dell’analisi
dell’attuale file di dati.

Quantification, Melt Curve, Gene
Expression, End Point, Custom
Data View, QC, Run Information
(Quantificazione, Curva di
fusione, Espressione genica,
Punto finale, Visualizza dati
personalizzati, CQ, Informazioni
analisi)

Visualizza i dati analizzati nelle schede
selezionate della finestra Data Analysis
(Analisi dei dati). Deve essere selezionata
almeno una scheda.

Settings
(Impostazioni)

Cq Determination Mode
(Modalità di determinazione Cq)

Selezionare la modalità Regression
(Regressione) o Single Threshold (Soglia
singola) per determinare come vengono
calcolati i valori Cq per ogni traccia.

Baseline Setting (Impostazione
linea basale)

Selezionare il metodo Baseline Subtraction
(Sottrazione linea basale) per i gruppi di
pozzetti selezionati.

Analysis Mode (Modalità di
analisi)

Selezionare questa voce per analizzare i
dati in base al fluoroforo o in base al target.

Tabella 16. Voci della barra dei menu disponibili nella finestra Data Analysis (Analisi dei dati)
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Voce di menu Comando Funzione

Cycles to Analyze (Cicli da
analizzare)

Selezionare i cicli che devono essere
analizzati.

Baseline Threshold (Soglie linea
basale)

Apre la finestra Baseline Threshold (Soglie
linea basale) per regolare la linea basale o
la soglia.

Trace Styles (Stili traccia) Apre la finestra di dialogo Trace Styles (Stili
traccia).

Plate Setup (Impostazione
piastra)

Apre l’editor piastra per visualizzare e
modificare la piastra; sostituire la piastra
attuale con una piastra del file piastra
definito dall’utente o un file di analisi
PrimePCR.

Include All Excluded Wells
(Includi tutti i pozzetti esclusi)

Include nell’analisi tutti i pozzetti esclusi.

Mouse Highlighting
(Evidenziazione mouse)

Attiva o disattiva l’evidenziazione
simultanea dei dati con il puntatore del
mouse.

Suggerimento: Se la funzione Mouse
Highlighting (Evidenziazione mouse) è
disattivata, premere il tasto Control
(Ctrl) per attivare provvisoriamente
l’evidenziazione.

Restore Default Window Layout
(Ripristina layout finestra
predefinito)

Ripristina l’impostazione predefinita per la
disposizione delle finestre.

Tabella 16. Voci della barra dei menu disponibili nella finestra Data Analysis (Analisi dei dati),
continua
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Voce di menu Comando Funzione

Export (Esporta) Export All Data Sheets to Excel
(Esporta tutti i fogli dati in Excel)

Esporta tutte le viste del foglio di calcolo da
ciascuna scheda in un file Excel separato.

Custom Export (Personalizza
esportazione)

Apre la finestra Custom Export
(Personalizza esportazione) in cui è
possibile specificare i file da esportare e il
formato file.

Export to LIMS Folder (Esporta
nella cartella LIMS)

Apre una finestra per salvare i dati in un
formato prestabilito nella cartella LIMS.

Seegene Export (Esportazione
per Seegene)

Apre una finestra per identificare la
posizione dove salvare i dati di tutte le viste
del foglio di calcolo nei file Excel
specificamente strutturati per l’utilizzo da
parte di Seegene, Inc.

Tools (Strumenti) Reports (Report) Apre il Report per questo file di dati.

Well Group Reports (Report
gruppo pozzetti)

Apre la finestra Well Group Report (Report
gruppo pozzetti) per i gruppi di pozzetti
specificati).

Import Fluorophore Calibration
(Importa calibrazione fluoroforo)

Selezionare un file di calibrazione da
applicare al file di dati attuale.

qbase+ Se installato, avvia qbase+ v2.5
direttamente dal file .pcrd attuale.

Tabella 16. Voci della barra dei menu disponibili nella finestra Data Analysis (Analisi dei dati),
continua
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Dettagli scheda
In ciascuna scheda della finestra Data Analysis (Analisi dei dati) sono visualizzati i dati dei grafici e dei
fogli di calcolo per una specifica metodologia di analisi ed è incluso un selettore pozzetto per
selezionare i dati che si desidera mostrare. Per impostazione predefinita, la finestra Data Analysis
(Analisi dei dati) visualizza la scheda Quantification (Quantificazione) quando si apre. È possibile
aggiungere i dati del grafico Amplification (Amplificazione) nella scheda Quantification
(Quantificazione) per determinare le impostazioni di analisi corrette per l’analisi.

Nota: Il software collega i dati nei riquadri di ciascuna scheda Data Analysis (Analisi dei dati). Ad
esempio, quando si evidenzia un pozzetto mettendo il puntatore del mouse sopra il pozzetto, nel
selettore pozzetto vengono evidenziati i dati di tutti gli altri riquadri.

Selettore del numero di fase
I sistemi CFX96 e CFX96 DeepWell possono acquisire dati di fluorescenza in più fasi del protocollo; il
software mantiene i dati acquisiti in ciascuna fase in modo indipendente. Il software visualizza il
selettore del numero di fase. Quando un protocollo contiene almeno una fase di raccolta dati, il
Software CFX Manager Dx visualizza i dati della prima fase di raccolta.

Se il protocollo contiene più fasi di raccolta, è possibile selezionare un’altra fase dall’elenco a discesa,
ad esempio:
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Quando si seleziona una fase, il software applica tale selezione a tutti i dati mostrati nella finestra Data
Analysis (Analisi dei dati).

Visualizzazione dei gruppi di pozzetti nell’analisi dei dati
I pozzetti nella piastra possono essere raggruppati in sottoinsiemi per l’analisi indipendente
utilizzando i gruppi di pozzetti. Quando si creano gruppi di pozzetti, i rispettivi nomi gruppo sono
visualizzati nell’elenco a discesa Well Groups (Gruppi pozzetti) della finestra Data Analysis (Analisi
dei dati) sulla barra degli strumenti.

Se si creano gruppi di pozzetti, il software visualizza il gruppo di pozzetti predefinito All Wells quando
si apre la finestra Data Analysis (Analisi dei dati), visualizzando i dati in tutti i pozzetti con contenuto
nei grafici e nei fogli di calcolo. Solo i pozzetti di quel gruppo di pozzetti caricato con contenuto viene
visualizzato nel selettore pozzetto e solo i dati di tali pozzetti sono inclusi nei calcoli dell’analisi dei dati.

Nota: Se non si creano gruppi di pozzetti, nella barra degli strumenti non è visualizzato l’elenco a
discesa Well Groups (Gruppi di pozzetti).

Modifica del contenuto dei pozzetti dopo l’analisi
La modifica della modalità di visualizzazione dei dati durante l’analisi dei dati, apportata cambiando il
contenuto dei pozzetti nell’editor piastra, non comporta cambiamenti ai dati della fluorescenza raccolti
da ogni pozzetto durante l’analisi. Dopo che il modulo ha raccolto i dati della fluorescenza, non è
possibile eliminare tali dati anche se si può scegliere di rimuoverli dalla visualizzazione e dall’analisi.

Per cambiare il contenuto dei pozzetti dopo un’analisi

u Nella finestra Data Analysis (Analisi dei dati), fare clic su Plate Setup (Impostazione piastra) e
quindi selezionare una delle seguenti opzioni:

n Edit/View Plate (Modifica/visualizza piastra): apre l’editor piastra in cui è possibile
apportare modifiche manuali alla disposizione.

n Replace Plate File (Sostituisci file piastra): apre il browser Select Plate (Seleziona
piastra) in cui è possibile navigare fino ad un file piastra precedentemente salvato con cui
sostituire la disposizione della piastra attuale.
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n Replace PrimePCR File (Sostituisci file PrimePCR): apre la finestra di dialogo Select
PrimePCR file (Seleziona file PrimePCR) in cui è possibile navigare fino a un file di analisi
PrimePCR™ e applicarlo alla disposizione della piastra.

Suggerimento: Si possono aggiungere o modificare le informazioni sul contenuto del pozzetto
prima o durante un’analisi oppure dopo che è terminata l’analisi PCR. Occorre assegnare la
modalità di analisi e la dimensione della piastra prima dell’analisi. Tali parametri non possono
cambiare dopo l’analisi.
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Impostazioni dell’analisi dei dati
I dati del grafico Amplification (Amplificazione) nella scheda Quantification (Quantificazione) mostrano
la fluorescenza relativa (in RFU) per ciascun pozzetto ad ogni ciclo. Ogni traccia presente nel grafico
rappresenta i dati di un singolo fluoroforo in ciascun pozzetto. Questi dati vengono utilizzati per
determinare i valori Cq per ogni pozzetto sulla base di ciascun fluoroforo. Il software utilizza una delle
due modalità per determinare i valori Cq:

n Regression (Regressione): applica un modello di regressione non lineare multivariabile alle
singole tracce dei pozzetti e poi utilizza tale modello per calcolare un valore Cq ottimale.

n Single Threshold (Soglia singola): utilizza un valore singolo di soglia per calcolare il valore Cq
in base al punto di incrocio della soglia delle singole tracce della fluorescenza.

Per scegliere la modalità di determinazione Cq, selezionare Settings > Cq Determination Mode
(Impostazioni > Modalità di determinazione Cq).

Regolazione della soglia
Nella modalità Single Threshold (Soglia singola), è possibile regolare la soglia per un fluoroforo
facendo clic sulla linea di soglia nel grafico di amplificazione e spostando il cursore del mouse in
verticale. In alternativa, è possibile specificare una soglia di attraversamento esatto per il fluoroforo
selezionato.

Impostazioni della linea basale
Il software imposta automaticamente la linea basale per ogni singolo pozzetto. L’impostazione della
linea basale determina il metodo della sottrazione della linea basale per tutte le tracce di fluorescenza.
Il software fornisce tre opzioni di sottrazione della linea basale:

n No Baseline Subtraction (Nessuna sottrazione linea basale): visualizza i dati come tracce di
fluorescenza relativa. Alcune analisi non sono possibili in questa modalità di analisi e, pertanto, il
software non visualizza le schede Gene Expression (Espressione genica), End Point (Punto
finale) e Allelic Discrimination (Discriminazione allelica).

n Baseline Subtracted (Linea basale sottratta): visualizza i dati come tracce sottratte della linea
basale per ciascun fluoroforo in un pozzetto. Il software deve eseguire la sottrazione della linea
basale per i dati, al fine di determinare i cicli di quantificazione, costruire curve standard e
determinare la concentrazione di campioni sconosciuti. Per generare una traccia sottratta della
linea basale, il software adatta la migliore linea diritta attraverso la fluorescenza registrata di
ciascun pozzetto durante i cicli della linea basale, quindi sottrae i migliori dati di adattamento dai
dati software di fondo in ciascuna ciclo.
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n Baseline Subtracted Curve Fit (Adattamento curva sottratta per linea basale): visualizza i
dati come tracce sottratte della linea basale e il software rende uniforme la curva sottratta della
linea basale usando un filtro di media centrato. Questo processo viene eseguito in modo che
ciascuna Cq rimanga invariante.

Oltre a queste opzioni, è possibile anche selezionare Apply Fluorescent Drift Correction (Applica
correzione deriva fluorescente). Per i pozzetti che hanno valori RFU in deriva in modo anomalo, durante i
pochi cicli iniziali di un’analisi, il software deriva una linea basale stimata dai pozzetti vicini per i quali è
stata correttamente generata una linea basale orizzontale.

Per cambiare l’impostazione della sottrazione della linea basale

u Selezionare Settings > Baseline Setting (Impostazioni > Impostazione linea basale).

Modalità di analisi
I dati possono essere raggruppati e analizzati tramite fluoroforo o nome target. Quando raggruppati per
fluoroforo, le tracce dei dati vengono visualizzate tramite fluoroforo come indicato nell’impostazione della
piastra per tale analisi. I dati del singolo fluoroforo sono visualizzati nel grafico di amplificazione e della
curva standard (se disponibile) quando vengono selezionate le caselle di controllo appropriate del
selettore di fluoroforo, che si trovano sotto il grafico di amplificazione.

Quando raggruppati per target, le tracce dei dati vengono visualizzate tramite nome target come
inserito nell’impostazione della piastra per tale analisi.
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Per scegliere una modalità di analisi dei dati

u Eseguire una delle seguenti operazioni:

n Selezionare Settings > Analysis Mode (Impostazioni > Modalità di analisi).

n Scegliere una modalità dal menu a discesa Analysis Mode (Modalità di analisi) nella barra
degli strumenti.

Cicli da analizzare
È possibile limitare il numero di cicli da analizzare. È possibile analizzare i dati anche da una
determinata serie di cicli. Il numero massimo di cicli che è possibile analizzare è 50.

Nota: La rimozione dei cicli dall’inizio di un’analisi può avere un impatto significativo sul
baselining.

Per limitare l’analisi dei dati ad una determinata gamma di cicli

1. Selezionare Select Settings > Cycles to Analyze (Seleziona impostazioni > Cicli da analizzare).

Appare la finestra di dialogo Cycles to Analyze (Cicli da analizzare).

2. Immettere i valori del ciclo di inizio e del ciclo di fine e quindi fare clic su OK.

Per tornare ai cicli inizialmente usati per l’analisi, fare clic su Restore Defaults (Ripristina valori
predefiniti) nella finestra di dialogo Cycles to Analyze (Cicli da analizzare).
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Selettore pozzetto
Utilizzare il selettore pozzetto per visualizzare o nascondere i dati del pozzetto nei grafici o nei fogli di
calcolo in tutta la finestra Data Analysis (Analisi dei dati). Nel selettore pozzetto possono essere
selezionati solo i pozzetti caricati con il campione. Il software colora i pozzetti nel selettore pozzetto:

n Blu: indica i pozzetti selezionati. I dati dei pozzetti selezionati sono visualizzati nella finestra Data
Analysis (Analisi dei dati).

n Grigio chiaro: indica i pozzetti deselezionati. I dati dei pozzetti deselezionati sono visualizzati
nella finestra Data Analysis (Analisi dei dati).

n Grigio scuro: indica i pozzetti vuoti.

Per visualizzare o nascondere i dati del pozzetto

u Nel selettore pozzetto, eseguire una delle seguenti operazioni:

n Per nascondere un pozzetto, fare clic sul singolo pozzetto. Per visualizzare quel pozzetto,
fare di nuovo clic sul pozzetto.

n Per nascondere più pozzetti, trascinare il cursore sui pozzetti che si intende selezionare. Per
visualizzare tali pozzetti, trascinare di nuovo il cursore su tali pozzetti.

n Fare clic in alto a sinistra della piastra per nascondere tutti i pozzetti. Fare di nuovo clic in alto
a destra per visualizzare tutti i pozzetti.
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n Fare clic sull’inizio di una colonna o riga per nascondere tali pozzetti. Fare di nuovo clic sulla
colonna o riga per visualizzare di nuovo i pozzetti.

Voci del menu del pulsante destro del mouse del selettore
pozzetto
La Tabella 17 elenca le opzioni selezionabili con il pulsante destro del mouse, disponibili nella vista del
selettore pozzetto.

Voce Funzione

Well XX (Pozzetto XX) Visualizza solo questo pozzetto, rimuove questo pozzetto dalla
vista, imposta il colore per questo pozzetto o esclude questo
pozzetto dall’analisi.

Selected Wells (Pozzetti
selezionati) (facendo clic con il
pulsante destro del mouse e
trascinando il cursore)

Visualizza solo questi pozzetti, rimuove questi pozzetti dalla vista,
imposta il colore per questi pozzetti o esclude questi pozzetti
dall’analisi.

Copy (Copia) Compia il contenuto del pozzetto negli appunti, incluso il tipo di
campione e il N. replicato.

Copy as Image (Copia come
immagine)

Copia la vista del selettore pozzetto come immagine.

Print (Stampa) Stampa la visualizzazione del selettore pozzetto.

Print Selection (Stampa
selezione)

Stampa la selezione corrente.

Export to Excel (Esporta in
Excel)

Esporta i dati in un foglio di calcolo Excel.

Export to Csv (Esporta in csv) Esporta i dati come documento di testo.

Export to Xml (Esporta in xml) Esporta i dati come documento .xml.

Well Labels (Etichette pozzetto) Cambia le etichette pozzetto con Sample Type (Tipo di campione),
Target Name (Nome target) o Sample Name (Nome campione).

Tabella 17. Voci del menu del pulsante destro del mouse nei selettori pozzetto
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Esclusione provvisoria di pozzetti dall’analisi
Per escludere provvisoriamente pozzetti dall’analisi dei dati

1. Fare clic con il pulsante destro del mouse sul pozzetto nel selettore pozzetto. Per escludere più
pozzetti, fare clic con il pulsante destro del mouse e trascinare il cursore per evidenziare più
pozzetti, tracce o punti.

2. Dal menu del pulsante destro del mouse, scegliere l’opzione desiderata:

n Well > Exclude Well (Pozzetto > Escludi pozzetto)

n Selected Wells > Exclude from Analysis (Pozzetti selezionati > Escludi da analisi)

n Selected Traces > Exclude these wells from Analysis (Tracce selezionate > Escludi questi
pozzetti dall’analisi)

In alternativa, per rimuovere provvisoriamente i pozzetti dall’analisi, eliminare l’intero contenuto
dei pozzetti nell’editor piastra facendo clic sul pulsante Clear Wells (Cancella pozzetti).

Importante: Occorre immettere di nuovo il contenuto di ogni pozzetto che è stato cancellato.

Per includere un pozzetto escluso

u Con il pulsante destro del mouse fare clic sul pozzetto desiderato nel selettore pozzetto e
selezionare Well > Include Well in Analysis (Pozzetto > Includi pozzetto nell’analisi).
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Grafici
Ogni grafico nella finestra Data Analysis (Analisi dei dati) visualizza i dati in un grafico diverso e
include opzioni che consentono di regolare ed esportare i dati o i grafici.

Voci comuni del menu del pulsante destro del mouse per i
grafici
La Tabella 18 elenca le voci del menu selezionabili con il pulsante destro del mouse che sono
disponibili nei grafici. Alcune delle voci disponibili sono presenti per tutti i grafici e queste voci possono
essere usate per cambiare il modo in cui vengono visualizzati i dati o per esportare facilmente i dati da
un grafico.

Voce Funzione

Copy (Copia) Copia il grafico negli appunti.

Save Image As (Salva
immagine con nome)

Salva l’immagine con una dimensione, risoluzione e tipo di file
specificati. I formati immagine disponibili sono PNG (predefinito), JPG e
BMP.

Page Setup (Impostazione
pagina)

Visualizza in anteprima e seleziona le impostazioni di una pagina per la
stampa.

Print (Stampa) Stampa il grafico.

Set Scale to Default
(Imposta scala su
predefinito)

Riporta il grafico alla sua visualizzazione predefinita dopo averlo
ingrandito.

Chart Options (Opzioni
grafico)

Apre la finestra Chart Options (Opzioni grafico) per cambiare il grafico,
ad esempio cambiando il titolo, selezionando i limiti per gli assi x e y,
mostrando le linee della griglia e i simboli di spunta più piccoli negli assi.

Tabella 18. Voci del menu del pulsante destro del mouse per i grafici

Nota: Gli elementi del menu che si applicano a determinati grafici sono descritti nel Capitolo 10,
Dettagli dell’analisi dei dati.
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Copia dei dati del grafico negli appunti
È possibile copiare il contenuto della vista a grafico e incollarlo in qualsiasi applicazione che accetti file
immagine bitmap.

Per copiare i dati del grafico negli appunti

1. Dal menu del pulsante destro del mouse per il grafico, selezionare Copy (Copia) .

2. Aprire un’applicazione che accetti immagini bitmap, ad esempio Microsoft Word.

3. Fare clic con il pulsante destro del mouse e selezionare Paste (Incolla) per incollare l’immagine
bitmap dagli appunti nell’applicazione.

Modifica delle impostazioni della soglia della linea basale
Nella modalità Single Threshold (Soglia singola), è possibile regolare la soglia per un fluoroforo
facendo clic sulla linea di soglia nel grafico di amplificazione e spostando il cursore del mouse in
verticale. In alternativa, è possibile specificare una soglia di attraversamento esatto per il fluoroforo
selezionato.

Suggerimento: È possibile precisare un intervallo di cicli per determinare la linea basale per tutti
i file di dati nella scheda Data Analysis (Analisi dei dati) in User > User Preferences (Utente >
Preferenze utente).

Per regolare il ciclo di inizio e di fine della linea basale per ciascun pozzetto

1. Nella scheda Quantification (Quantificazione), selezionare un singolo fluoroforo sotto il grafico di
amplificazione.

2. Dal menu del pulsante destro del mouse per il del grafico, selezionare Baseline Threshold (Soglia
linea basale).

Appare la finestra di dialogo Baseline Threshold (Soglia linea basale).
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3. Nella sezione Baseline Cycles (Cicli linea basale), eseguire una delle seguenti operazioni:

n Per selezionare un pozzetto, fare clic sul rispettivo numero di riga.

n Per selezionare più pozzetti vicini, fare clic sul numero di riga del primo pozzetto e trascinare
in basso la colonna fino all’ultimo pozzetto.

n Per selezionare più pozzetti non vicini, premere il tasto Control (Ctrl) e fare clic sul numero di
riga di ciascun pozzetto target.

n Per selezionare tutti i pozzetti, fare clic in alto a sinistra sulla tabella.

4. Regolare il Baseline Begin cycle (Ciclo di inizio linea basale) e il Baseline End cycle (Ciclo di fine
linea basale) per tutti i pozzetti selezionati oppure modificare il numero del ciclo di inizio e di fine
nella parte inferiore del foglio di calcolo.

Suggerimento: Per ripristinare gli ultimi valori salvati delle impostazioni, fare clic su Reset
All User Defined Values (Ripristina tutti i valori definiti dall’utente).

5. Fare clic su OK per salvare le modifiche e tornare al grafico.

Per precisare un intervallo di cicli per tutti i file

u Nella finestra Home (Home) o nella finestra Plate Editor (Editor piastra), selezionare User > User
Preferences (Utente > Preferenze utente) e scegliere la scheda Data Analysis (Analisi dei dati).
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Ordinamento dei dati del target e del campione
Nota: Questa opzione è disponibile solo nei grafici dell’espressione genica.

Per impostazione predefinita, gli elenchi dei target e dei campioni sono visualizzati in ordine
alfabetico. Usare la finestra di dialogo Sort (Ordina) per ordinare la visualizzazione in ordine alfabetico
inverso o per spostare manualmente un termine in un’altra posizione dell’elenco.

Per ordinare i dati del target e del campione

1. Dal menu del pulsante destro del mouse per il grafico, fare clic su Sort (Ordina).

Viene visualizzata la finestra di dialogo Gene Expression Chart Sorting (Ordine del grafico
dell’espressione genica).

2. Nella finestra di dialogo, fare clic su Z-A per ordinare l’elenco nell’ordine alfabetico inverso.

3. Per spostare un termine manualmente, selezionarlo e fare clic sul pulsante appropriato tra i
grafici:

n Fare clic sulla freccia su o giù per spostare il termine selezionato di una posizione.

n Fare clic sulla freccia della barra su o giù per spostare il termine selezionato in alto o in basso
nell’elenco.

4. Fare clic su OK per salvare le modifiche e tornare alla scheda Gene Expression (Espressione
genica).
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Ingrandimento di un’area nel grafico
Per ingrandire un’area del grafico

u Fare clic e trascinare il grafico e quindi fare clic su Zoom*. Il software ridimensiona il grafico e lo
centra sull’area selezionata.

Nota: * Il grafico a barre non richiede l’uso del comando popup Zoom.

Per ripristinare la visualizzazione completa

u Fare clic con il pulsante destro del mouse nel grafico e selezionare Set Scale to Default (Imposta
scala su predefinito).

Copia di grafici in un file Microsoft
È possibile copiare i grafici con dati in documenti Microsoft Word, Excel o PowerPoint. La risoluzione
dell’immagine corrisponde a quella della schermata da cui è stata ottenuta l’immagine

Per copiare i grafici in un file Microsoft

1. Nella finestra Data Analysis (Analisi dei dati), selezionare Copy (Copia) dal menu del pulsante
destro del mouse del grafico.

2. Aprire un file Microsoft vuoto e incollare il contenuto dagli appunti.

Alternativa: fare clic sull’icona e trascinare il grafico in un file Microsoft.
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Fogli di calcolo
I fogli di calcolo visualizzati in Data Analysis (Analisi dei dati) includono opzioni per l’ordinamento e il
trasferimento dei dati. Ordinare le colonne in base ad uno dei seguenti metodi:

n Fare clic e trascinare una colonna in una nuova posizione nella tabella selezionata.

n Fare clic sull'intestazione della colonna per ordinare i dati in ordine crescente e decrescente.

Per ordinare fino a tre colonne di dati nella finestra Sort (Ordina)

1. Fare clic con il pulsante destro del mouse sul foglio di calcolo e selezionare Sort (Ordina).

2. Nella finestra di dialogo Sort (Ordina), selezionare il primo titolo colonna da ordinare. Ordinare i
dati in ordine crescente e decrescente.

3. Selezionare una seconda o terza colonna da ordinare e scegliere Ascending (Crescente) o
Descending (Decrescente).

4. Fare clic su OK (OK) per ordinare i dati oppure fare clic su Cancel (Annulla) per arrestare
l’ordinamento.

Evidenziare i dati sui grafici associati e sul selettore del pozzetto mantenendo il cursore del mouse su
una cella. Fare clic in una cella per copiare e incollare il suo contenuto in un altro programma software.

Voci comuni del menu del pulsante destro del mouse per i fogli
di calcolo
La Tabella 19 elenca le voci del menu del pulsante destro del mouse in una qualunque vista del foglio
di calcolo.

Voce Funzione

Copy (Copia) Copia il contenuto dei pozzetti selezionati negli appunti, quindi lo
incolla in un foglio di calcolo come Excel.

Copy as Image (Copia come
immagine)

Copia la vista del foglio di calcolo come file di immagine e la incolla
in un file che accetta un file di immagine, come ad esempio i file di
testo, di immagine o di foglio di calcolo.

Print (Stampa) Stampa la visualizzazione corrente.

Tabella 19. Voci del menu del pulsante destro del mouse per i fogli di calcolo
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Voce Funzione

Print Selection (Stampa
selezione)

Stampa la selezione corrente.

Export to Excel (Esporta in
Excel)

Esporta i dati in un foglio di calcolo Excel.

Export to CSV (Esporta in CSV) Esporta i dati in un file con valori delimitati da virgole (.csv).

Export to Xml (Esporta in xml) Esporta i dati in un file xml.

Export to Html (Esporta in html) Esporta i dati in un file html.

Find (Trova) Cerca un testo.

Sort (Ordina) Ordina i dati selezionando fino a tre colonne.

Select Columns (Seleziona
colonne)

Seleziona le colonne che saranno visualizzate nel foglio di calcolo.

Tabella 19. Voci del menu del pulsante destro del mouse per i fogli di calcolo, continua
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Esportazione
Il Software CFX Manager Dx offre quattro opzioni di esportazione dal menu a discesa Export
(Esporta):

n Export All Data Sheets (Esporta tutti i fogli dati in Excel)

n Custom Export (Personalizza esportazione)

n Export to LIMS (Esporta in LIMS)

n Seegene Export (Esportazione per Seegene)

Esportazione di tutte le schede di dati
È possibile esportare tutte le viste dei fogli di calcolo da ogni scheda del Software CFX Manager Dx in
singoli file.

Per esportare tutte le schede di dati

u Selezionare Export > Export All Data Sheets (Esporta > Esporta tutte le schede dati).

n CSV (*.csv)

n Testo (*.txt)

n Excel 2007 (*.xlsx)

n Excel 2003 (*.xls)

n XML (*.xml)
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Creazione di un file di esportazione personalizzato
Per creare un file di esportazione personalizzato

1. Selezionare Export > Custom Export (Esporta > Esportazione personalizzata). Si apre la finestra
di dialogo Custom Export (Esportazione personalizzata).

2. Selezionare il formato di esportazione dall’elenco a discesa che viene visualizzato.

3. Selezionare le caselle di controllo per gli elementi da esportare.

4. (Facoltativo) Fare clic su Customize Column Names (Personalizza nomi colonna) per cambiare i
nomi delle colonne.

5. Fare clic su Export (Esporta). Viene visualizzata la finestra di dialogo Save As (Salva con nome).

6. Nella finestra di dialogo Save As (Salva con nome), specificare un nome file e la posizione in cui
salvare il file esportato.

7. Fare clic su OK per salvare il file di esportazione.
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Esportazione in una cartella LIMS
È possibile esportare i dati in un formato file compatibile con LIMS.

Per esportare i dati in formato LIMS

1. Selezionare Export > Export to LIMS Folder (Esporta > Esporta nella cartella LIMS).

Viene visualizzata la finestra di dialogo Save As (Salva con nome).

2. Nella finestra di dialogo Save As (Salva con nome), specificare un nome file e la posizione in cui
salvare il file esportato.

3. Fare clic su OK per salvare il file di esportazione.

Esportazione dei dati con formattazione Seegene
È possibile esportare i dati da tutte le viste dei fogli di calcolo in file Excel strutturati specificamente per
l’uso da parte di Seegene, Inc.

Per esportare i dati nello specifico formato Seegene

1. Selezionare Export > Seegene Export (Esporta > Esportazione Seegene).

Viene visualizzata la finestra di dialogo Save As (Salva con nome).

2. Nella finestra di dialogo Save As (Salva con nome), specificare la posizione di una cartella in cui
salvare i file Excel con formattazione Seegene (.xlsx) esportati.

3. Fare clic su OK per salvare i file di esportazione.
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Capitolo 10 Dettagli dell’analisi dei dati
Nella finestra Data Analysis (Analisi dei dati) del software CFX Manager™ Dx sono incluse più schede
da cui è possibile visualizzare i dati. Il presente capitolo spiega nel dettaglio tali schede.

Suggerimento: È possibile scegliere quali schede visualizzare nella finestra Data Analysis
(Analisi dei dati) utilizzando il menu View (Visualizza). Il layout personalizzato viene salvato nel
file di dati.
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Scheda Quantification (Quantificazione)
Utilizzare i dati della scheda Quantification (Quantificazione) per impostare le condizioni di analisi dei
dati, tra cui le impostazioni della linea basale per i singoli pozzetti e le impostazioni di soglia. La
scheda Quantification (Quantificazione) visualizza i dati in queste quattro rappresentazioni:

n Grafico di amplificazione: visualizza le unità di fluorescenza relativa (RFU) per ciascun pozzetto
in ogni ciclo. Ogni traccia presente nel grafico rappresenta i dati di un singolo fluoroforo in ciascun
pozzetto.

n Curva standard: appare solo se l’analisi include pozzetti indicati come standard per il tipo di
campione (Std). La curva standard visualizza il ciclo di soglia tracciato sul registro della quantità
iniziale. La legenda visualizza l’efficacia della reazione (E) per ciascun fluoroforo nei pozzetti con
un tipo di campione standard.

n Selettore pozzetto: seleziona i pozzetti con i dati della fluorescenza che si desidera mostrare.

n Foglio di calcolo: visualizza un foglio di calcolo dei dati raccolti nei pozzetti selezionati.

Opzioni fluoroforo
Per visualizzare i dati del fluoroforo nei grafici e nei fogli di calcolo della scheda Quantification
(Quantificazione), selezionare i fluorofori target sotto il grafico di amplificazione. Per nascondere i dati
del fluoroforo nella finestra Data Analysis (Analisi dei dati), deselezionare la relativa casella di
controllo.
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Scheda Quantification (Quantificazione)

Finestra di dialogo Trace Styles (Stili traccia)
Utilizzando la finestra di dialogo Trace Styles (Stili traccia) è possibile modificare l’aspetto delle tracce
nei grafici di amplificazione e curva di fusione delle schede Quantification (Quantificazione) e Melt
Curve (Curva di fusione). È possibile poi visualizzare in anteprima le modifiche nel selettore pozzetto
che appare nella finestra di dialogo Trace Styles (Stili traccia).

Modifica degli stili traccia

1. Selezionare un unico fluoroforo nel grafico di amplificazione.

2. Per aprire la finestra di dialogo Trace Styles (Stili traccia), eseguire una delle seguenti operazioni:

n Fare clic su Trace Styles (Stili traccia) nel grafico di amplificazione.

n Selezionare Settings > Trace Styles (Impostazioni > Stili traccia) nella barra dei menu Data
Analysis (Analisi dei dati).

n Fare clic con il pulsante destro del mouse e selezionare Trace Styles (Stili traccia).

Viene visualizzata la finestra di dialogo Trace Styles (Stili traccia).

3. Nella finestra di dialogo Trace Styles (Stili traccia), selezionare un gruppo di pozzetti specifico nel
selettore pozzetto nel riquadro inferiore. In alternativa, selezionare i pozzetti che contengono un
tipo di campione nel menu a discesa nella colonnaWells (Pozzetti).

4. Eseguire una delle seguenti operazioni:
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n Per scegliere un colore per i pozzetti selezionati, fare clic sulla casella nella colonna Color
(Colore).

n Per assegnare un simbolo ai pozzetti selezionati, selezionare un simbolo dal menu a discesa
Symbol (Simbolo).

n Per colorare velocemente i pozzetti dall’etichetta pulsante, fare clic sul set di selezione
rapida appropriato:

o Random byWell (Casuale in base al pozzetto)

o Random by Replicate (Casuale in base al replicato)

o Use Fluor Colors (Utilizza colori fluoroforo)

o Use Target Colors (Utilizza colori target)

o Use Sample Colors (Utilizza colori campione)

n Per assegnare le etichette pozzetto, scegliere Sample Type (Tipo campione), Target Name
(Nome target), Sample Name (Nome campione) o Symbol (Simbolo).

Opzione Log Scale (Scala logaritmica)
Selezionare Log Scale (Scala logaritmica) sotto il grafico Amplification (Amplificazione) per
visualizzare le tracce della fluorescenza in una scala semilogaritmica:

Suggerimento: Per ingrandire un’area del grafico, trascinare il cursore sull’area desiderata. Per
tornare alla visualizzazione completa, fare clic sul grafico con il pulsante destro del mouse e
selezionare Set Scale to Default (Imposta scala predefinita).
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Grafico della curva standard
Il software crea un grafico della curva standard nella scheda Quantification (Quantificazione), se i dati
includono i tipi di campione definiti come Std per almeno un fluoroforo nell’analisi.

Nel grafico della curva standard sono visualizzate le seguenti informazioni:

n Nome per ciascuna curva (il fluoroforo o il target).

n Il colore di ogni fluoroforo o target.

n L’efficacia della reazione (E). Utilizzare questa statistica per ottimizzare una reazione multiplex e
per livellare i dati per una curva standard.

Nota: L’efficacia della reazione descrive come viene prodotto il target con ogni ciclo del
protocollo. Un’efficacia del 100% indica che si sta doppiando il target con ogni ciclo.

n Coefficiente di determinazione, R2 (scritto come R^2). Utilizzare questa statistica per determinare
il livello di correttezza della descrizione dei dati da parte della linea (bontà di adattamento).

n Pendenza

n Intercetta y
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Opzioni del menu del grafico di amplificazione
Oltre alle comuni opzioni del menu selezionabili con il pulsante destro del mouse per i grafici (fare
riferimento a Voci comuni del menu del pulsante destro del mouse per i grafici a pagina 185), la Tabella 20
elenca le opzioni di menu disponibili solo per il grafico di amplificazione.

Nota: Il grafico della curva standard fornisce solo le opzioni di menu comuni selezionabili con il
pulsante destro.

Opzione del menu Funzione

Show Threshold Values (Mostra
valori soglia)

Visualizza il valore della soglia per ogni curva di amplificazione nel
grafico.

Trace Styles (Stili traccia) Apre la finestra Trace Styles (Stili traccia) per modificare gli stili
delle tracce che appaiono nelle tabelle Quantification
(Quantificazione) e Melt Curve (Curva di fusione).

Baseline Thresholds (Soglie
linea basale)

Apre la finestra Baseline Thresholds (Soglie linea basale) per
modificare la linea basale o le soglie di ogni fluoroforo (le
modifiche sono visualizzate nel grafico di amplificazione nella
scheda Quantification (Quantificazione)).

Tabella 20. Elementi del menu selezionabili con il pulsante destro e sinistro nel grafico di
amplificazione

Foglio di calcolo della scheda Quantification (Quantificazione)
Nella Tabella 21 sono definiti i dati visualizzati nel foglio di calcolo della scheda Quantification
(Quantificazione).

Informazioni Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Target (Target) Nome target caricato nei pozzetti dell’editor piastra

Content (Contenuto) Una combinazione di tipo campione (obbligatorio) e N. replicato
(facoltativo) caricati nell’editor piastra

Sample (Campione) Nome campione caricato nei pozzetti dell’editor piastra

Cq Ciclo di quantificazione per ciascuna traccia

Tabella 21. Contenuto del foglio di calcolo della scheda Quantification (Quantificazione)
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Modifica dei dati del target, del contenuto o del campione

È possibile cambiare i dati nelle colonne Target (Target), Content (Contenuto) e Sample (Campione)
modificando il file piastra mediante l’editor piastra anche dopo aver eseguito l’esperimento.

Per cambiare i dati nelle colonne Content (Contenuto), Target (Target) e Sample
(Campione)

u Fare clic su Plate Setup (Impostazione piastra) e selezionare View/Edit Plate (Visualizza/Modifica
piastra) per aprire l’editor piastra.
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Scheda Quantification Data (Dati di quantificazione)
La scheda Quantification Data (Dati di quantificazione) visualizza i dati di quantificazione raccolti in
ogni pozzetto. Il Software CFX Manager Dx visualizza i dati in quattro differenti viste foglio di calcolo:

n Results (Risultati): visualizza un foglio di calcolo dei dati. Questa è la vista predefinita.

n Standard Curve Results (Risultati curva standard): visualizza un foglio di calcolo dei dati della
curva standard.

n Plate (Piastra): visualizza i dati in ciascun pozzetto come una mappa pozzetto.

n RFU: visualizza le quantità RFU in ciascun pozzetto per ogni ciclo.

Selezionare ogni foglio di calcolo dall’elenco a discesa che è visualizzato sotto la scheda
Quantification Data (Dati di quantificazione).

Foglio di calcolo Results (Risultati)
Nel foglio di calcolo Results (Risultati) sono visualizzati i dati di ciascun pozzetto della piastra.

Nota: Tutti i calcoli della deviazione standard sono validi per i gruppi di replicati assegnati nei
pozzetti della finestra Plate Editor (Editor piastra). I calcoli stabiliscono la media del valore Cq per
ciascun pozzetto presente nel gruppo di replicati.

La Tabella 22 definisce i dati visualizzati nel foglio di calcolo Results (Risultati).
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Scheda Quantification Data (Dati di quantificazione)

Informazioni Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Target (Target) Nome del target di amplificazione (gene)

Content (Contenuto) Tipo di campione e n. di replicati

Sample (Campione) Descrizione del campione

Biological Set Name (Nome set
biologico)

Nome del set biologico

Cq Ciclo di quantificazione

CqMean (Media Cq) Media del ciclo di quantificazione per il gruppo di replicati

Cq Std. Dev (Dev. std. Cq) Deviazione standard del ciclo di quantificazione per il gruppo di
replicati

Starting Quantity (SQ, Quantità
iniziale)

Stima della quantità iniziale del target

Log Starting Quantity (Registro
quantità iniziale)

Registro della quantità iniziale

SQMean (Media SQ) Media della quantità iniziale

SQ Std. Dev (Dev. std. SQ) Deviazione standard della quantità iniziale nei replicati

Tabella 22. Contenuto del foglio di calcolo dei risultati
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Foglio di calcolo dei risultati della curva standard
Il foglio di calcolo dei risultati della curva standard mostra i parametri calcolati per la curva standard.

La Tabella 23 definisce i dati visualizzati sul foglio di calcolo per i risultati della curva standard.

Informazioni Descrizione

Fluor (or Target) (Fluoroforo (o
Target))

Fluoroforo (o Target) rilevato

Efficiency (%) (Efficacia %) Efficacia della reazione

Slope (Pendenza) Pendenza della curva standard.

Y-intercept (Intercetta y) Punto nel quale la curva intercetta l’asse y

R^2 Coefficiente di determinazione

Tabella 23. Contenuto del foglio di calcolo dei risultati della curva standard
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Scheda Quantification Data (Dati di quantificazione)

Foglio di calcolo della piastra
Il foglio di calcolo della piastra visualizza una mappa delle piastre con i dati di un fluoroforo alla volta.

Per visualizzare i dati di un determinato fluoroforo

u Fare clic sulla scheda in fondo al foglio di calcolo.

Foglio di calcolo RFU
Nel foglio di calcolo RFU sono visualizzate le letture in unità di fluorescenza relativa (RFU) di ogni
pozzetto, acquisite durante ciascun ciclo dell’analisi. Il numero del pozzetto appare in cima a ciascuna
colonna e il numero del ciclo appare a sinistra di ogni riga.
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Scheda Melt Curve (Curva di fusione)
Esclusione di responsabilità: non sono concessi diritti da parte di Bio-Rad per l’utilizzo delle analisi
della curva di fusione in analisi di fusione ad alta risoluzione, nel campo della diagnostica in vitro per
uso umano e veterinario. Inoltre, è responsabilità dell’acquirente acquisire i diritti di proprietà
intellettuale che potrebbero essere necessari per la sua applicazione specifica.

Per coloranti leganti il DNA e sonde di ibridazione non divisibili, la fluorescenza è più brillante quando i
due filamenti di DNA si appaiano. Tuttavia, se la temperatura aumenta verso la temperatura di fusione
(Tm), la fluorescenza diminuisce ad una velocità costante (pendenza costante). Alla Tm c’è una
riduzione considerevole della fluorescenza con una variazione considerevole della pendenza. Il tasso
di questa variazione è determinato tracciando la prima regressione negativa della fluorescenza
rispetto alla temperatura (-d(RFU)/dT). Il tasso di variazione più elevato della fluorescenza determina
picchi visibili e rappresenta la Tm dei complessi di DNA a doppia elica.

Il Software CFX Manager Dx traccia i dati RFU raccolti durante una curva di fusione in funzione della
temperatura. Per analizzare i dati del picco di fusione, il software assegna ad ogni picco una
temperatura iniziale e finale muovendo la barra della soglia. Il piano dell’area del picco è specificato
dalla posizione della barra della soglia di fusione. Un picco valido deve avere un’altezza minima
correlata alla distanza tra la barra della soglia e l’altezza del picco più alto.

La scheda Melt Curve (Curva di fusione) visualizza la Tm (temperatura di fusione) dei prodotti PCR
amplificati, in quattro visualizzazioni:

n Melt Curve (Curva di fusione): visualizza i dati in tempo reale per ogni fluoroforo come unità RFU
per temperatura per ogni pozzetto.

n Melt Peak (Picco di fusione): visualizza la regressione negativa dei dati RFU per temperatura per
ogni pozzetto.

n Well selector (Selettore pozzetto): visualizza i pozzetti per i quali mostrare o nascondere i dati.

n Peak spreadsheet (Foglio di calcolo picco): visualizza i dati raccolti nel pozzetto selezionato.

Nota: Questo foglio di calcolo visualizza fino a due picchi per ogni traccia. Per visualizzare
più picchi, fare clic sulla scheda Melt Curve Data (Dati curva di fusione).
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Scheda Melt Curve (Curva di fusione)

La Tabella 24 a pagina 207 definisce i dati che vengono visualizzati nel foglio di calcolo della curva di
fusione.

Informazioni Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Content (Contenuto) Una combinazione di tipo di campione e numero del
replicato

Sample (Campione) Nome del campione caricato nell’editor piastra.

Melt Temp (Temperatura di fusione) La temperatura del picco di fusione per ogni pozzetto

Nota: Il foglio di calcolo contiene solo i due picchi
più alti.

Tabella 24. Contenuti del foglio di calcolo della curva di fusione
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Correzione dei dati della curva di fusione
Per correggere i dati della curva di fusione

u Eseguire una delle seguenti operazioni:

n Fare clic e trascinare le barre soglia nel grafico Melt Peak (Picco di fusione) per includere o
escludere i picchi nell’analisi dei dati.

n Selezionare Positive (Positivo), nel menu a discesa Peaks (Picchi), per visualizzare i dati del
foglio di calcolo per i picchi al di sopra della linea della soglia di fusione oppure selezionare
Negative (Negativo) per visualizzare i dati del foglio di calcolo per i picchi al di sotto della
linea della soglia di fusione.

n Aprire la finestra Trace Styles (Stili traccia) per cambiare il colore delle tracce nei grafici Melt
Curve (Curva di fusione) e Melt Peak (Picco di fusione).

n Selezionare un numero nel selettore Step Number (Numero fase) per visualizzare i dati della
curva di fusione in un’altra fase del protocollo. L’elenco mostra più di una fase se il protocollo
include letture piastra in più di una fase della curva di fusione.

n Selezionare i pozzetti nel selettore pozzetto per focalizzare i sottoinsiemi dei dati.

n Selezionare un gruppo di pozzetti per visualizzare e analizzare un sottoinsieme dei pozzetti
nella piastra. Nel menu a discesa Well Group (Gruppo di pozzetti) presente nella barra degli
strumenti, selezionare ogni gruppo di pozzetti per nome.
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Scheda Melt Curve Data (Dati curva di fusione)
La scheda Melt Curve Data (Dati curva di fusione) visualizza i dati della scheda Melt Curve (Curva di
fusione) in più fogli di calcolo che includono tutti i picchi di fusione per ciascuna traccia. offre quattro
opzioni di foglio di calcolo in cui visualizzare i dati della curva di fusione:

n Melt Peaks (Picchi di fusione): visualizza tutti dati, compresi tutti i picchi di fusione, per ciascuna
traccia. Questa è la vista predefinita.

n Plate (Piastra): visualizza una vista dei dati e il contenuto di ciascun pozzetto nella piastra.

n RFU (RFU): visualizza le quantità RFU a ciascuna temperatura per ciascun pozzetto.

n -d(RFU)/dT (-d(RFU)/dT): visualizza il tasso di variazione negativo in RFU quando cambia la
temperatura (T). Si tratta di un primo grafico di regressione per ciascun pozzetto nella piastra.

Selezionare ogni foglio di calcolo dall’elenco a discesa che è visualizzato sotto la scheda Melt Curve
Data (Dati curva di fusione).

Foglio di calcolo dei picchi di fusione
Il foglio di calcolo dei picchi di fusione visualizza tutti i dati della curva di fusione.

La Tabella 25 a pagina 210 definisce i dati che vengono visualizzati nel foglio di calcolo dei picchi di
fusione.

Manuale operativo | 209



Capitolo 10 Dettagli dell’analisi dei dati

Informazioni Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Content (Contenuto) Tipo di campione elencato nella finestra Plate Editor (Editor
piastra)

Target (Target) Target di amplificazione (gene)

Sample (Campione) Nome del campione elencato nella finestra Plate Editor (Editor
piastra)

Melt Temperature (Temperatura
di fusione)

Temperatura di fusione di ciascun prodotto, elencata come un
picco (massimo) per riga nel foglio di calcolo

Peak Height (Altezza picco) Altezza del picco

Begin Temperature (Temperatura
iniziale)

Temperatura all’inizio del picco

End Temperature (Temperatura
finale)

Temperatura alla fine del picco

Tabella 25. Contenuto del foglio di calcolo dei picchi di fusione

Foglio di calcolo della piastra
Il foglio di calcolo della piastra visualizza i dati della curva di fusione in formato piastra.

Nota: Per regolare il picco richiamato dal software, regolare la linea di soglia nel grafico del picco
di fusione sulla scheda Melt Curve (Curva di fusione).

La Tabella 26 a pagina 211 definisce i dati che vengono visualizzati nel foglio di calcolo della piastra.
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Informazioni Descrizione

Content
(Contenuto)

Una combinazione del tipo di campione (obbligatorio) e del n. di replicati
(facoltativo)

Sample (Campione) Descrizione del campione

Peak 1 (Picco 1) Primo picco di fusione (massimo)

Peak 2 (Picco 2) Secondo picco di fusione (inferiore)

Tabella 26. Contenuto del foglio di calcolo della piastra

Foglio di calcolo RFU
Il foglio di calcolo RFU visualizza la fluorescenza per ciascun pozzetto ad ogni ciclo acquisito durante
la curva di fusione.

Nella Tabella 27 sono definiti i dati visualizzati nel foglio di calcolo RFU.

Informazioni Descrizione

Numero di pozzetto (A1, A2, A3, A4, A5) Posizione del pozzetto nella piastra per i
pozzetti caricati

Temperature (Temperatura) Temperatura di fusione del target amplificato,
tracciata come un solo pozzetto per ogni fila e
come vari pozzetti per più prodotti nello stesso
pozzetto

Tabella 27. Contenuto del foglio di calcolo RFU
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Foglio di calcolo -d(RFU)/dT
Il foglio di calcolo -d(RFU)/dT visualizza il tasso di variazione negativo in RFU quando cambia la
temperatura (T).

La Tabella 28 definisce i dati visualizzati sul foglio di calcolo -d(RFU)/dT.

Informazioni Descrizione

Numero di pozzetto (A1, A2, A3, A4, A5) Posizione del pozzetto nella piastra per i pozzetti caricati

Temperature (Temperatura) -d(RFU)/dT Tasso di variazione negativo in RFU quando cambia la
temperatura (T)

Tabella 28. Contenuto del foglio di calcolo -d(RFU)/dT

212 | Sistemi CFX96 Dx e CFX96 DeepWell Dx



Scheda End Point (Punto finale)

Scheda End Point (Punto finale)
Aprire la scheda End Point (Punto finale) per analizzare le unità di fluorescenza relativa (RFU) finali
per i pozzetti di campione. Il software confronta i livelli RFU per i pozzetti con campioni sconosciuti con
i livelli RFU per i pozzetti con controlli negativi e “richiama” il valore positivo o negativo sconosciuto. I
campioni positivi hanno un valore RFUmaggiore del valore RFUmedio dei controlli negativi più il
valore di cutoff.

Per analizzare i dati del punto finale, la piastra deve contenere i controlli negativi; diversamente il
software non riesce ad effettuare il richiamo. Eseguire uno di questi due tipi di protocollo:

n Eseguire un protocollo di quantificazione: impostare un protocollo normale. Al termine dell’analisi,
aprire la finestra Data Analysis (Analisi dei dati), regolare le impostazioni di analisi dei dati nella
scheda Quantification (Quantificazione), quindi fare clic sulla scheda End Point (Punto finale) per
scegliere un ciclo per il punto finale.

n Eseguire il protocollo End Point Only (Solo punto finale): caricare il protocollo End Point Only
(Solo punto finale) nella scheda Plate (Piastra) della finestra Run Setup (Impostazione analisi),
selezionare o creare una piastra e avviare l’analisi.

Nella scheda End Point (Punto finale) sono visualizzati i valori medi RFU per determinare se il target è
stato amplificato dall’ultimo ciclo (finale). Utilizzare questi dati per stabilire se sia presente (positivo)
una particolare sequenza target in un campione. I target positivi hanno valori RFU maggiori del livello
di cutoff che si definisce.
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Suggerimento: Per creare un protocollo per punto finale, aprire la scheda Protocol (Protocollo)
(finestra Run Setup (Impostazione analisi)) e selezionare Run > End Point Only Run (Analisi >
Analisi solo del punto finale).

Al termine dell’analisi, il file di dati si apre nella scheda End Point (Punto finale), che comprende le
seguenti sezioni:

n Settings (Impostazioni): regola le impostazioni dell’analisi dei dati.

n Results (Risultati): visualizza i risultati subito dopo aver regolato le impostazioni.

n Well Selector (Selettore pozzetto): seleziona i pozzetti con i dati del punto finale che si intende
mostrare.

n RFU spreadsheet (Foglio di calcolo RFU): visualizza il valore RFU finale raccolto nei pozzetti
selezionati.

Dati relativi ai risultati
La sezione Results (Risultati) visualizza i seguenti dati:

n Lowest RFU value (Valore RFUminimo): il valore RFUminimo nei dati

n Highest RFU value (Valore RFUmassimo): il valore RFUmassimo nei dati

n Negative Control Average (Media controlli negativi): media RFU per i pozzetti che contengono i
controlli negativi

n Cut Off Value (Valore di cutoff): calcolato aggiungendo la tolleranza (RFU o percentuale
dell’intervallo elencate nelle impostazioni) e la media dei controlli negativi. I campioni con RFU
maggiori del valore di cutoff saranno chiamati “Positive” (Positivi). Per regolare il valore di cutoff,
cambiare l’RFU o la percentuale di intervallo

Il valore di cutoff viene calcolato usando questa formula:

Valore di cutoff = media dei controlli negativi + tolleranza

Selezionare una tolleranza con uno di questi metodi:

n RFUs (RFU) (impostazione predefinita): selezionare questo metodo per utilizzare un valore RFU
assoluto per la tolleranza. Il valore di tolleranza RFUminimo è 2. Il valore massimo è il valore
assoluto del valore RFUmassimo, meno il valore assoluto del valore RFUminimo. Il valore di
tolleranza RFU predefinito è il 10% dell’intervallo RFU totale.

n Percent of Range (Percentuale di intervallo): selezionare questo metodo per utilizzare una
percentuale dell’intervallo RFU per la tolleranza. La percentuale di intervallo minima è 1%. La
percentuale di intervallo massima è 99%. La percentuale di intervallo predefinita è 10%.
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Regolazione dell’analisi dei dati del punto finale
Per regolare i dati nella scheda End Point (Punto finale)

u Eseguire una delle seguenti operazioni:

n Scegliere un fluoroforo dall’elenco a discesa.

n Scegliere un valore End Cycle to Average (Media fine ciclo) per impostare il numero di cicli
con cui calcolare la media di RFU nel punto finale.

n Selezionare RFUs (RFU) per visualizzare i dati in unità di fluorescenza relativa.

n Selezionare Percentage of Range (Percentuale dell’intervallo) per visualizzare i dati come
percentuale dell’intervallo RFU.

n Selezionare i pozzetti nel selettore pozzetto per focalizzare i sottoinsiemi dei dati.

n Selezionare un gruppo di pozzetti per visualizzare e analizzare un sottoinsieme dei pozzetti
nella piastra. Nel menu a discesa Well Group (Gruppo di pozzetti) presente nella barra degli
strumenti, selezionare ogni gruppo di pozzetti per nome.

Foglio di calcolo RFU per l’analisi del punto finale
La Tabella 29 definisce i dati che sono visualizzati nel foglio di calcolo RFU della scheda End Point
(Punto finale).

Informazioni Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Fluor (Fluoroforo) Fluoroforo rilevato

Content (Contenuto) Una combinazione del tipo di campione e del n. di replicati

End RFU (RFU finale) RFU nel ciclo del punto finale

Call (Richiamo) Positive (Positivo) o Negative (Negativo), dove i campioni positivi hanno
un valore RFUmaggiore della media RFU dei controlli negativi più il
valore di cutoff

Sample (Campione) Nome del campione caricato nell’editor piastra

Tabella 29. Contenuto del foglio di calcolo del punto finale
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Scheda Allelic Discrimination (Discriminazione allelica)
La scheda Allelic Discrimination (Discriminazione allelica) assegna i genotipi ai pozzetti con campioni
sconosciuti. Usare questi dati per identificare i campioni con genotipi diversi, fra cui Allele 1 (Allele 1),
Allele 2 (Allele 2), Heterozygote (Eterozigote), No Call (Nessun richiamo) (senza amplificazione) o
Undetermined (Indeterminato).

Nota: I dati per la discriminazione allelica devono derivare dalle analisi multiplex con almeno due
fluorofori. Ciascun fluoroforo identifica un allele in tutti i campioni.

L’analisi della discriminazione allelica richiede il seguente contenuto minimo del pozzetto:

n Due fluorofori in ciascun pozzetto

n Campioni NTC (no template control, nessun controllo modello) per l’analisi ottimizzata dei dati

Il Software CFX Manager Dx offre quattro opzioni in cui visualizzare i dati della discriminazione
allelica:

n Allelic Discrimination chart (Grafico della discriminazione allelica): visualizza i dati in un grafico di
RFU per Allele 1/Allele 2. Ciascun punto del grafico rappresenta i dati di entrambi i fluorofori in un
pozzetto. È possibile passare tra le coordinate cartesiane e quelle polari selezionando e
deselezionando la casella di controllo Polar Coordinates (Coordinate polari). Le coordinate
cartesiane rappresentano l’RFU per Allele 1 sull’asse x e l’RFU per Allele 2 sull’asse y. Le
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coordinate polari rappresentano l’angolo sull’asse x e la distanza RFU sull’asse y dall’origine
(mediana di tutti i NTC).

n Well spreadsheet (Foglio di lavoro del pozzetto): visualizza i dati della discriminazione allelica
raccolti in ciascun pozzetto della piastra.

n Well selector (Selettore pozzetto): seleziona i pozzetti con i dati allelici che si desidera mostrare.

n Selected Fluorophores panel (Pannello dei fluorofori selezionati): cambia le etichette dell’asse x e
dell’asse y nel grafico della discriminazione allelica, il ciclo da analizzare e se visualizzare la
mappa dei richiami.

Regolazione dei dati per la discriminazione allelica
Il software assegna automaticamente un genotipo ai pozzetti con campioni sconosciuti, in base alle
posizioni degli NTC e all’angolo e alla distanza dei punti di dati sconosciuti rispetto agli NTC.

Per regolare i dati della discriminazione allelica

u Eseguire una delle seguenti operazioni:

n Per visualizzare le coordinate polari, selezionare la casella di controllo nel grafico della
discriminazione allelica.

n Per visualizzare un altro fluoroforo, sceglierlo dall’elenco a discesa nel pannello dei fluorofori
selezionati.

n Per cambiare un richiamo, trascinare attraverso i punti di dati nel grafico della
discriminazione allelica e scegliere un’opzione nell’elenco dei pozzetti selezionati:

o Allele 1 (Allele 1)

o Allele 2 (Allele 2)

o Heterozygote (Eterozigote)

o Undetermined (Indeterminato)

o No Call (Nessun richiamo)

o Auto Call (Richiamo automatico)

Suggerimento: Selezionare Auto Call (Richiamo automatico) per tornare al richiamo
predefinito.
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Opzioni del menu Chart (Grafico)
Oltre alle opzioni comuni del menu del pulsante destro del mouse per i grafici (vedere Voci comuni del
menu del pulsante destro del mouse per i grafici a pagina 185), la Tabella 30 elenca le opzioni di menu
disponibili nel grafico della discriminazione allelica).

Opzione del menu Funzione

Zoom Focalizza la visualizzazione del grafico nell’area selezionata
(facendo clic e trascinando il cursore nel grafico).

Suggerimento: Per ripristinare lo zoom e mostrare tutti i punti
di dati, fare clic con il pulsante destro del mouse e selezionare
Set Scale to Default (Imposta scala su predefinito).

Well (Pozzetto) Le opzioni disponibili per il pozzetto selezionato sono: Display only
this well (Visualizza solo questo pozzetto), Remove this well from
view (Rimuovi questo pozzetto dalla visualizzazione), Set color for
this trace (Imposta colore per questa traccia) o Exclude this well
from analysis (Escludi questo pozzetto dall’analisi).

Selected Wells (Pozzetti
selezionati)

Le opzioni disponibili per i pozzetti selezionati (selezionati facendo
clic e trascinando il cursore nel grafico) sono: Display only these
wells (Visualizza solo questi pozzetti), Remove these wells from
view (Rimuovi questi pozzetti dalla visualizzazione), Set color for
these traces (Imposta colore per queste tracce) o Exclude these
wells from analysis (Escludi questi pozzetti dall’analisi).

Tabella 30. Opzioni del menu del pulsante destro del mouse e opzioni normali del grafico
della discriminazione allelica

Foglio di calcolo per la discriminazione allelica
La Tabella 31 definisce i dati visualizzati sul foglio di calcolo per la discriminazione allelica.

Informazioni Descrizione

Well (Pozzetto) Posizione del pozzetto nella piastra

Sample (Campione) Descrizione del nome campione

Tabella 31. Contenuto del foglio di calcolo per la discriminazione allelica
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Informazioni Descrizione

Call (Richiamo) Identità dell’allele, fra cui Allele 1 (Allele 1), Allele 2 (Allele 2),
Heterozygote (Eterozigote), No Call (Nessun richiamo) o
Undetermined (Indeterminato)

Type (Tipo) Auto (Automatico) o Manual (Manuale), descrive come è stato
effettuato il richiamo. Automatico indica che il richiamo è stato
selezionato dal software. Manuale indica che il richiamo è stato
scelto dall’operatore.

RFU1 RFU per Allele 1

RFU2 RFU per Allele 2

Tabella 31. Contenuto del foglio di calcolo per la discriminazione allelica, continua
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Scheda Custom Data View (Vista personalizzata dei dati)
La scheda Custom Data View (Vista personalizzata dei dati) visualizza più riquadri in un formato
personalizzabile.

L’elenco a discesa Load a Preset View (Carica vista predefinita) offre una scelta di modelli di formati di
visualizzazione. La vista predefinita visualizzata dipende dal file analizzato. Ad esempio, se sono
presenti i dati della curva di fusione, appare la vista predefinita Amp+Melt.
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Creazione di una vista personalizzata dei dati
Per creare una vista personalizzata dei dati

u Eseguire una delle seguenti operazioni:

n Dall’elenco a discesa, selezionare una vista preimpostata alternativa.

n Selezionare un altro grafico dall’elenco a discesa che si trova nella parte superiore di ciascun
riquadro.

n Cambiare il numero di righe e colonne nella scheda.

n Cambiare le dimensione dei singoli riquadri. Trascinare le barre verso il bordo di ciascun
riquadro.

Fare clic su Save as Preset (Salva come preimpostato) per salvare la vista personalizzata come
modello preimpostato. Fare clic su Manage Presets (Gestisci preimpostazioni) per eliminare,
rinominare o ripristinare le viste preimpostate esistenti.
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Scheda QC (CQ)
Utilizzare la scheda QC (CQ) per valutare velocemente la qualità dei dati dell’analisi in base alle
regole definite nella scheda QC (CQ).

Il Software CFX Manager Dx offre quattro opzioni in cui visualizzare i dati del CQ:

n Amplification chart (Grafico di amplificazione): visualizza le RFU per ciascun pozzetto ad
ogni ciclo. Ogni traccia presente nel grafico rappresenta i dati di un singolo fluoroforo in ciascun
pozzetto.

n QC rules table (Tabella delle regole del CQ): visualizza le regole di CQ e le impostazioni che
definiscono ogni regola. Le regole di CQ applicate sono indicate da un segno di spunta.

n Well selector (Selettore di pozzetto): seleziona i pozzetti con i dati della fluorescenza che si
desidera mostrare.

n QC rule summary pane (Riquadro di riepilogo della regola di CQ): visualizza la regola di CQ
selezionata ed evidenzia i pozzetti che non soddisfano tale regola.

Modifica dei criteri CQ
Per modificare i criteri CQ

u Selezionare o deselezionare la casella di controllo Use (Utilizza) per le regole da includere o
escludere dal CQ.
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Esclusione dei pozzetti che non superano il CQ
Il Software CFX Manager Dx visualizza i pozzetti che non superano i criteri di CQ nella colonna
Results (Risultati), presente nella tabella delle regole di CQ e nel riquadro di riepilogo.

Per escludere i pozzetti che non superano i criteri di CQ

u Per ogni pozzetto che deve essere escluso, selezionare Exclude Wells (Escludi pozzetti).
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Scheda Run Information (Informazioni analisi)
Nella scheda Run Information (Informazioni analisi) sono indicati il protocollo e altre informazioni su
ciascuna analisi. Utilizzare questa scheda per eseguire quanto segue:

n Visualizzare il protocollo.

n Immettere o modificare le note sull’analisi.

n Immettere o modificare l’ID o il codice a barre per l’analisi.

n Visualizzare gli eventi che potrebbero essersi verificati durante l’analisi. Utilizzare questi
messaggi per agevolare l’individuazione e la risoluzione di errori in un’analisi.

Suggerimento: Con il pulsante destro del mouse fare clic sul protocollo per copiarlo, esportarlo o
stamparlo. Con il pulsante destro del mouse fare clic sui riquadri Notes (Note), ID/Bar Code
(ID/Codice a barre) o Other (Altro) per tagliare, copiare, incollare, eliminare o selezionare il testo.
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Report di analisi dei dati
Nella finestra di dialogo Report (Report) sono visualizzate le informazioni sul file di dati attuale della
finestra Data Analysis (Analisi dei dati) . Per aprire un report, selezionare Tools > Reports (Strumenti >
Report).

Nella finestra di dialogo Report (Report) sono incluse le seguenti sezioni:

n Barra dei menu e degli strumenti: fornisce le opzioni per formattare, salvare e stampare il report o
il modello.

n Elenco delle opzioni (in alto a sinistra della finestra di dialogo): fornisce le opzioni da visualizzare
nel report.

n Riquadro delle opzioni (in basso a sinistra della finestra di dialogo): visualizza le caselle di testo in
cui si possono immettere informazioni relative all’opzione selezionata.

n Riquadro anteprima (a destra della finestra di dialogo): visualizza l’anteprima dell’attuale report.
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Categorie di report di analisi dei dati
Nella Tabella 32 sono elencate tutte le opzioni disponibili per il report di analisi dei dati, in base al tipo
di dati presenti nella finestra Data Analysis (Analisi dei dati).

Categoria Opzione Descrizione

Header (Intestazione)

Titolo, sottotitolo e logo per il report

Report Information (Informazioni
sul report)

Data di analisi, nome utente, nome file
di dati, percorso file di dati e gruppo di
pozzetti selezionato

Audit Information (Informazioni
audit)

Informazioni aggiuntive richieste per
l’audit, tra cui le firme

Notes (Note) Note sul report di dati

Run Setup (Impostazione dell'analisi)

Run Information (Informazioni
analisi)

Data di analisi, nome utente, nome file
di dati, percorso file di dati e gruppo di
pozzetti selezionato

Protocol (Protocollo) Visualizzazione del testo delle fasi e
delle opzioni del protocollo

Plate Display (Display piastra) Visualizzazione delle informazioni della
piastra in ciascun pozzetto della
piastra.

Quantification (Quantificazione)

Analysis Settings (Impostazioni
dell’analisi)

Numero di fasi per la raccolta dei dati,
modalità di analisi e metodica di
sottrazione della linea basale

Amplification Chart (Grafico
dell’amplificazione)

Grafico dell’amplificazione per le analisi
che includono i dati di quantificazione

Grafico della curva standard Grafico della curva standard

Tabella 32. Categorie di report di analisi dei dati nell’elenco delle opzioni
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Categoria Opzione Descrizione

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

Gene Expression - Bar Chart (Espressione genica - Grafico a barre)

Analysis Settings (Impostazioni
dell’analisi)

Modalità di analisi, dati del grafico,
opzione di messa in scala ed errore
grafico

Chart (Grafico) Copia del grafico a barre

Target Names (Nomi target) Grafico dei nomi target

Sample Names (Nomi
campione)

Grafico dei nomi campione

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

Target Stability (Stabilità target) Grafico dei valori della stabilità target

Gene Expression – Clustergram and Scatter Plot (Espressione genica - Diagramma di
gruppo e grafico di dispersione)

Analysis Settings (Impostazioni
dell’analisi)

Impostazioni per ciascun tipo di grafico

Chart (Grafico) Copia del grafico

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun target

Melt Curve (Curva di fusione)

Analysis Settings (Impostazioni
dell’analisi)

Numero fase di fusione e impostazione
della barra di soglia

Melt Curve Chart (Grafico curva
di fusione)

Grafico curva di fusione

Melt Peak Chart (Grafico picco
di fusione)

Grafico picco di fusione

Tabella 32. Categorie di report di analisi dei dati nell’elenco delle opzioni, continua
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Categoria Opzione Descrizione

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

Allelic Discrimination (Discriminazione allelica)

Analysis Settings (Impostazioni
dell’analisi)

Visualizza i fluorofori, il ciclo e
visualizza la call map

Allelic Discrimination Chart
(Grafico discriminazione
allelica)

Copia del grafico di discriminazione
allelica

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

End Point (Punto finale)

Analysis Settings (Impostazioni
dell’analisi)

Fluoroforo, media cicli di fine, modalità,
valore RFU più basso, valore RFU più
alto e valore di cutoff

Data (Dati) Foglio di calcolo che elenca i dati in
ciascun pozzetto

QC Parameters (Parametri CQ)

Data (Dati) Foglio di calcolo che elenca i parametri
per ciascuna regola CQ

Tabella 32. Categorie di report di analisi dei dati nell’elenco delle opzioni, continua
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Creazione di un report di analisi dei dati
È possibile salvare il layout del report come modello, che è possibile usare di nuovo per report simili.

Per creare un report di analisi dei dati

1. Eseguire le regolazioni finali del contenuto dei pozzetti, dei pozzetti selezionati, dei grafici e dei
fogli di calcolo nella finestra Data Analysis (Analisi dei dati), prima di creare il report.

2. Selezionare Tools > Reports (Strumenti > Report) nella barra del menu Data Analysis (Analisi dei
dati) per aprire la finestra di dialogo Report (Report).

3. Scegliere le opzioni che si desidera includere nel report. Il report si apre con le opzioni predefinite
selezionate. Selezionare o deselezionare le caselle di controllo per cambiare categorie intere o
singole opzioni all’interno di una categoria.

Nota: I dati che vengono visualizzati nel report dipendono dalle selezioni presenti nelle
schede della finestra Data Analysis (Analisi dei dati) . Ad esempio, un’analisi di
quantificazione potrebbe non contenere una curva standard e, pertanto, tali dati non sono
visualizzati nella finestra Data Analysis (Analisi dei dati) o nel report dei dati.

4. Cambiare l’ordine delle categorie e degli elementi in un report. Trascinare le opzioni nella relativa
posizione. Gli elementi possono essere riordinati solamente all’interno delle categorie a cui
appartengono.

5. (Facoltativo) Nel riquadro Report Options (Opzioni report), inserire le informazioni relative
all’opzione selezionata:

n Scegliere un sottogruppo di informazioni da visualizzare nel report.

n Scegliere impostazioni specifiche per l’opzione selezionata.

n Cambiare il testo da visualizzare per l’opzione selezionata.

6. Fare clic su Update Report (Aggiorna report) per aggiornare l’anteprima del report con tutte le
modifiche.

7. Stampare o salvare il report. Fare clic sul pulsante Print Report (Stampa report) nella barra degli
strumenti per stampare il report attuale. Selezionare File > Save (File > Salva) per salvare il report
in formato PDF (file Adobe Acrobat Reader) e selezionare una posizione in cui salvare il file.
Selezionare File > Save As (File > Salva con nome) per salvare il report con un nuovo nome o in
una nuova posizione.

8. (Facoltativo) Creare un modello di report con le informazioni desiderate. Per salvare in un
modello le impostazioni del report attuali, selezionare Template > Save oppure Save As (Modello
> Salva/Salva con nome). Dopodiché, caricare il modello di report la prossima volta che si
desidera creare un nuovo report.
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Creazione di report sul gruppo di pozzetti
Per creare un report sul gruppo di pozzetti

1. Selezionare Tools > Well Group Reports (Strumenti > Report gruppo di pozzetti) nella finestra
Data Analysis (Analisi dei dati).

2. Nella finestra di dialogo Well Groups Reports (Report gruppi di pozzetti), selezionare tutti i gruppi
di pozzetti, le fasi di amplificazione e le fasi di fusione da includere nel report.

3. Inserire il percorso o navigare fino alla cartella di destinazione in cui salvare il report.

4. (Facoltativo) Selezionare Choose a Report Template (Scegli un modello di report) e navigare fino
alla cartella del file modello.

5. (Facoltativo) Selezionare Open Destination Folder (Apri cartella di destinazione) per aprire la
cartella e visualizzare i report dopo che sono stati generati.

6. Fare clic su Create Reports (Crea report).
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Con l’utilizzo di controlli rigorosamente qualificati nelle reazioni, si può utilizzare il software CFX
Manager™ Dx per effettuare l’analisi dell’espressione genica al fine di normalizzare le differenze
relative in una concentrazione target tra i campioni. Vengono tipicamente utilizzati i livelli di
espressione per uno o più geni di riferimento per normalizzare i livelli di espressione di un gene
d’interesse. I geni di riferimento prendono in considerazione il carico di differenze o altre variazioni
rappresentate in ciascun campione e i rispettivi livelli di espressione non dovrebbero essere
pregiudicati nel sistema biologico studiato.

Scegliere la scheda Gene Expression (Espressione genica) nella finestra Data Analysis (Analisi dei
dati) per valutare differenze relative tra le reazioni PCR in due o più pozzetti. Ad esempio, si possono
valutare numeri relativi di genomi virali o numeri relativi di sequenze transfettate in una reazione PCR.
L’applicazione più comune per lo studio dell’espressione genica è il confronto della concentrazione
cDNA in più di una reazione per stimare i livelli dell’RNA messaggero di stato stazionario.

Il software calcola il livello relativo di espressione di un target con uno di questi scenari:

n Il livello di espressione relativo di una sequenza target (Target 1) rispetto ad un altro target
(Target 2); ad esempio la quantità di un gene rispetto ad un altro gene secondo lo stesso
trattamento campione.

n Il livello di espressione relativo di una sequenza target in un campione rispetto allo stesso target
secondo un trattamento campione differente; ad esempio, la quantità relativa di un gene rispetto
allo stesso gene secondo diverse condizioni temporali, geografiche o di sviluppo.

Impostazione della piastra per l’analisi dell’espressione
genica

Per eseguire l’analisi dell’espressione genica, il contenuto dei pozzetti deve includere quanto segue:

n Due o più target: i due target che rappresentano geni amplificati diversi o delle sequenze nei
campioni.

n Uno o più target di riferimento: almeno un target deve essere un target di riferimento per
l’espressione normalizzata. Assegnare tutti i target di riferimento nella finestra Experiment
Settings (Impostazioni esperimento) per analizzare i dati nella modalità Normalized Expression
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(Espressione normalizzata) (ΔΔCq). Le analisi che non contengono un riferimento devono essere
analizzate usando la modalità Relative Expression (Espressione relativa) (ΔCq).

n Campioni comuni: le reazioni devono includere campioni comuni (richiesti almeno due) per
visualizzare i dati tracciati nella scheda Gene Expression (Espressione genica). Questi campioni
devono rappresentare vari trattamenti o condizioni per ciascuna delle sequenze target.
Assegnare un campione di controllo (opzionale) nella finestra Experiment Settings (Impostazioni
esperimento). Se non si seleziona alcun controllo, il software utilizza il valore Cqminimo come
controllo.

I requisiti per l’impostazione Gene Expression (Espressione genica) nell’editor piastra dipendono dal
fatto che il contenuto della reazione sia PCR singleplex, con un fluoroforo nelle reazioni, o PCR
multiplex, con più di un fluoroforo nelle reazioni.

Impostazione guidata della piastra
Se l’impostazione piastra di un file di dati non contiene le informazioni richieste per l’analisi ed è
selezionata la scheda Gene Expression (Espressione genica), lo spazio normalmente occupato dal
grafico a barre conterrà le istruzioni per inserire queste informazioni. Per l’espressione genica
normalizzata, completare le seguenti fasi:

1. Definire i nomi target e campione usando una delle seguenti opzioni:

n Plate Setup (Impostazione piastra): apre la finestra Plate Editor (Editor piastra).

n Replace Plate File (Sostituisci file piastra): apre il browser Select Plate (Seleziona piastra), in
cui è possibile navigare fino ad un file piastra precedentemente salvato con cui sostituire la
disposizione della piastra attuale.

n Replace PrimePCR File (Sostituisci file PrimePCR): apre la finestra di dialogo Select
PrimePCR file (Seleziona file PrimePCR), in cui è possibile navigare fino a un file di analisi
PrimePCR™ e applicarlo alla disposizione della piastra.

2. Selezionare uno o più target di riferimento ad un campione di controllo usando la finestra di
dialogo Experiment Settings (Impostazioni esperimento).

Se la disposizione della piastra contiene già le informazioni sul target e sul campione, è
necessario eseguire solo la seconda fase che è evidenziata in arancione. Questa fase deve
essere completata prima dell’analisi dell’espressione genica.

Nota: i dati per il diagramma di gruppo e il grafico di dispersione sono visualizzati solo se
vengono soddisfatti tutti i requisiti per l’espressione genica normalizzata elencati in Plate
Setup (Impostazione piastra) per Gene Expression Analysis (Analisi espressione genica).
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Grafici dell’espressione genica
Il software CFX Manager Dx visualizza i dati dell’espressione genica in più viste. Nella Tabella 33
sono elencate le opzioni di rappresentazione grafica disponibili nel software.

Pulsante Nome Funzione

Grafico a barre Visualizza i dati dell’espressione genica
normalizzata nel formato grafico a barre.

Diagramma di gruppo Visualizza i dati dell’espressione
normalizzata in una gerarchia basata sul
grado di similitudine dell’espressione per i
vari target e campioni.

Grafico di dispersione Visualizza l’espressione normalizzata dei
target per un controllo rispetto ad un
campione sperimentale.

Risultati Riepiloga i dati di tutti i grafici.

Tabella 33. Opzioni di rappresentazione grafica dell’espressione genica
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Grafico a barre

L’espressione relativa dei target viene rappresentata in queste due viste:

n Grafico dell’espressione genica: visualizza i dati PCR in tempo reale con uno dei seguenti valori:

o ΔΔCq—espressione normalizzata relativa, calcolata usando i campioni di controllo e i target di
riferimento.

o ΔCq—quantità relativa del gene target in un campione relativo ad un campione di controllo.

n Foglio di calcolo: visualizza un foglio di calcolo dei dati dell’espressione genica.

Suggerimento: Fare clic con il pulsante destro del mouse su un grafico o un foglio di calcolo
qualsiasi per le opzioni. Selezionare View/Edit Plate (Visualizza/Modifica piastra) dal menu a
discesa Plate Setup (Impostazioni piastra) per aprire l’editor piastra e cambiare il contenuto
dei pozzetti nella piastra.
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Suggerimento: Selezionare Sort (Ordina) dal menu del pulsante destro del mouse per
riorganizzare l’ordine dei nomi target e campione nel grafico.

Espressione genica normalizzata

Per normalizzare i dati, usare il livello di espressione misurato di uno o più geni di riferimento come
fattore di normalizzazione. I geni di riferimento sono dei target che non sono regolati nel sistema
biologico studiato, come actina,GAPDH o tubulina.

Per impostare l’analisi dell’espressione genica normalizzata (ΔΔCq)

1. Aprire un file di dati (estensione .pcrd).

2. Rivedere i dati nella scheda Quantification (Quantificazione) della finestra Data Analysis (Analisi
dei dati). Modificare i dati, cambiando ad esempio la soglia e la modalità di analisi.

3. Scegliere la scheda Gene Expression (Espressione genica).

4. Nella scheda Gene Expression (Espressione genica), fare clic su Experiment Settings
(Impostazioni esperimento).

5. Nella finestra di dialogo Experiment Settings (Impostazioni esperimento), procedere come segue:

a. Scegliere la scheda Samples (Campioni) e selezionare un controllo. Quando si assegna un
controllo, il Software CFX Manager Dx normalizza le quantità relative per tutti i geni sulla quantità
di controllo, che è impostata su 1.

b. Scegliere la scheda Target (Target) e selezionare i geni di riferimento. L’analisi
dell’espressione genica richiede un riferimento fra i target nei campioni.

6. Selezionare Normalized Expression (Espressione normalizzata) (ΔΔCq) se non è già stata
selezionata, quindi visualizzare i livelli di espressione nella scheda Gene Expression
(Espressione genica).

Quantità relativa

Per definizione, i dati della quantità relativa (ΔCq) non sono normalizzati. Questo metodo viene
utilizzato per quantificare i campioni che non includono geni di riferimento (target). Tipicamente, i
ricercatori confidano in una delle seguenti considerazioni quando impostano la propria analisi:

n Ciascun campione contiene la stessa quantità di modello, possibilmente la stessa massa di RNA
o cDNA in ciascun pozzetto.

n Ogni deviazione della quantità di campione biologico caricato sarà normalizzata dopo l’analisi con
un metodo di analisi dei dati esterno al software. Ad esempio, un ricercatore potrebbe scegliere di
dividere il valore della quantità relativa con il fattore di normalizzazione, probabilmente la massa di
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acido nucleico caricata per ciascun campione o il numero di cellule da cui è stato isolato l’acido
nucleico.

Per eseguire un’analisi della quantità relativa (ΔCq)

u Nella scheda Gene Expression (Espressione genica), selezionare Relative Quantity (ΔCq)
(Quantità relativa) dall’elenco a discesa Mode (Modalità) che si trova nel riquadro di destra.

Suggerimento: Per confrontare i risultati con i dati di altre analisi di espressione genica,
aprire un nuovo studio dei geni o aggiungere un file di dati allo studio dei geni esistente.

Ordinamento dei dati del target e del campione
Nota: Questa opzione è disponibile solo nei grafici dell’espressione genica.

Per impostazione predefinita, gli elenchi dei target e dei campioni sono visualizzati in ordine
alfabetico. Usare la finestra di dialogo Sort (Ordina) per ordinare la visualizzazione in ordine alfabetico
inverso o per spostare manualmente un termine in un’altra posizione dell’elenco.

Per ordinare i dati del target e del campione

1. Dal menu del pulsante destro del mouse per il grafico, fare clic su Sort (Ordina).

Viene visualizzata la finestra di dialogo Gene Expression Chart Sorting (Ordine del grafico
dell’espressione genica).

2. Nella finestra di dialogo, fare clic su Z-A per ordinare l’elenco nell’ordine alfabetico inverso.

3. Per spostare un termine manualmente, selezionarlo e fare clic sul pulsante appropriato tra i
grafici:

n Fare clic sulla freccia su o giù per spostare il termine selezionato di una posizione.

n Fare clic sulla freccia della barra su o giù per spostare il termine selezionato in alto o in basso
nell’elenco.
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4. Fare clic su OK per salvare le modifiche e tornare alla scheda Gene Expression (Espressione
genica).

Rettifica dei dati dell’espressione genica
Dopo aver selezionato la modalità di analisi, ossia normalized expression (∆∆Cq, espressione
normalizzata) o relative quantity (∆Cq, quantità relativa), rettificare i dati visualizzati nella scheda
Gene Expression (Espressione genica) modificando le opzioni delle impostazioni a destra del grafico.

Suggerimento: Si impostano le opzioni predefinite dei dati dell’espressione genica nella finestra di
dialogo User Preferences (Preferenze dell’operatore) (vedere Impostazione dei parametri predefiniti del
file di dati dell’espressione genica a pagina 74).

Dati su grafico

Impostare il valore dell’asse delle ordinate su Linear scale (Scala lineare) per attivare le opzioni dei
dati su grafico. Le opzioni per i dati su grafico permettono di presentare i dati nel grafico con una di
queste opzioni:

n Relative to control (Relativo al controllo): per rappresentare i dati con l’asse rapportato da 0 a 1.
Se si assegna un controllo nell’analisi, selezionare questa opzione per visualizzare rapidamente
la upregulation e la downregulation del target.

n Relative to zero (Relativo a zero): per rappresentare i dati con l’origine a zero.

Campione di controllo

Usare il menu a discesa Control Sample (Campione di controllo) per selezionare un campione che
sarà utilizzato per normalizzare la quantità relativa.

Impostazioni del grafico

Le opzioni che seguono (descritte sotto) appaiono quando è selezionata la casella Show Chart
Settings (Mostra impostazioni grafico): X-Axis (Asse X), Y-Axis (Asse Y), Scaling (Messa in scala),
Error Type (Tipo di errore) e Chart Error Multiplier (Moltiplicatore errori grafico).

Opzioni per l’asse X

L’opzione per l’asse X permette di selezionare i dati dell’asse x del grafico Gene Expression
(Espressione genica):

n Target (Target): permette di rappresentare graficamente i nomi target sull’asse x.

n Sample (Campione): permette di rappresentare i nomi campione sull’asse x.
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Opzioni per l’asse Y

L’opzione per l’asse y permette di mostrare il grafico dell’espressione genica in una di queste tre
scale:

n Linear (Lineare): selezionare questa opzione per mostrare una scala lineare.

Suggerimento: L’impostazione dell’asse y su Linear (Lineare) attiva l’elenco a discesa
Graph Data (Dati su grafico) da cui si può scegliere di rappresentare i dati relativi al controllo
o relativi a zero.

n Log 2: selezionare questa opzione per valutare i campioni in base ad una grande gamma
dinamica.

n Log 10: selezionare questa opzione per valutare i campioni in base ad una gamma dinamica
molto grande.

Opzioni di messa in scala

Per abilitare le opzioni di messa in scala nel grafico Gene Expression (Espressione genica),
selezionare Normalized Gene Expression (Espressione genica normalizzata) (ΔΔCq) e impostare
Control Sample (Campione di controllo) su None (Nessuno). Selezionare una di queste opzioni di
messa in scala per calcolare e presentare i dati nella maniera migliore per il modello di analisi:

n Unscaled (Senza scala): presenta l’espressione genica normalizzata senza scala.

n Highest (Più alto): mette in scala l’espressione genica normalizzata per ciascun target dividendo
l’espressione genica di ogni campione con il livello più alto di espressione in tutti i campioni.

Questa opzione di messa in scala utilizza la formula scaled-to-highest (rapportato al valore più
alto).

n Highest (Più basso): mette in scala l’espressione genica normalizzata per ciascun target
dividendo l’espressione genica di ogni campione con il livello più basso di espressione in tutti i
campioni.

Questa opzione di messa in scala utilizza la formula scaled-to-lowest (rapportato al valore più
basso).

n Average (Media): mette in scala l’espressione genica normalizzata per ciascun target dividendo
l’espressione genica di ogni campione con la media geometrica dei livelli di espressione per tutti i
campioni.

Questa opzione di messa in scala utilizza la formula scaled-to-average (rapportato alla media).
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Tipo di errore

Selezionare un’opzione per il tipo di calcolo degli errori (barre di errore) nel grafico Gene Expression
(Espressione genica):

n Standard error of the mean (Errore medio standard) (opzione predefinita)

n Standard deviation (Deviazione standard)

Moltiplicatore per le barre di errore del grafico

Selezionare un moltiplicatore per le barre di errore nel grafico Gene Expression (Espressione genica).
Selezionare uno di questi numeri interi:
+/- 1 (predefinito), 2 o 3. Il tipo di moltiplicatore cambia quando si seleziona la il tipo di errore:

n SEMs: errore standard della media

n Std Devs: deviazioni standard

Impostazioni dell’esperimento
Suggerimento: Questa finestra di dialogo è disponibile anche nell’editor piastra. Per maggiori
informazioni, vedere Modifica delle impostazioni dell’esperimento a pagina 134.

Nella finestra di dialogo Experiment Settings (Impostazioni esperimento), è possibile visualizzare o
modificare l’elenco di target o campioni, selezionare i geni di riferimento, selezionare i controlli oppure
impostare il gruppo di analisi dell’espressione genica da analizzare se i nomi definiti dei gruppi
biologici sono stati aggiunti ai pozzetti.

Per aprire la finestra di dialogo Experiment Settings (Impostazioni esperimento)

u Nella scheda Bar Chart (Grafico a barre), fare clic su Experiment Settings (Impostazioni
esperimento) nella parte inferiore del riquadro di destra.

Viene visualizzata la finestra di dialogo Experiment Settings (Impostazioni esperimento) che
mostra la scheda Target (Target).
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Per regolare le impostazioni Targets (Target)

u Nella scheda Targets (Target), eseguire una delle seguenti operazioni:

n Per selezionare un target come riferimento per l’analisi dei dati dell’espressione genica,
selezionarne il nome nella colonna Reference (Riferimento).

n Per cambiare il colore del target, fare clic sulla relativa cella nella colonna Color (Colore) e
cambiare il colore nella finestra di dialogo Color (Colore) che appare.

Il cambiamento di colore appare nei grafici dell’espressione genica.

n Per usare un valore per l’efficacia precedentemente determinato, deselezionare la casella di
controllo del target nella casella Auto Efficiency (Efficacia automatica) e immettere un
numero per la percentuale dell’efficacia di un target.

Il software calcola l’efficacia relativa per un target utilizzando la funzione Auto Efficiency
(Efficacia automatica) se i dati per un target includono una curva standard.

Per regolare le impostazioni di Sample (Campione)

u Nella scheda Samples (Campioni), eseguire una delle seguenti operazioni:

n Per selezionare un campione come controllo per l’analisi dei dati dell’espressione genica,
selezionarne il nome nella colonna Control (Controllo).

n Per cambiare il colore del campione biologico, fare clic sulla relativa cella nella colonna Color
(Colore) e cambiare il colore nella finestra di dialogo Color (Colore) che appare.
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Il cambiamento di colore appare nei grafici dell’espressione genica.

n Per visualizzare il campione nei grafici dell’espressione genica, selezionarlo nella colonna
Show Chart (Mostra grafico).

n Per rimuovere il campione dai grafici dell’espressione genica, selezionarlo nella colonna
Show Chart (Mostra grafico).

Suggerimento: I dati del campione rimangono nella tabella dei risultati.

Per cambiare la selezione delle opzioni di analisi del set biologico

u Se sono stati assegnati uno o più set biologici ai pozzetti nella piastra (vedere Assegnazione di set
biologici ai pozzetti a pagina 127), viene visualizzato l’elenco delle opzioni di analisi del set
biologico che permette di modificare la selezione, secondo necessità.

n Target vs. Sample (Target vs campione): nei calcoli dell’espressione genica viene usato
solo il nome campione del pozzetto.

n Target vs. Biological Set (Target vs set biologico): nei calcoli viene usato solo il nome
del set biologico.

n Target vs. Sample_Biological Set (Target vs campione_set biologico): il nome
campione e il nome del set biologico vengono combinati per formare un nome unico usato
nei calcoli.

n Target vs. Biological Set_Sample (Target vs set biologico_campione): il nome del set
biologico e il nome campione vengono combinati per formare un nome unico usato nei
calcoli.

Per escludere un tipo di campione dai calcoli dell’analisi

u Selezionare la casella di controllo pertinente nella parte inferiore della finestra di dialogo
Experiment Settings (Impostazioni esperimento).

Nota: In tal modo si escludono i controlli e/o gli standard dall’analisi dell’espressione genica.

Valore target della stabilità
I valori target della stabilità sono calcolati ogniqualvolta viene utilizzato più di un gene di riferimento. Il
software CFX Manager Dx calcola due parametri di controllo qualità per i geni di riferimento:
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n Il Coefficient Variance (CV, Coefficiente di varianza) delle quantità relative al gene di
riferimento normalizzato. Un valore CV ridotto indica maggiore stabilità.

n L’M Value (M, Valore M), una misura della stabilità dell’espressione genica di riferimento.

I valori CV e M consigliati sono visualizzati nella parte inferiore della finestra di dialogo Stability Value
(Valore stabilità).

Per visualizzare il valore target della stabilità

u Nella scheda Gene Expression Bar Chart (Grafico a barre dell’espressione genica), fare clic sulla
casella Target Stability Value (Valore target della stabilità) nella parte inferiore del riquadro di
destra.

Appare la finestra di dialogo Stability Value (Valore di stabilità).

Opzioni del menu del pulsante destro del mouse
Fare clic con il pulsante destro del mouse sul grafico dell’espressione genica per selezionare le voci
mostrate nella Tabella 34.

Voce Funzione

Copy (Copia) Copia il grafico negli appunti.

Save Image As (Salva
immagine con nome)

Salva il grafico come file immagine. Impostare la risoluzione e le
dimensioni dell’immagine, quindi selezionare il tipo di file (PNG,
GIF, JPG, TIF o BMP).

Page Setup (Impostazione
pagina)

Seleziona le impostazioni di una pagina per la stampa.

Print (Stampa) Stampa il grafico.

Set Scale to Default (Imposta
scala su predefinito)

Show All (Mostra tutto) visualizza tutti i dati nel grafico a barre.
Scroll Bar (Barra di scorrimento) visualizza una barra di scorrimento
se vi sono troppi campioni da visualizzare nella struttura del grafico,
mantenendo un’ampiezza di barra minima.

Chart Options (Opzioni grafico) Apre la finestra Chart Options (Opzioni grafico) per regolare il
grafico.

Sort (Ordina) Mette in ordine i campioni o i target che sono visualizzati sull’asse x
del grafico.

Tabella 34. Voci del menu del pulsante destro del mouse per l’espressione genica
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Voce Funzione

Use Corrected Std Devs (Usa
deviazioni standard corrette)

Calcola le barre di errore usando la formula delle deviazioni
standard corrette.

Use Solid Bar Colors (Usa tinte
unite per barra)

Visualizza le barre in tinta unita nel grafico.

X–Axis Labels (Etichette asse
x)

Visualizza le etichette dell’asse x in orizzontale o inclinate.

Tabella 34. Voci del menu del pulsante destro del mouse per l’espressione genica, continua

Risultati
La Tabella 35 definisce i dati visualizzati nella tabella dei dati dell’espressione genica.

Nota: I valori nella tabella vengono calcolati in base al tipo di grafico e alle preferenze selezionate
nel riquadro a destra.

Informazioni Descrizione

Target (Target) Nome target (gene amplificato) selezionato nella finestra
Experiment Settings (Impostazioni esperimento).

Sample (Campione) Nome del campione selezionato nella finestra Experiment Settings
(Impostazioni esperimento).

Ctrl (Ctrl) Nome del controllo selezionato nella finestra Experiment Settings
(Impostazioni esperimento).

Relative Quantity (Quantità
relativa) o
Expression (Espressione)

Quantità relativa (ΔCq) o espressione genica normalizzata (ΔΔCq),
in base alla modalità selezionata.

Relative Quantity (Quantità
relativa) o Expression SEM
(SEM espressione) (o SD)

Errore standard della media (SEM) o deviazione standard (SD)
della quantità relativa o dell’espressione normalizzata, in base
all’opzione selezionata.

Tabella 35. Descrizione delle informazioni incluse nel foglio di calcolo della scheda Bar Chart
(Grafico a barre)
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Informazioni Descrizione

Corrected Relative Quantity
(Quantità relativa corretta) o
Expression SEM (SEM
espressione) (o SD)

Calcolo del valore corretto per SEM o SD della quantità relativa o
dell’espressione normalizzata, in base all’opzione selezionata.

Mean Cq (Media Cq) Media del ciclo di quantificazione.

Cq SEM (o SD) SEM o SD del ciclo di quantificazione, in base all’opzione
selezionata.

Tabella 35. Descrizione delle informazioni incluse nel foglio di calcolo della scheda Bar Chart
(Grafico a barre), continua

Opzione Show Details (Mostra dettagli)
La Tabella 36 definisce i dati visualizzati quando si seleziona Show Details (Mostra dettagli) dal menu
del pulsante destro del mouse per il foglio di calcolo del grafico a barre.

Informazioni Descrizione

Data Set (Serie dati) Dati di fluorescenza di un fluoroforo nel file di dati

Relative Quantity (Quantità
relativa)

Quantità relativa calcolata dei campioni

Relative Quantity SD (DS
quantità relativa)

Deviazione standard del calcolo della quantità relativa

Corrected Relative Quantity SD
(DS quantità relativa corretta)

Deviazione standard calcolata della quantità relativa corretta

Relative Quantity SEM (SEM
quantità relativa)

Errore standard della media del calcolo della quantità relativa

Corrected Relative Quantity
SEM (SEM quantità relativa
corretta)

Errore standard calcolato della media della quantità relativa corretta

Relative Quantity(lg) (Quantità
relativa lg)

Log2 della quantità relativa che viene usata per l’analisi statistica

Tabella 36. Informazioni del foglio di calcolo del grafico a barre con l’opzione Show Details
(Mostra dettagli) selezionata
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Informazioni Descrizione

SD RQ(lg) (DV QR lg) Deviazione standard della quantità relativa (log2)

SEM Expression(lg)
(Espressione SEM lg)

Errore standard della media dell’espressione (log2)

Unscaled Expression
(Espressione senza scala)

Espressione senza scala calcolata

Unscaled Expression SD (DS
espressione senza scala)

Deviazione standard calcolata dell’espressione senza scala

Corrected Unscaled Expression
SD (DS espressione senza
scala corretta)

Deviazione standard calcolata dell’espressione senza scala
corretta

Unscaled Expression SEM
(SEM espressione senza scala)

Errore standard calcolato della media dell’espressione senza scala

Corrected Unscaled Expression
SEM (SEM espressione senza
scala corretta)

Errore standard calcolato della media dell’espressione senza scala
corretta

Unscaled Expression(lg)
(Espressione senza scala lg)

Log2 dell’espressione senza scala

SD Unscaled Expression(lg)
(Espressione senza scala DS
lg)

Deviazione standard dell’espressione senza scala (log2)

SEM Unscaled Expression(lg)
(Espressione senza scala SEM
lg)

Errore standard della media dell’espressione senza scala (log2)

Expression (Espressione) Espressione genica normalizzata

Corrected Expression SD (DS
espressione corretta)

Deviazione standard calcolata

Expression SEM (SEM
espressione)

Errore standard della media

Tabella 36. Informazioni del foglio di calcolo del grafico a barre con l’opzione Show Details
(Mostra dettagli) selezionata, continua
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Informazioni Descrizione

Corrected Expression SEM
(SEM espressione corretta)

Errore standard calcolato della media

Expression(lg) (Espressione lg) Log2 dell’espressione (espressione normalizzata) che viene usata
per l’analisi statistica

SD Expression(lg)
(Espressione DS lg)

Deviazione standard dell’espressione (log2)

SEM Expression(lg)
(Espressione SEM lg)

Errore standard della media dell’espressione (log2)

Mean Cq (Media Cq) Media del ciclo di quantificazione

Cq SD (DS Cq) Deviazione standard del ciclo di quantificazione

Cq SEM (SEM Cq) Errore standard della media del ciclo di quantificazione

Tabella 36. Informazioni del foglio di calcolo del grafico a barre con l’opzione Show Details
(Mostra dettagli) selezionata, continua
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Diagramma di gruppo
Il diagramma di gruppo visualizza i dati in una gerarchia basata sul grado di similitudine
dell’espressione per i vari target e campioni.

Nota: È necessario scegliere un target di riferimento per visualizzare uno dei diagrammi di dati
diversi dall’espressione relativa per i grafici a barre.

L’immagine del diagramma di gruppo illustra l’espressione relativa di un campione o target come
segue:

n Upregulation (rosso) — espressione maggiore

n Downregulation (verde o blu) — espressione minore

n Nessuna regolazione (nero)

n Nessun valore calcolato (nero con una X bianca)

Più chiara è la sfumatura del colore, maggiore è la differenza di espressione relativa. Se non è
possibile calcolare alcun valore Cq normalizzato, il quadrato sarà nero con una X bianca.

Sui bordi esterni del diagramma di dati c’è un dendrogramma, che indica la gerarchia del diagramma
di gruppo. I target o i campioni che hanno pattern di espressione simili avranno diramazioni vicine,
mentre quelli con pattern diversi saranno più distanti.

Impostazioni
È possibile impostare le seguenti opzioni:

n Cluster By (Raggruppa per): scegliere tra Targets (Target), Samples (Campioni), Both (Entrambi)
o None (Nessuno).

n Size (Dimensioni): permette di regolare le dimensioni dell’immagine e di cambiare la percentuale
di ingrandimento del grafico.

n Split Out Replicates (Replicati divisi): visualizza i valori per i singoli replicati.

Suggerimento: È possibile cambiare la combinazione di colori per diagramma di gruppo e grafico di
dispersione dal Rosso/Verde predefinito a Rosso/Blu selezionando questa opzione dal menu del
pulsante destro del mouse su di questi grafici.

Opzioni del menu del pulsante destro del mouse
Le opzioni del menu del pulsante destro del mouse per il diagramma di gruppo sono uguali a quelle
disponibili per il grafico a barre. Per le opzioni disponibili, vedere la Tabella 34 a pagina 242. Inoltre,
selezionare Color Scheme (Combinazione di colori) per cambiare l’espressione della down-regulation
da rosso/verde predefinito a rosso/blu sul grafico.
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Foglio di calcolo dei dati
Il foglio di calcolo visualizza i valori per il target, il campione e l’espressione normalizzata. Fare clic
sulla casella di controllo accanto ad un target per includerlo o escluderlo dal tracciato.
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Grafico di dispersione
Il grafico di dispersione visualizza l’espressione normalizzata dei target per un controllo rispetto ad un
campione dell’esperimento. Le linee nel grafico indicano la soglia di regolazione. I punti di dati tra le linee
indicano che la differenza nell’espressione per quel target (gene) è irrilevante tra i campioni. I punti di dati al
di fuori delle linee superano la soglia di regolazione e potrebbero essere interessanti.

L’immagine del grafico mostra i seguenti cambiamenti nell’espressione target in base alla soglia di
regolazione:

n Upregulation (cerchio rosso): espressione relativamente maggiore

n Downregulation (cerchio verde o blu): espressione relativamente minore

n Nessun cambiamento (cerchio nero)

Fare clic e trascinare una linea di soglia per regolare il valore della soglia di regolazione.

Impostazioni
È possibile impostare le seguenti opzioni:

n Control Sample (Campione di controllo)

n Experimental Sample (Campione sperimentale)

n Soglia di regolazione. Quando si aumenta o si diminuisce il valore di regolazione, le linee di
soglia nel grafico si muovono di conseguenza.

Opzioni del menu del pulsante destro del mouse
Le opzioni del menu del pulsante destro del mouse per il grafico di dispersione sono uguali a quelle
disponibili per il grafico a barre. Per le opzioni disponibili, vedere la Tabella 34 a pagina 242.
Selezionare inoltre Symbol (Simbolo) per cambiare il simbolo utilizzato sul grafico dal cerchio
predefinito a uno dei seguenti:

n Triangolo

n X

n Quadrato

n Rombo
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Foglio di calcolo dei dati
Il foglio di calcolo visualizza i valori per il target e l’espressione normalizzata per il controllo e i
campioni sperimentali. Indica anche se i target sono regolati verso l’alto o verso il basso rispetto alla
soglia di regolazione. Fare clic sulla casella di controllo accanto ad un target per includerlo o
escluderlo dal tracciato.
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Results (Risultati)
La scheda Results (Risultati) fornisce un foglio di calcolo che riepiloga i dati di tutti i grafici. Nella
Tabella 37 sono definiti i dati visualizzati nel foglio di calcolo Results (Risultati).

Informazioni Descrizione

Target (Target) Nome target (gene amplificato)

Sample (Campione) Nome del campione

Mean Cq (Media Cq) Media del ciclo di quantificazione

Mean Efficiency Corrected Cq
(Media Cq con efficacia
corretta)

Media del ciclo di quantificazione dopo la rettifica dell’efficacia della
reazione

Normalized Expression
(Espressione normalizzata)

Espressione target normalizzata in base al target di riferimento
(ΔΔCq)

Relative Normalized
Expression (Espressione
normalizzata relativa)

Espressione normalizzata relativa ad un campione di controllo;
chiamata anche Fold Change

Regulation (Regolazione) Cambiamento dell’espressione relativa ad un campione di controllo

Compared to Regulation
Threshold (Rispetto alla soglia
di regolazione)

Upregulation o downregulation di un campione sperimentale in
base all’impostazione della soglia

Tabella 37. Informazioni presenti nella scheda Results (Risultati)

Nota: I dati per i replicati sono reperibili solo nei fogli di calcolo delle schede di analisi dei dati in
cui è stata selezionata l’opzione Split Out Replicates (Replicati divisi) (ossia, Clustergram
(Diagramma di gruppo)). Potrebbe esserci una discrepanza tra i dati dell’espressione nei fogli di
calcolo dell’analisi dell’espressione genica se è stato selezionato “none” (nessuno) come
campione di controllo nel grafico a barre.
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Studio dei geni
Creare uno studio dei geni per confrontare i dati dell’espressione genica di uno o più esperimenti di
PCR in tempo reale utilizzando un calibratore inter-analisi per la normalizzazione tra gli esperimenti.
Creare uno studio dei geni aggiungendo dati da uno o più file di dati (estensione .pcrd) allo studio dei
geni. Il software li raggruppa in un file singolo (estensione .mgxd).

Nota: Il numero massimo di campioni che è possibile analizzare in uno studio dei geni è limitato
dalle dimensioni della memoria virtuale e della RAM del computer.

Calibrazione inter-analisi
La calibrazione inter-analisi viene tentata automaticamente in ogni studio dei geni per ciascun target al
fine di normalizzare variazioni inter-analisi tra i target determinate in analisi PCR in tempo reale
separate (ossia, differenti file .pcrd generati da piastre diverse).

Per permettere al software di riconoscere un campione come calibratore inter-analisi, occorre
condividere lo stesso nome target, nome campione e, se utilizzato, nome del set biologico per ogni
piastra che viene confrontata.

Nota: Per consentire la calibrazione inter-analisi, nello studio dei geni deve essere presente
almeno un campione di calibratore inter-analisi. I target senza campioni di calibratori inter-analisi
appropriati saranno elaborati senza correzione nello studio dei geni (sconsigliato).

I calibratori inter-analisi possono essere applicati in due modi:

n Per target (Per target): i vari primer della PCR possono avere un’efficacia diversa. Per
impostazione predefinita, il calibratore inter-analisi viene applicato a tutti i pozzetti della stessa
piastra che hanno lo stesso nome target, ad esempio il Cq generato con lo stesso dosaggio.

n Entire study (Intero studio): un calibratore inter-analisi viene selezionato dall’utente e applicato
all’intero studio dei geni.

Finestra di dialogo Gene Study (Studio dei geni)
La finestra di dialogo Gene Study (Studio dei geni) include due schede:

n Scheda Study Setup (Impostazione studio): gestisce le analisi nello studio dei geni.

Importante: L’aggiunta o la rimozione dei file di dati in uno studio dei geni non cambia i dati
nel file originale.

n Scheda Study Analysis (Analisi dello studio): visualizza i dati dell’espressione genica per le
analisi combinate.
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Scheda Study Setup (Impostazione studio)
La Tabella 38 definisce i dati visualizzati nella scheda Study Setup (Impostazione studio).

Titolo della colonna Descrizione

File Name (Nome file) Nome del file di dati dell’analisi (estensione .pcrd)

File Folder (Cartella file) Directory che memorizza il file di dati di ciascuna analisi nello studio
dei geni

Date Created (Data di
creazione)

Data di raccolta dei dati dell’analisi

Well Group Name (Nome
gruppo di pozzetti)

Nome del gruppo di pozzetti che è stato selezionato quando il file è
stato aggiunto allo studio dei geni

Suggerimento: Per analizzare un gruppo di pozzetti nello studio
dei geni, occorre selezionare quel gruppo di pozzetti nella finestra
Data Analysis (Analisi dei dati) prima di importare il file di dati nello
studio dei geni.

Step (Fase) Fase del protocollo che include la lettura piastra per raccogliere i dati
della PCR in tempo reale

Run Type (Tipo di analisi) Analisi definita dall’utente o PrimePCR™

Protocol Edited (Protocollo
modificato)

Se questo parametro è selezionato, indica che il protocollo usato per
l’analisi PrimePCR è stato modificato

View Plate (Visualizza
piastra)

Apre una mappa della piastra con i dati di ciascuna analisi inclusa nello
studio dei geni

Tabella 38. Scheda Study Setup (Impostazione studio) nella finestra di dialogo Gene Study
(Studio dei geni)

Preparazione di uno studio dei geni
Per preparare uno studio dei geni

1. Prima di importare i dati in uno studio dei geni, procedere come segue nella finestra Data Analysis
(Analisi dei dati):

n Verificare che i campioni con lo stesso contenuto abbiamo lo stesso nome. In uno studio dei
geni, il software presume che i pozzetti con lo stesso nome target o campione contengano gli
stessi campioni.
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n Regolare la linea basale e la soglia (Cq) nella scheda Quantification (Quantificazione) per
ottimizzare i dati in ciascuna analisi.

n Selezionare il gruppo di pozzetti che si desidera includere nello studio dei geni.

Al fine di visualizzare i dati da un gruppo di pozzetti nello studio dei geni, è necessario
selezionare tale gruppo prima di importare i file di dati.

La scheda Study Setup (Impostazione studio) mostra un elenco di tutte le analisi nello studio dei
geni.

2. Nella finestra di dialogo Gene Study (Studio dei geni), scegliere la scheda Study Setup
(Impostazione studio).

3. Fare clic su Add Data Files (Aggiungi file di dati) per selezionare un file da una finestra di
navigazione.

Suggerimento: Per aggiungere rapidamente delle analisi ad uno studio dei geni, trascinare i
file di dati (estensione .pcrd) nella finestra di dialogo Study Setup (Impostazione studio).

4. Il Software CFX Manager Dx esegue automaticamente l’analisi dello studio dei geni quando si
aggiungono i file di dati. Scegliere la scheda Study Analysis (Analisi dello studio) per visualizzare i
risultati.

Per rimuovere le analisi dallo studio dei geni

u Selezionare uno o più file nell’elenco e fare clic su Remove (Rimuovi).

Per aggiungere note relative allo studio dei geni

u Inserire le note sui file e sull’analisi nella casella di testo Notes (Note).
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Scheda Study Analysis (Analisi dello studio)
La scheda Study Analysis (Analisi dello studio) visualizza i dati di tutte le analisi dello studio dei geni.
Le opzioni dell’analisi dei dati dell’espressione genica sono uguali a quelle usate per un solo file di dati
con la seguente eccezione:

n Per i grafici a barre, i valori di calibrazione inter-analisi (se calcolati) sono visualizzati quando si fa
clic su Inter-run Calibration (Calibrazione inter-analisi).

Nota: Solo i seguenti tipi di campione possono essere usati come calibratore inter-analisi:

o Unknown (Sconosciuto)

o Standard (Standard)

o Positive Control (Controllo positivo)

I tipi di campione Negative control (Controllo negativo), no template control (NTC, nessun
controllo modello) e no reverse transcriptase control (NRT, nessun controllo di trascrittasi
inversa) non possono essere usati come calibratore inter-analisi.
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Creazione di un report dello studio dei geni
Per creare un report dello studio dei geni

1. Prima di creare un report, regolare secondo necessità i dati e i grafici del report dello studio dei
geni.

2. Selezionare Tools > Reports (Strumenti > Report) nel menu Gene Study (Studio dei geni) per
aprire la finestra di dialogo Report (Report).

3. Scegliere le opzioni che si desidera includere nel report. Il report si apre con le opzioni predefinite
selezionate. Selezionare o deselezionare le caselle di controllo per cambiare categorie intere o
singole opzioni all’interno di una categoria.

Le Categorie di report dello studio dei geni a pagina 256 elencano le opzioni disponibili da
visualizzare.

4. Cambiare l’ordine delle categorie e degli elementi in un report. Trascinare le opzioni nella
posizione richiesta. Gli elementi possono essere riordinati solamente all’interno delle categorie a
cui appartengono.

5. Fare clic su Update Report (Aggiorna report) per aggiornare l’anteprima del report con tutte le
modifiche.

6. Stampare o salvare il report. Fare clic sul pulsante Print Report (Stampa report) nella barra degli
strumenti per stampare il report attuale. Selezionare File > Save (File > Salva) per salvare il report
in formato PDF (file Adobe Acrobat Reader) e selezionare una posizione in cui salvare il file.
Selezionare File > Save As (File > Salva con nome) per salvare il report con un nuovo nome o in
una nuova posizione.

7. (Facoltativo) Creare un modello di report con le informazioni desiderate. Per salvare in un
modello le impostazioni del report attuali, selezionare Template > Save oppure Save As (Modello
> Salva/Salva con nome). Dopodiché, caricare il modello di report la prossima volta che si
desidera creare un nuovo report.

Categorie di report dello studio dei geni
Usare la finestra di dialogo Gene Study Report (Report dello studio dei geni) per organizzare i dati
dello studio dei geni in un report. La Tabella 39 elenca tutte le opzioni disponibili per un report dello
studio dei geni.
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Categoria Opzione Descrizione

Header (Intestazione)

Titolo, sottotitolo e logo per il report

Informazioni sul report Data, nome utente, nome file di dati, percorso
file di dati e il gruppo di pozzetti selezionato

Elenco dei file dello studio
dei geni

Elenco di tutti i file di dati nello studio dei geni

Note Note sul report di dati

Study Analysis: Bar Chart (Analisi dello studio: grafico a barre)

Impostazioni dell’analisi Elenco dei parametri di analisi selezionati

Grafico Grafico a barre dell’espressione genica, che
visualizza i dati

Nomi target Elenco dei target nello studio dei geni

Nomi campione Elenco dei campioni nello studio dei geni

Dati Foglio di calcolo che mostra i dati

Stabilità target Dati di stabilità target

Calibrazione inter-analisi Dati di calibrazione inter-analisi

Analisi dello studio: Clustergram and Scatter Plot (Analisi dello studio: diagramma di
gruppo e grafico di dispersione)

Impostazioni dell’analisi Impostazioni per ciascun tipo di grafico

Grafico Grafico dell’espressione genica, che visualizza i
dati

Dati Foglio di calcolo che elenca i dati in ciascun
target

Tabella 39. Categorie per un report dello studio dei geni
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Appendice A Calcoli per l’analisi dei dati
Il software CFX Manager™ Dx calcola automaticamente le formule e visualizza i risultati nelle schede
di analisi dei dati. In questa appendice viene spiegato dettagliatamente come il software CFX
Manager Dx calcola le formule.

Efficacia della reazione
Le evidenze suggeriscono che, utilizzando una misura accurata dell’efficacia per ciascun primer e set
di sonde, si ottengono risultati più accurati quando si analizzano i dati dell’espressione genica. Il
valore predefinito dell’efficacia utilizzato nei calcoli dell’espressione genica è 100%. Per valutare
l’efficacia della reazione, generare una curva standard utilizzando diluizioni seriali di un campione
rappresentativo in tutta la gamma dinamica pertinente e quindi registrare l’efficacia per la successiva
analisi dell’espressione genica. Se l’analisi include una curva standard, il software calcola
automaticamente l’efficacia e la visualizza sotto la curva standard della scheda Quantification
(Quantificazione), quando è selezionata l’opzione Auto Efficiency (Efficacia automatica) nella scheda
Targets (Target) della finestra Experiment Settings (Impostazioni esperimento).

L’efficacia (E) nelle formule di efficacia fa riferimento ai valori di “efficacia” come descritti da Pfaffl
(2001) and Vandesompele et al. (2002). In queste pubblicazioni, un’efficacia pari a 2 (perfetto
raddoppiamento con ogni ciclo) equivale al 100% dell’efficacia in questo software. È possibile
convertire i calcoli dell’efficacia in quelli usati nel software utilizzando i seguenti rapporti matematici:

n E = (% di efficacia * 0,01) + 1

n % di efficacia = (E – 1) * 100

Quantità relativa
La formula per la quantità relativa (ΔCq) per un campione (GOI) è:

Nota: Questa formula viene utilizzata per calcolare la quantità relativa quando non vi è alcun
campione di controllo definito.

Dove:
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n E = Efficacia definita del primer e della sonda. Questa efficacia viene calcolata con la formula
(% di efficacia * 0,01) + 1, dove l’efficacia del 100% = 2

n C q (min) = Media di Cq per il campione con Media di Cq più bassa per il GOI

n C q (campione) = Media di Cq per il campione

n GOI = Gene di interesse (un target)

Quantità relativa quando si seleziona un controllo
Quando viene assegnato un campione di controllo, la quantità relativa (RQ) di ogni campione con un
gene di interesse (GOI) viene calcolata con questa formula:

Dove:

n E = Efficacia definita del primer e della sonda. Questa efficacia viene calcolata con la formula
(% di efficacia * 0,01) + 1, dove l’efficacia del 100% = 2

n Cq (controllo) = Media di Cq per il campione di controllo

n Cq (campione) = Media di Cq per ogni campione con un GOI

n GOI = Gene di interesse (un target)

Deviazione standard della quantità relativa
La formula per la deviazione standard del calcolo della quantità relativa è:

Dove:

n SD Relative Quantity = Deviazione standard del calcolo della quantità relativa

n SD CqGOI sample = Deviazione standard della Cq per il campione (GOI)

n Relative Quantity = Quantità relativa del campione

n E = Efficacia definita del primer e della sonda. Questa efficacia viene calcolata con la formula
(% di efficacia * 0,01) + 1, dove l’efficacia del 100% = 2

n GOI = Gene di interesse (un target)
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Cq con efficacia corretta (CqE)
La formula per il Cq con efficacia corretta è

Dove:

n E = Efficacia

Media Cq con efficacia corretta (MCqE)
La formula per la media Cq con efficacia corretta è

Dove:

n CqE = Cq con efficacia corretta

n n = Numero di replicati

Fattore di normalizzazione
Il denominatore dell’equazione per l’espressione normalizzata è indicato come fattore di
normalizzazione. Il fattore di normalizzazione è la media geometrica delle quantità relative di tutti i
target di riferimento (i geni) per un determinato campione, così come viene descritto in questa formula:

Dove:

n RQ = Quantità relativa

n n = Numero di target di riferimento

n GOI = Gene di interesse (un target)
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Espressione normalizzata
L’espressione normalizzata (ΔΔCq) è la quantità relativa del target (gene) normalizzata con le quantità
dei target di riferimento (geni o sequenze) nel sistema biologico. Per selezionare i target di riferimento,
aprire la finestra Experiment Settings (Impostazioni esperimento) e fare clic sulla colonna Reference
(Riferimento) per ciascun target che funge da gene di riferimento.

La formula per l’espressione normalizzata, che utilizza il calcolo della quantità relativa (RQ), è

Dove:

n RQ = Quantità relativa di un campione

n Ref = Target di riferimento in un’analisi che include uno o più target di riferimento in ogni
campione

n GOI = Gene di interesse (un target)

A condizione che i target di riferimento non cambino il livello d’espressione nel sistema biologico, il
calcolo dell’espressione normalizzata rappresenterà le differenze o le variazioni di carico del numero
di cellule che sono rappresentate in ciascun campione.

Espressione normalizzata quando si seleziona un controllo
Quando si seleziona un campione di controllo nella finestra Experiment Settings (Impostazioni
esperimento), il software imposta su 1 il livello di espressione del campione di controllo. In questa
situazione, il software normalizza le quantità relative di tutta l’espressione target (gene) in base alla
quantità di controllo (un valore di 1). Questa espressione normalizzata è equivalente all’analisi
dell’espressione normalizzata non messa in scala quando si sceglie un controllo.

Nota: Questo valore è noto anche con il nome di espressione normalizzata relativa (RNE) e fold
change.
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Deviazione standard per l’espressione normalizzata
La rimessa in scala del valore dell’espressione normalizzata viene eseguita dividendo la deviazione
standard dell’espressione normalizzata con il valore dell’espressione normalizzata per il livello più alto
o più basso dell’espressione, in base all’opzione di messa in scala prescelta. La formula per la
deviazione standard (SD) del fattore di normalizzazione è

Dove:

n RQ = Quantità relativa di un campione

n SD = Deviazione standard

n NF = Fattore di normalizzazione

n Ref = Target di riferimento

n n = Numero di target di riferimento

Quando viene assegnato un campione di controllo, non occorre eseguire questa funzione di rimessa
in scala sulla deviazione standard, come mostrato nella seguente formula.

Dove:

n NE = Espressione normalizzata

n RQ = Quantità relativa di un campione

n SD = Deviazione standard

n GOI = Gene di interesse (un target)
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Espressione normalizzata rapportata al livello più alto di
espressione

Quando l’analisi non include controlli, mettere in scala l’espressione normalizzata (NE) per ciascun
target (gene) dividendo il livello di espressione di ogni campione per il livello più alto di espressione in
tutti i campioni. Il software imposta il livello più alto di espressione sul valore di 1 e rimette in scala tutti i
livelli di espressione dei campioni. La formula per la messa in scala più alta è:

Dove:

n GOI = Gene di interesse (target)

Espressione normalizzata rapportata al livello più basso di
espressione

Quando l’analisi non include controlli, mettere in scala l’espressione normalizzata (NE) per ciascun
target (gene) dividendo il livello di espressione di ogni campione per il livello più basso di espressione
in tutti i campioni. Il software imposta il livello più basso di espressione sul valore di 1 e rimette in scala
tutti i livelli di espressione dei campioni. La formula per la messa in scala più bassa è:

Dove:

n GOI = Gene di interesse (target)
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Espressione normalizzata rapportata al livello di
espressione medio

Quando l’analisi non include controlli, rapportare l’espressione normalizzata (NE) per ciascun target
(gene) dividendo il livello di espressione di ogni campione per il livello medio geometrico di
espressione in tutti i campioni. Il software imposta il livello medio di espressione sul valore di 1 e
rimette in scala tutti i livelli di espressione dei campioni. La formula per la messa in scala media è:

Dove:

n GOI = Gene di interesse (target)

n GM =Media geometrica dell’espressione normalizzata per tutti i campioni
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Deviazione standard per l’espressione normalizzata
rapportata

La rimessa in scala del valore rapportato dell’espressione normalizzata (NE) viene eseguita dividendo
la deviazione standard (SD) dell’espressione normalizzata con il valore dell’espressione normalizzata
per il livello più alto (MAX) o più basso (MIN) dell’espressione, in base all’opzione di messa in scala
prescelta.

Nota: Quando viene assegnato un campione di controllo, non occorre eseguire questa funzione
di rimessa in scala sulla deviazione standard.

Il calcolo per questa formula è

Dove:

n NE = Espressione normalizzata

n SD = Deviazione standard

n GOI = Gene di interesse (target)

n MAX = Livello più alto dell’espressione

n MIN = Livello più basso dell’espressione

Regolazione
La regolazione è una misura dell’aumento o della riduzione dell’espressione di un target per un
campione sperimentale rispetto ad un campione di controllo ed è determinata come segue:

Se Espressione (sperimentale) > Espressione (controllo):

Se Espressione (sperimentale) < Espressione (controllo):

Nota: Per il grafico a barre, l’espressione si basa sulla quantità relativa o sull’espressione
normalizzata, in base alla modalità selezionata (vedere Grafico a barre a pagina 234). Tuttavia, per
il grafico di dispersione, il diagramma di gruppo, il valore della regolazione viene sempre
calcolato sulla base dell’espressione normalizzata.
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Formule per i valori corretti
Una differenza tra i valori corretti e i valori non corretti si vede solo se viene creata una curva standard
come parte dell’analisi PCR in tempo reale. Il software utilizza tre equazioni per determinare la
propagazione dell’errore:

n Errore standard

n Errore standard per espressione normalizzata

n Errore standard per il gene di interesse normalizzato (target)

La formula per l’errore standard è

Dove:

n n = Numero di target di riferimento (geni)

n SD = Deviazione standard

L’errore standard per il fattore di normalizzazione per la formula di espressione normalizzata è

Dove:

n n = Numero di target di riferimento

n SE = Errore standard

n NF = Espressione normalizzata

n RQ = Quantità relativa

L’errore standard per la formula del gene di interesse normalizzato (GOI) è

Dove:

n SE = Errore standard

n GOI = Gene di interesse (un target)

n NF = Fattore di normalizzazione

n n = Numero di target di riferimento
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Appendice B Gestione degli utenti e dei ruoli di
CFX Manager Dx

Nel software CFX Manager™ Dx è possibile creare utenti e assegnare un ruolo a tali utenti. I ruoli
limitano l’accesso alle funzioni di CFX Manager Dx. All’utente può essere assegnato solo un ruolo alla
volta. Tuttavia, l’amministratore del software CFX Manager Dx può modificare il ruolo dell’utente in
qualsiasi momento.

Suggerimento: Non è necessario creare utenti per utilizzare CFX Manager Dx. Se non si creano
utenti, tutta l’attività viene svolta dall’account utente predefinito admin.

Importante: “User Admin” è l’account amministratore predefinito, che si utilizza per accedere
inizialmente a CFX Manager Dx. Si consiglia di creare un utente specifico per amministrare CFX
Manager Dx. Assegnare a questo utente il ruolo di Amministratore ed eseguire tutte le attività
amministrative con questo utente.

Importante: Il software CFX Manager Dx non ha una funzione di timeout inattività per la sessione
utente. Quindi si consiglia di implementare le misure di sicurezza per l’accesso utenti di Windows
o di terzi (ad esempio, implementare uno screen saver che richieda il login).

Gestione degli utenti
Nell’edizione standard del Software CFX Manager Dx, gli account utente possono avere un nome o
una password qualsiasi.

Per assegnare un ruolo a ciascun utente, selezionare dall’elenco dei ruoli nella finestra User
Administration (Amministrazione utente). In questo esempio, all’utente Guest (Ospite) viene dato il
diritto aggiunto di salvare i file.

Aggiunta e rimozione di utenti
Nota: Solo l’amministratore del CFX Manager Dx può aggiungere e rimuovere utenti.

Per aggiungere account utente al CFX Manager Dx

1. Nella finestra Home (Home), selezionare User > User Administration (Utente > Amministrazione
utenti).

Viene visualizzata la finestra di dialogo User Administration (Amministrazione utenti).
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2. Nel riquadro Manage Users (Gestisci utenti), digitare un nome utente per l’utente.

3. Selezionare un ruolo utente.

I ruoli limitano i diritti dell’utente. L’impostazione predefinita è Principal (Principale).

Suggerimento: È possibile cambiare i diritti per ciascun ruolo. La modifica dei diritti del ruolo
interessa tutti gli utenti assegnati a tale ruolo. Per ulteriori informazioni, vedere Gestione dei
diritti sui ruoli a pagina 271.

4. (Facoltativo) Digitare il nome intero e la password per l’utente.

5. Fare clic su OK per aprire una finestra di dialogo e confermare che si desidera chiudere la
finestra.

6. Fare clic su Yes (Sì) per chiudere la finestra di dialogo e la finestra.

Per rimuovere un utente

1. Nel riquadro Manage Users (Gestisci utenti), selezionare Remove (Rimuovi) per ciascun utente
che si desidera rimuovere.

2. Fare clic su OK per aprire una finestra di dialogo e confermare che si desidera chiudere la
finestra.

3. Fare clic su Yes (Sì) per chiudere la finestra di dialogo e la finestra.

Nota: L’elenco degli utenti software deve includere sempre un amministratore.
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Gestione dei diritti sui ruoli
CFXManager Dx include questi quattro ruoli:

n Administrator (Amministratore) (obbligatorio): gli amministratori hanno tutti i diritti e non è
possibile modificare tali diritti. Gli amministratori possono inoltre aggiungere e rimuovere gli utenti
e cambiare i diritti per ciascun ruolo.

Nota: Solo un amministratore può cambiare i diritti per ogni ruolo.

n Principal (Principale): per impostazione predefinita l’utente principale ha tutti i diritti

n Operator (Operatore): per impostazione predefinita l’utente operatore ha tutti i diritti eccetto quello
di ignorare i cicli

n Guest (Ospite): per impostazione predefinita l’utente ospite può solo leggere i file

Importante: La modifica dei diritti per un ruolo si ripercuote su tutti gli utenti assegnati a tale
ruolo. Non è possibile personalizzare un ruolo per un determinato utente. Procedere con cautela
quando si modificano i diritti dei ruoli.

Per specificare i diritti per ciascun ruolo

1. Nella finestra Home (Home), selezionare User > User Administration (Utente > Amministrazione
utenti).

2. Nel riquadro Manage Rights (Gestisci diritti) eseguire una delle seguenti operazioni:

n Per rimuovere un diritto da un ruolo, deselezionare la sua casella di controllo.

n Per aggiungere un diritto a quel ruolo, selezionare la sua casella di controllo.

3. Fare clic su OK per aprire una finestra di dialogo e confermare che si desidera chiudere la
finestra.

4. Fare clic su Yes (Sì) per chiudere la finestra di dialogo e la finestra.

Per ripristinare tutti i diritti per tutti i ruoli

u Nella finestra di dialogo User Administration (Amministrazione utenti) fare clic su Restore Default
Rights (Ripristina diritti predefiniti).
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Accesso al software CFX Manager Dx
Il software CFX Manager Dx gestisce l’accesso al software attraverso la finestra di dialogo Login
(Accedi). All’avvio del software, CFX Manager Dx visualizza automaticamente la finestra di dialogo
Login (Accedi) quando nella finestra User Administration (Amministrazione utenti) sono elencati due o
più utenti.

Il Software CFX Manager Dx visualizza il nome dell’utente collegato nella parte superiore della finestra
Home (Home).

Per accedere a CFX Manager Dx

1. Nella finestra di dialogo Login (Accedi), selezionare il nome dall’elenco a discesa User Name
(Nome utente).

2. Digitare la password.

3. Fare clic su OK per chiudere la finestra di Login (Accedi) e aprire il software.

Modifica degli utenti
È possibile cambiare utente mentre il software è in funzione.

Per cambiare utente

1. Nella finestra Home (Home), selezionare User (Utente) > Select User (Seleziona utente) per
aprire la finestra di dialogo Login (Accedi).

2. Selezionare un nome dall’elenco a discesa User Name (Nome utente).

3. Digitare la password del nuovo utente.

4. Fare clic su OK per chiudere la finestra di dialogo Login (Accedi) e aprire il software.
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Modifica delle password utente
Gli utenti CFX Manager Dx possono cambiare la propria password in qualsiasi momento.

Per cambiare le password utente

1. Nella finestra Home (Home), selezionare User > Change Password (Utente > Cambia password)
per aprire la finestra di dialogo Change Password (Cambia password).

2. In Old Password (Vecchia password), digitare la password attuale.

3. In New Password (Nuova password), digitare una nuova password e ridigitarla in Confirm New
Password (Conferma nuova password).

4. Fare clic su OK per confermare la modifica.

Visualizzazione del ruolo e dei diritti
Suggerimento: Gli utenti a cui viene assegnato il ruolo utente Principal (Principale), Operator
(Operatore) o Guest (Ospite) possono visualizzare solo le loro impostazioni, diritti e ruoli.

Per visualizzare il ruolo e i diritti dell’utente corrente

u Nella finestra Home (Home), selezionare User > User Administration (Utente > Amministrazione
utenti).

Contattare l’amministratore CFX Manager Dx per modificare le impostazioni, i diritti e i ruoli utente
elencati nella finestra User Administration (Amministrazione utenti).
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È possibile configurare il software CFX Manager™ Dx per l’uso con un sistema di gestione delle
informazioni di laboratorio (LIMS). Per l’integrazione LIMS, CFX Manager Dx richiede le informazioni
di impostazione piastra generate dalla piattaforma LIMS (un file LIMS, *.plrn), un file di protocollo
creato usando il Software CFX Manager Dx (*.prcl), una posizione di esportazione dati definita e un
formato di esportazione definito.

Al termine dell’analisi, CFX Manager Dx genera un file di dati (.pcrd) e lo salva nella posizione di una
cartella di esportazione dei dati definita. CFX Manager Dx può anche creare un file di dati compatibile
con LIMS nel formato .csv e lo salva nella stessa posizione.

Creazione di file di dati compatibili con LIMS
Questa appendice illustra come impostare il software CFX Manager Dx per creare, salvare o
esportare i file di dati compatibili con LIMS.

Impostazione della cartella LIMS e delle opzioni per
l’esportazione dati
Come impostazione predefinita, CFX Manager Dx salva i protocolli LIMS, i file e i file di esportazione
dati nella seguente cartella:
_ C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

È possibile configurare CFX Manager Dx per salvare i file in un’altra cartella e modificare le opzioni di
esportazione per i dati LIMS.

Per impostare la cartella LIMS e le opzioni di esportazione dati

1. Nella finestra Home (Home), selezionare Tools > Options (Strumenti > Opzioni).

2. Nella finestra di dialogo Options (Opzioni), selezionare Data Export Settings (Impostazioni
esportazioni dati).
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3. (Facoltativo) Selezionare Automatically export LIMS data at end of run (Esporta automaticamente
i dati LIMS al termine dell’analisi).

Il software esporterà automaticamente i dati LIMS dopo ogni analisi e li salverà nella posizione
specificata.

4. Per modificare le opzioni di esportazione predefinite per i dati LIMS, fare clic su LIMS Data Export
Settings (Impostazioni esportazione dati LIMS).

Importante: Solo i dati LIMS esportati come file .csv possono essere importati nuovamente
in CFX Manager Dx.

5. Nella finestra di dialogo LIMS Data Export Format Settings (Impostazioni formato esportazione
dati LIMS), selezionare le opzioni di esportazione desiderate, quindi fare clic su OK.

6. Nella finestra di dialogo Options (Opzioni), navigare e selezionare una cartella predefinita nella
quale si desidera salvare il file di dati LIMS. È possibile selezionare una posizione diversa per
ciascun tipo di file:

n Protocollo

n File LIMS

n Esportazione dati

7. Fare clic su OK per salvare le modifiche e chiudere la finestra di dialogo Options (Opzioni).

Creazione di un protocollo LIMS
Per avviare un’analisi LIMS, creare un file protocollo CFX Manager Dx (*.prcl) e salvarlo nella
posizione della cartella del protocollo LIMS designato.

Per ulteriori informazioni vedere il Capitolo 6, Creazione di protocolli.
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Creazione di un file LIMS
Nel file LIMS (*.plrn) sono inclusi i dettagli di impostazione della piastra e il nome file del protocollo.
Questo file viene generato dal LIMS interno. Il CFX Manager Dx utilizza il file LIMS per creare un file
piastra da utilizzare con un file protocollo.

Il CFX Manager Dx fornisce file modello di importazione piastra che è possibile modificare per creare
file piastra LIMS personalizzati.

Suggerimento: Tale attività deve essere portata a termine da uno specialista LIMS.

Per creare un file LIMS

1. Nella finestra Home (Home), selezionare View > Show > LIMS File Folder (Visualizza > Mostra >
Cartella file LIMS).

2. Aprire la cartella dei modelli LIMS e selezionare un file .csv da importare nel LIMS interno.

3. Utilizzando il LIMS, modificare il file modello compilando i campi richiesti elencati nella Tabella 40.

4. Salvare il modello con l’estensione nome file .plrn nella cartella dei file LIMS.

Importante: Il CFX Manager Dx può aprire solo il file .plrn. Occorre salvare il file .csv come
.plrn per avviare l’analisi LIMS.

Colonna Riga Descrizione Contenuto Scopo

A 1 Intestazione piastra Non modificare Predefinito

A,B,C 2 Campo/Dati/Istruzione Non modificare Predefinito

B 3 Versione Non modificare Predefinito

B 4 Dimensione piastra Non modificare Predefinito

Tabella 40. Definizione del contenuto file .csv LIMS
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Colonna Riga Descrizione Contenuto Scopo

B 5 Tipo di piastra Inserire “BRWhite”,
“BR Clear” o un altro
tipo di piastra
calibrata

Obbligatorio

B 6 Modalità di scansione Inserire “SYBR/FAM
Only:” (Solo
SYBR/FAM), “All
Channels” (Tutti i
canali) o “FRET”
(FRET)

Obbligatorio

Tabella 40. Definizione del contenuto file .csv LIMS, continua
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Colonna Riga Descrizione Contenuto Scopo

B 7 Unità Inserire una delle
seguenti voci “copy
number” (numero di
copie), “fold dilution”
(diluizione fold),
“micromoles”
(micromoli),
“nanomoles”
(nanomoli),
“picomoles”
(picomoli),
“femtomoles”
(femtomoli),
“attomoles”
(attomoli),
“milligrams”
(milligrammi),
“micrograms”
(microgrammi),
“nanograms”
(nanogrammi),
“picograms”
(picogrammi),
“femtograms”
(femtogrammi),
“attograms”
(attogrammi) o
“percent”
(percentuale)

Obbligatorio

B 8 ID analisi Inserire una
descrizione breve o
il codice a barre che
identifichi questa
analisi (massimo 30
caratteri, non sono
consentite virgole)

Facoltativo

Tabella 40. Definizione del contenuto file .csv LIMS, continua
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Colonna Riga Descrizione Contenuto Scopo

B 9 Nota analisi Inserire una
descrizione per
l’analisi

Facoltativo

B 10 Protocollo analisi Inserire il nome file
protocollo
esattamente come
elencato.

Obbligatorio

A 11 File di dati Inserire il nome file
di dati

Facoltativo

A 12-15 TBD/Vuoto Non modificare Predefinito

A 16 Dati piastra Non modificare Predefinito

Tabella 40. Definizione del contenuto file .csv LIMS, continua
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Colonna Riga Descrizione Contenuto Scopo

A 17-113 Posizione pozzetto Non modificare Predefinito

B-G Colorante Ch1, Colorante
Ch2, Colorante Ch3,
Colorante Ch4, Colorante
Ch5, FRET

Inserire un nome
colorante calibrato
(per esempio,
“FAM”) per ciascun
canale usato

Obbligatorio

H Tipo campione Inserire uno dei
seguenti tipi di
campione:
“Unknown”
(Sconosciuto),
“Standard”
(Standard), “Positive
Control” (Controllo
positivo), “Negative
Control” (Controllo
negativo), “NTC”
(Nessun controllo
modello) o “NRT”
(Nessun controllo di
trascrittasi inversa)

Obbligatorio

I Nome campione Inserire il nome
campione

Facoltativo

J-O Target CH1, Target CH2,
Target CH3, Target CH4,
Target CH5, Target FRET

Inserire il nome
target per ciascun
canale usato

Facoltativo

P Nome set biologico Inserire il nome set
biologico

Facoltativo

Tabella 40. Definizione del contenuto file .csv LIMS, continua
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Colonna Riga Descrizione Contenuto Scopo

Q Replicato Inserire un valore
intero positivo per
ciascun set di
replicati. Il valore
non può essere
zero.

Facoltativo

R-W Quantità CH1, Quantità
CH2, Quantità CH3,
Quantità CH4, Quantità
CH5, Quantità FRET

Inserire i valori
relativi alle quantità
per ogni standard.
Inserire la
concentrazione in
forma decimale.

Obbligatorio per
tutti gli standard

X Nota pozzetto Inserire la nota
pozzetto (massimo
20 caratteri)

Facoltativo

Y-AD Colore pozzetto Ch1,
Colore pozzetto Ch2,
Colore pozzetto Ch3,
Colore pozzetto Ch4,
Colore pozzetto Ch5,
Colore pozzetto FRET

Inserire un colore
stile tracce definito
dall’utente in
formato decimale
(argb) intero a 32 bit

Facoltativo

Tabella 40. Definizione del contenuto file .csv LIMS, continua

Avvio di un’analisi LIMS
Per avviare un’analisi LIMS

1. Per aprire un file LIMS .plrn, eseguire una delle seguenti operazioni:

n Nella finestra Home (Home), selezionare View > Show > LIMS File Folder (Visualizza >
Mostra > Cartella file LIMS) e aprire il file .plrn target.

n Nella finestra Home (Home), selezionare File > Open > LIMS File (File > Apri > File LIMS) e
aprire il file .plrn target.

Il file viene aperto nella scheda Start Run (Avvia analisi) nella procedura guidata Run Setup
(Impostazione analisi). La scheda Start Run (Avvia analisi) visualizza le informazioni relative
all’esperimento da eseguire. Visualizza anche il blocco o i blocchi di strumenti collegati sui quali è
possibile eseguire l’esperimento.
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2. Nella scheda Start Run (Avvia analisi), selezionare uno strumento e fare clic su Start Run (Avvia
analisi).

Esportazione dei dati nel LIMS
Una volta completata l’analisi, CFX Manager Dx genera un file di dati (.pcrd) e lo salva nella posizione
della cartella di esportazione dei dati definita.

Per esportare il file di dati nel LIMS

u Aprire il file .pcrd e selezionare Export > Export to LIMS Folder (Esporta > Esporta nella cartella
LIMS).

Suggerimento: Se si seleziona Automatically Export Data after Run (Esportazione automatica
dei dati dopo l'analisi) nelle opzioni LIMS, CFX Manager Dx crea un file di dati LIMS compatibile in
formato .csv e lo salva nella stessa cartella.
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Appendice D Risoluzione dei problemi di
connessione del Software CFX Manager Dx

Registro dell’applicazione
Prima di avviare una nuova analisi, gli strumenti CFX96™ e CFX96 DeepWell avviano un test di
autodiagnostica per verificare che il sistema funzioni secondo le specifiche. Il software registra i
risultati di questo test nel file registro dell’applicazione e registro dell’analisi. Se si nota un problema in
uno o più esperimenti, aprire i registri dell’analisi e dell’applicazione per individuare l’origine del
problema.

Il Software CFX Manager™ Dx tiene traccia delle informazioni sullo stato di uno strumento durante
l’analisi nel registro dell’applicazione. Utilizzare questi registri per seguire gli eventi che si verificano
negli strumenti e nel software e per la risoluzione dei problemi.

Per aprire il registro dell’applicazione

u Nella finestra Home (Home), selezionare View > Application Log (Visualizza > Registro
dell’applicazione).
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Risoluzione dei problemi
Di norma, i problemi di comunicazione tra software e strumento possono essere risolti riavviando il
computer e il sistema. Assicurarsi di salvare il lavoro in corso prima di eseguire il riavvio.

Nota: Verificare che il computer abbia RAM e spazio sul disco a sufficienza. La memoria
RAM deve essere di almeno 4 GB e lo spazio libero minimo sul disco rigido deve essere di 128
GB.

Interruzione di alimentazione
In caso di interruzione dell’alimentazione, lo strumento e il computer si spengono. Se l’interruzione di
alimentazione è breve, lo strumento riprende a eseguire un protocollo, ma nel registro di applicazione
viene annotata l’interruzione di alimentazione. In base alle impostazioni del computer e alla durata
dell’interruzione dell’alimentazione, lo strumento e il software tentano di continuare a funzionare in
base alla fase del protocollo:

n Se il protocollo è in una fase che non prevede alcuna lettura piastra, il protocollo continua a
funzionare non appena viene ripristinata la corrente elettrica.

n Se il protocollo è in una fase con una lettura piastra, lo strumento attende che il software si riavvii
e riprenda la comunicazione per raccogliere i dati. In questa situazione, il protocollo continua solo
se il software non viene spento dal computer. Il protocollo si avvia non appena il computer e il
software si riavviano.

Rimozione dei campioni dal modulo di reazione durante l’interruzione
dell’alimentazione

È possibile aprire un coperchio motorizzato, bloccato su un modulo di reazione, per rimuovere i
campioni durante l’interruzione di alimentazione.

Per rimuovere la piastra di blocco

1. Spingere verso il basso la barra di blocco per rimuovere il modulo di reazione dal termociclatore
C1000™Dx.

2. Sistemare con cura il modulo di reazione su un tavolo o banco da laboratorio.

3. Posizionare il modulo in modo che la parte anteriore del modulo sporga di circa 5 cm dal bordo.
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4. Con una chiave a brugola, rimuovere le due viti grandi da sotto il bordo anteriore del modulo di
reazione (sotto il pulsante per l’apertura del coperchio).

Si deve sentire lo scatto di apertura del fermo dall’interno del modulo.

Importante: Non rimuovere le due viti piccole che si trovano nella parte anteriore del
modulo.

5. Aprire il coperchio del modulo di reazione. Si osservi che il fermo (in plastica scura) non è più
fissato. Rimuovere i campioni dal blocco.

6. Reinstallare il fermo di blocco e fissarlo con le viti grandi per rimontare il modulo di reazione al
coperchio aperto.
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Recupero di file dal computer CFX Manager Dx
È possibile recuperare i file dei dati e di registro presenti sullo strumento e trasferirli sul disco rigido di
un computer collegato.

Nota: Tutti i file presenti nella cartella dei dati in tempo reale della base dello strumento vengono
recuperati sul computer.

Per recuperare i file dallo strumento

1. Nel riquadro Detected Instruments (Strumenti rilevati) della finestra Home (Home), fare clic con il
pulsante destro del mouse sullo strumento desiderato e selezionare una delle seguenti opzioni:

n Retrieve Log Files (Recupera file di registro)

n Retrieve Data Files (Recupera file di dati)

2. Scegliere la posizione della cartella in cui salvare i file recuperati.

3. Fare clic su OK.

Installazione manuale del software CFX Manager Dx
Per installare manualmente il Software CFX Manager Dx

1. Se necessario, scollegare dal computer tutti gli strumenti collegati.

Individuare e scollegare il cavo USB dello strumento sul computer CFX Manager Dx. L’estremità
inserita nello strumento può rimanere in posizione.

2. Accedere al computer CFX Manager Dx con privilegi di Amministratore.

3. Inserire il CD del software.

4. In Windows Explorer, navigare fino al CD, fare clic con il pulsante destro del mouse sull’icona del
CD del software e selezionare Explore (Esplora) per aprire la finestra del CD.

5. Fare doppio clic sulla cartella CFX_Manager per aprire la cartella, quindi fare doppio clic su
setup.exe per avviare la procedura guidata di installazione del software.

6. Seguire le istruzioni della procedura guidata per installare il software e quindi fare clic su Finish
(Fine).
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Reinstallazione dei driver
Per reinstallare i driver dello strumento

u Nella finestra Home (Home), selezionare Tools > Reinstall Instrument Drivers (Strumenti >
Reinstalla driver strumento).

Nota: Se si hanno problemi di comunicazione del software con un sistema in tempo reale dopo
aver reinstallato i driver e aver controllato la connessione USB, contattare l’assistenza tecnica di
Bio-Rad.
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Minpack Copyright Notice (1999) University of Chicago. Tutti i diritti riservati

La ridistribuzione e l’utilizzo nei formati sorgente e binario, con o senza modifiche, sono consentiti
purché vengano soddisfatte le seguenti condizioni:

1. La ridistribuzione in formato sorgente deve mantenere l’avviso sul copyright riportato sopra, il
presente elenco di condizioni e la seguente esclusione di responsabilità.

2. La ridistribuzione in formato binario deve riprodurre l’avviso sul copyright riportato sopra, il
presente elenco di condizioni e la seguente dichiarazione di non responsabilità nella
documentazione e/o in qualsiasi altro materiale fornito con la distribuzione.

3. L’eventuale documentazione per l’utente finale, inclusa con la ridistribuzione, deve includere la
seguente citazione:

“Questo prodotto include software sviluppato dalla University of Chicago, come Operator of Argonne
National Laboratory”.
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